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“Life! Don’t talk to me about life.”

— Marvin The Paranoid Android
from The Hitchhiker’s Guide to
the Galaxy by Douglas Adams
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INTRODUCTION

WHAT IS
SIMLIFE?

YOUR REASONS
10 (SIM)LIVE

SimLife is an Artificial Life Laboratory/Playground designed to simulate
environments, biology, evolution, ecosystems, and life.

It is a game, a toy and an experimental tool to learn about life, real and
artificial.

As a game, SimLife challenges you to successfully solve the problems
presented to you in each of six different scenarios.

As an experimental tool, SimLife gives you the power to:
* create and modify worlds;
* create and modify plants and animals at the genetic level,

* design environments and ecosystems;

simulate and control evolution; and even

change the physics of the universe.

A major feature and purpose of SimLife is that it is an exploration of the
emerging computer field of Artificial Life.

The goals in playing SimLife are many, and, as with most Maxis products,
are entirely up to you.

If you approach SimLife as a game, then your goals can be to win each of
the scenarios. If you approach SimLife as a “laboratory in a computer,”
your goals are as limitless as your imagination. If you approach SimLife
as atoy, youdon't need goals; you can just play with plants, animals and
ecosystems.

If you are interested in monitoring your personal progress or under-
standing of the ecological systems in SimLife, you can keep an eye on the
Ecology Score in the Graphs Window. It displays an ongoing score of the
ecological soundness of your ecosystem, which you can view as a rating
of how well you are doing as master of life on your world. There is also
an evaluation window that graphically shows how complex your ecosys-
tem is, as well as assigning a score to your performance.




Perhaps the greatest challenge of playing SimLife is to start from scratch
and design and build a world with a sustainable ecosystem.

It's not an easy task, and once you do it you may realize just how fragile
an ecosystem can be: how a small change in the environment or the
extinction of a single species can cause a wave of destruction that
destroys life up and down the food chain.

What can be considered the ultimate goal of SimLife is to look beyond the
game, to understand that the real world with its millions of species with
their combined billions of genes are all interrelated and carefully
balanced in the food chain and the web of life, and that this balance can
be upset. Once we realize this, maybe we’ll treat our planet, our
environment and life itself with the respect they deserve and need. OK.
Enough heaviosity. Go play.

SimLife was designed to be played at different levels:
* On the simple game level of trying to solve the scenarios;

* On a simple experimental/play level of building your own
worlds, animals, and ecosystems; and

* On a complex experimental level where you control (or
meddle with) the laws of physics and manipulate plants and
animals at the genetic level.

You can do these things in any of five difficulty levels, from beginner to
expert.

THE ULTIMATE GOAL?

LEVELS OF PLAY

Introduction
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SOFTWARE TOYS
AND

SYSTEM
SIMULATIONS

SimLife isn't exactly a game — it's what we call a Software Toy. Toys, by
definition, are more flexible and open-ended than games.

As an example, compare a game, tennis, with atoy, a ball. In every tennis
game, there is one way to begin, one goal to pursue and one way to end.
There are infinite variations in the middle, but they all start the same
way, chase the same goal and end the same way. A ball is more flexible
— there are more things you can do with it. With the ball, you can play
tennis. You can play catch. You can throw it at someone. You can bounce
it. You can make up a hundred different games using the ball. Besides
games, there are other things you can do with a ball. You can paint it, use
it to plug a leaky roof, or just contemplate its roundness.

In SimLife, the “toy” is a biology laboratory in a computer.

When you play with SimLife, or any of our other Software Toys", don't
limit yourself to trying to “win.” Play with it. Experiment. Try new things.
Just have fun.

There are many types of toys. SimLife, like SimCity*, SimEarth”, and
SimAnt® before it, is a SYSTEM SIMULATION toy. In a system simulation,
we provide you with a set of RULES and TOOLS that describe, create and
control a system. In the case of SimLife, the system is an ecosystem. Part
of the challenge of playing with a system simulation toy is to figure out
how the system works and take control of it. As master of the system, you
are free to use the Tools to create and control an unlimited number of
systems (in this case, ecosystems) within the framework provided by
the Rules.

In SimLife, the Rules to learn are based on biology and behavior,
including:

Environment: All life is affected by its external environmental condi-
tions, including the landscape, the climate, physical disasters and most
importantly, other life-forms.




Genetics: Living beings are defined by the genes they carry and pass on
to their offspring.

Evolution: Life changes in response to its environment; species adapt
to their surroundings and evolve into new species.

Behavior: To survive individually and as a species, life-forms must find
food and water, defend themselves from predators and reproduce.

The Food Chain: For an ecosystem to be stable, the food chain must be
a complete circle; herbivores eat plants, carnivores eat herbivores,
plants consume animal waste and rotted carcasses. The sun provides
the energy to keep the cycle going.

Ecosystems: In addition to the cycling of material in the food chain, a
stable ecosystem has to efficiently cycle oxygen, carbon dioxide, water
and other important gasses and minerals between life, the atmosphere
and the land.

The Tools provide you with the ability to design and build worlds and
ecosystems:

e Create landforms with lakes, mountains, rivers and
impassable barriers.

Modify the climate: set temperature ranges, humidity,
seasonal changes, and day-length variations with the Climate
Lab.

Mix and match pre-defined plants and animals, modify them
at the genetic level, or create your own life-forms in the
Biology Lab.

Use mutagens to cause mutations and speed up evolution.

Change the laws of physics: set the lengths of days and years,
change the energy it takes to walk, swim, or fly.

Track your data with graphs and charts that display
population and genetic changes through time.

Introduction
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WHAT IS
ARTIFIGIAL LIFE?

But the most important Tool of all is the simulator itself. Test your
knowledge, plans, theories and ideas as you watch your creatures and
ecosystems thrive or die.

SimLife is an Artificial Life playshop/toolkit/workshop.

Artificial Life (A-life) is an emerging new field in computer science that
is giving us a whole new way to study biology, evolution and life itself.
Our Software Toys make use of Alife technology to simulate living
systems that change and grow depending on the choices you make.

The idea behind Adlife is to produce lifelike behavior on a computer (or
other artificial media), where it can be studied in ways real living things
cannot. Alife creates alaboratory in a computer, where the scientist can
completely control all environmental factors—even time.

One of the most important features of A-life is emergent behavior—when
complex behavior emerges from the combination of many individuals
following simple rules. Two examples of emergent behavior are ant
colonies in the real world, and SimCity in the computer world. In fact,
biologic “life as we know it” can be considered a form of emergent
behavior.

Another important aspect of A-life is evolution—artificial life-forms can
react to their environment and grow, reproduce and evolve into more
complex forms.

The future of A-life holds much potential and promise. It may someday
go beyond the experimental world into the practical realm of design. The
tools and techniques being developed now will someday allow us to
grow or evolve designs for complex systems ranging from software to
airplanes to intelligence.

In a sense, A-life has the same ultimate goal as Artificial Intelligence (Al),
but uses opposite methods. Al uses a top-down approach to create a




thinking machine that emulates the human brain. A-life uses the bottom-
up approach—start with single cells and grow/evolve life with intelli-
gence.

There are five parts to the docs for SimLife: the manual, the machine-
specificaddendum, thelab book, theregistration card and the President’s
letter/support info card.

The manual (that which you now hold in your hands) has:

* An Introduction chapter that gives you a little background
on the game and a brief explanation of Artificial Life;

* A Getting Started chapter to get you up and running;

¢ A three-part Tutorial that gives you some background info,
leads you through many of the windows and functions of the
program and shows you how to set up, conduct and evaluate
an experiment;

* AReferencesectionthat gives more background information,
complete descriptions of every menu, window, button and
function, sample experiments to try and miscellaneous
information on the simulation; and

A Glossary, a Bibliography and an Index.

The machine-specific addendum gives you any special info you'll need
for your particular computer, including loading, saving, printing, special
menu items, and keyboard shortcuts. It also has any last-minute features
that were too recent to make it into the manual. If you have any questions
that aren’t answered in the manual, check your machine-specific adden-
dum.

The lab book goes along with the experiment in the tutorial to give you
an example of one way to write up SimLife experiments. The lab book
also has data sheets containing printed blanks of most of the windows
that you can copy, draw in the data, and include in your own lab reports.

ABOUT SIMLIFE
DOCUMENTATION

Introduction
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VARIOUS SIMLIFE
VERSIONS AND
MANUAL GRAPHICS

Sending in the registration card entitles you to free technical support, an
extended warranty on SimLife and a whole bunch of other things. Read
it, fill it out and send it in. You'll be glad you did.

The President’s letter invites you to contact Maxis about any problems
or suggestions you may have with or for SimLife. The support info (on
the back of the President’s letter) tells you how to contact us for
customer service and technical support.

SimLife is (or soon will be) available on a number of different computer
systems. We try to keep all the versions as close to each other as
possible, while staying true to the individual interface differences of
each machine.

The graphics for this manual are taken primarily from the Color Macin-
tosh version of SimLife because it was ready first. On any other com-
puter, there will be some slight differences in the look of the program. All
the same features and functions will be there, but some things (like
buttons) may be moved around a little. If your screen doesn’t exactly
match the graphics in the manual, check in the machine-specific adden-
dum for a complete explanation of how SimLife has been customized for
your computer.
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“All life is an experiment.”

— Oliver Wendell Holmes



GETTING STARTED

INSTALLATION

O TARTING
THE PROGRAM

ABOUT THE
TUTORIALS

On most computers, SimLife must be installed to a hard disk before it can
be run. See your computer-specific addendum for installation instruc-
tions on your computer.

Once again, see your computer-specific addendum for starting instruc-
tions.

There is an on-screen tutorial built into SimLife. Once you start the
program, you will see the New Game Window. Click on the button that
says Tutorial, then click on Make It So. You will be taken on a quick tour
through the basic features of SimLife.

In addition, there is a fairly extensive tutorial in this manual, written in
three parts.

The first part gives some background information on SimLife, and on life
itself. You may want to skim through this section before going on. Most
of you will just jump right in and start messing around with the game.
Enjoy yourself—the information will be here when you want it.

The second part is a tour of the major features, functions and windows.
We won't be chasing any particular goal here, just playing around and
getting familiar with many of the things you can do with SimLife.

The third part of the tutorial is the complete design, setup and execution
of an experiment. We'll define the goals of the experiment, decide what
kind of world and what kind of life would be best to reach the goals, and
carry it out. Included in the SimLife package is a “lab book™ that
summarizes the steps in the experiment, and leaves room for recording
data and conclusions.
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“My boy, you are descended from a
long line of determined, resourceful,
microscopic tadpoles—champions
every one.”

— Kilgore Trout
from Galapagos by Kurt Vonnegut
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TUTORIAL

BEFORE
YOU BEGIN

WHO ARE YOU
AND

WHAT ARE YOU
DOING HERE?

This tutorial covers a lot of material fairly quickly. If you're not already
somewhat familiar with SimLife, you'll probably want to run through the
on-screen tutorial first. It can be started from the New Game Window. Or
you may want to give the Before You Begin section below a quick once-
over, then do the on-screen tutorial.

The graphics in this tutorial are from the color Macintosh version. The
screens on your computer may vary a little. See your machine-specific
addendum for more details.

Before playing SimLife, there are a few things you'll want to know.

[ hope you have many heads, because while playing SimLife you'll be
wearing many hats. Depending on the scenario you play or the experi-
ment you design, you can think of yourself as:

¢ aplanetary game warden trying to protect and improve
various ecosystems;

* abehavioral ecologist exploring the different ways plants
and animals interact in their ecosystems;

* an evolutionary biologist trying to prove theories;
¢ Charles Darwin (only in his dreams);

* a being with amazing powers who creates worlds,
populates them with plants and animals, and balances
ecosystems for fun;

¢ an Artificial Life experimenter; and

¢ anormal human trying to play and win a pretty complex
computer game.




What you are trying to do is:
e win each of the scenarios;

* stick your finger into an ecosystem, muck it up a bit and see
what happens;

e simulate current ecological situations (and disasters) and
try to recover before it's too late;

* build your own ecosystem from scratch;

o design and carry out any number of experiments that deal
with plants, animals, genetics, evolution and ecosytems;

* casually observe the interactions between plants, animals
and the environment over a long period of time; and

have fun.

SimLife is much easier and more fun to play if you have a mouse. This
tutorial and the manual in general assume you have one.

If you don’t have a mouse, check in the computer-specific addendum for
instructions on using menus and controlling windows, and for keyboard
equivalents to terms like “clicking” and “dragging.”

SimLife deals with life and ecosystems in a very simplified way. Simpli-
fication serves a few purposes. If it were even 1/10th as complex as the
world we live in, it would have taken us 100 years to make the program,
it would cost you hundreds of thousands of dollars, and you'd need a
computer the size of Baltimore to play it.

Because it is simple, time can be sped up and experiments that would
take hundreds of years in real time can be performed in hours or
minutes. Because it is simple, many external influences can be removed
for experimental controls that cannot be removed in “real world”
experiments.

OF MICE AND
KEYBOARDS

SIMPLICITY
AND RICHNESS

Tutorial
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IT’S ABOUT TIME

SimLife, even while extremely simple compared to life as we live it, is a
fairly deep game/simulation/toy. It has many interrelated features and
functions that make it quite powerful and take a bit of thinking to master.

One of the most powerful features in SimLife is the ability to limit or
ignore many of the features. Depending on the game or experiment you
may require a large, rich, complex world with climatic changes, moun-
tains and valleys, and a convoluted web of plants and animals preying on
each other, or just a small spot of ground with no mountains, no weather
changes and only one type of life.

Both the tutorial below and some of the scenarios will deal with some
small, simple setups so you can play and explore right away without
learning everything first, and gradually deal with more complex worlds
and experiments,

BUTTONS AND MORE BUTTONS

This game has more buttons than all the bellies in China. It can be a little
confusing at first, but follow the tutorial and you'll meet most of them
one at a time. Then you can read the reference section of this manual
(just kidding—! know nobody reads reference sections of manuals) to
find out exactly what each and every button does. If all else fails and you
can’t decide which button to press, try eeny-meeny-miney-moe.

Time in SimLife consists of Ticks, Days and Years. Each year is divided
up into four seasons of equal length: summer, fall, winter and spring.

A tick is one simulation cycle. The actual length of a tick in real seconds
depends on your computer’s speed, the size of the world and the
number of organisms in the world.

The number of ticks per day and days per year varies with the different
scenarios and can be customized for different experiments. By adjusting
ticks and days, you adjust the rate at which time passes. When a scenario
or experiment deals with the behavior of one animal or one generation,
then you will want time to go slowly so the animal has time to exhibit its




hehavior. When a scenario or experiment deals with the genetic drift
yver many generations, then you will want time to pass quickly.

Here are a few things to keep in mind while working your way through
the tutorial:

MENUS

To play SimLife, you'll have to understand how to use menus. Many
computers these days have menuing systems built into their operating
systems, including Macintosh, Amiga and Windows-based computers.
In these cases we follow all the standard menu-use conventions for your
computer/operating system.

Check your machine-specific addendum for special menu details (if any)
and for keyboard shortcuts for opening menus and selecting menu
items.

DOWN-ARROW (TRIANGLE) BUTTONS

Whenever you see a button with a down-arrow, or triangle pointing
down, it means you can click and hold on this button to open a pop-up
menu of choices.

= i

Clicking quickly on any down-arrow button will automatically reselect
the last selection without opening the submenu.

SELECTED SPECIES

Within most windows, only one species will be “active” at a time. And
when playing SimLife, you usually play with one species at a time,
checking it out in one window, spreading it in another, and modifying it
in yet another.

OTHER STUFF YOU
SHOULD KNOW
(SIMLIFE CONVENTIONS
AND TERMINOLOGY)

Tutorial
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Reselecting the species each time you jump to another window would be
a hassle, so in most windows, when you select a species, it becomes the
default or Selected Species for most other windows. The Selected Species
stays selected until you pick another one.

LOCAL SPECIES

Selecting a species in some windows does not make that species the
“official” Selected Species. The lucky plant or animal you choose in these
windows becomes the center of attention for the current window only—
they are local stars. Since we need to call them something, these are
called the Local Species.

Choosing or changing the Local Species in these windows does not
change the Selected Species or Local Species in any other windows.

Warning: the following definitions are very short and simplified to give
you just enough of a background to get started with SimLife. This is not
a complete discussion of these topics, and they are dealt with primarily
as they are used in SimLife, which is not a totally accurate representation
of the real world. (In spite of this warning, I know I'll get some tersely
reprimanding letters from biologists and other scientists for my casual
treatment of these issues. I'm doing my best. Soit’s not perfect. So shoot
me. I'll be taking notes for the upcoming manual for SimMartyr.)

LIFE

Defining life is not easy. (As if you'd believe me if I told you.) You'll get
a different answer from everyone you ask and every book you read. But
basically, life is a gene's way of making copies of itself.

Some definitions of life include the requirement that organisms be
composed of one or more cells. Is this chauvinism? If cells can be
considered “building blocks,” can we stretch the definition of cell to
include building blocks made of computer code as well as protoplasm?
Is this a subject that is likely to keep philosophers and science fiction
afficionados occupied for years to come?




For the purposes of playing with SimLife, we'll define life as anything that
exhibits lifelike behavior, including: adaptive behavior, self-replication
and the ability to extract order from the environment.

That's what life is. For answers to why it is or what it means, you'll have
to look somewhere other than in a computer game.

SPECIES

A species is a group of related organisms or populations capable of
interbreeding.

ENVIRONMENT

The environment, as used in SimLife, is the total external influence upon
an organism. This includes the influences of climate, landscape, other
life-forms and your computer. In fact, everything but the organism’s
genetic code.

ECOLOGY

Today, when most people hear the word ecology, they think of all the
things that are going wrong, like pollution, endangered species and
declining rainforests. But ecology, in our world as well as in SimLife, is
also the “good stuff.”

Ecology is the study of the interrelationships of organisms and their
environment. All the interrelationships, both good and bad.

ECOSYSTEM

An ecosystem is the combination of the environment and the life in it
functioning together as an ecological unit in nature (or in computer).

In SimLife, we will often refer to the world as an ecosystem, and use the
words “world” and “ecosystem” interchangeably, since the SimLife
world is such a small place compared to the world we live in. It is,
however, possible to have two or more ecosystems running simulta-
neously in a SimLife world.

Tutorial
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PLANTS AND ANIMALS

In SimLife, there are two basic types of life-forms: plants and animals,
which roughly correspond to plants and animals in our world, but are,
of course, much simplified.

All life wants to survive, individually and as a species. In order for an
animal to survive as an individual, it must find food and eat without being
eaten. To survive as aspecies, many of the individuals must also live long
enough to find a mate and reproduce.

The process of an animal finding food while simultaneously avoiding
becoming food is called foraging. Foraging includes defense from preda-
tors, and is 90% of animal behavior.

Finding a mate (in SimLife, at least) is almost a byproduct of foraging.
Animals follow their foraging patterns looking for food and water and get
distracted and sidetracked by the presence of the opposite sex.

Plants, as well as animals, have behavior. They aren’t as active or as
noisy as animals, but they have to absorb nourishment, reproduce and
spread their seeds.

Plants don't have to forage for food; they get their nutrients from the
soil, the atmosphere and the sun. In SimLife, areas with deeper soil
have more nutrients for plants. Unlike animals, plants can’t move
around, but their seeds can.

As plants and animals die, they decompose and enrich the soil (increase
the soil depth).




FOOD, FOOD CHAINS AND FOOD WEBS
Food

Food is anything that can be consumed by the life in SimLife. All the food
that plants need is found in sunlight, air and soil. Food for animals is
more varied and includes plants and plant products, other animals, filter
food and Ultra-Food.

Plants

When animals eat plants, they don't necessarily eat all the plant, or
enough of the plant to kill it. They can nibble the leaves and the plant can
grow new ones. Animals can also eat seeds, fruit and nectar from plants.

Filter Food

Filter food is the microscopic and near-microscopic plants and animals
in the water, air and soil that are eaten by filter food-eating animals. For
example, some whales live on plankton, tiny plants and animals that live
near the surface of the ocean.

Filter food is alive and needs nourishment, and often sunlight, so it
concentrates at the surface of the water, and near shorelines both in and
out of the water.

Other Animals

Animals can be predators and can eat other animals—if they can catch
them.

Ultra-Food

The closest thing to Ultra-Food that occurs in our world is the supermar-
ket, where you can walk in and get any and all the food you need. In
SimLife, this food source looks like a shopping cart. It supplies an
unlimited amount of whatever food an animal needs to any animal that
approaches it.

Ultra-Food is a useful tool for helping new ecosystems get started and for
miraculously saving the lives of starving animals.

Tutorial
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Food Chains

A food chain is an arrangement of plants and animals in an ecosystem
structured according to who eats whom. Usually with the eater shown
above the eatee.

Plants and filter food are usually considered the bottom of the chain,
with herbivores (animals that eat plants) in the middle and predatory
carnivores (animals that eat other animals) at the top.

Food Webs

A food web is the combination of all the interacting food chains in an
ecosystem.

GENETICS AND GENES

Genetics is the study of genes, the carriers of the genetic code that
defines what we are and sets the limits of what we can become.

The genetic code of plants and animals in SimLife is much shorter and
simpler than for organisms in our world. Whereas our genes are en-
coded and stored in a complex molecule called DNA, SimLife genes are
encoded and stored in something like a database file.

While fewer and simpler, genes in SimLife are very powerful. One gene
in a SimLife organism has the equivalent effect on that organism as
hundreds or thousands of our genes have on us.

CHROMOSOMES

Chromosomes are long chains of genes. There can be many (thousands
to millions) genes in a single chromosome. Different life-forms on earth
have different amounts of chromosomes: Humans have 46, the fruit fly
has 8, an onion has 16, a dog has 78 and a goldfish has 94.

In SimLife, each chromosome consists of a single gene.
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GENOMES, PROTOTYPES, POPULATIONS
AND GENE POOLS

Genomes
In SimLife, a genome is the set of all the genes in an individual organism.
The genome will be different for each species and may vary from
individual to individual within a species.

Prototype Genome
Every species in SimLife has a “prototype” genome. This is the original
or master set of genes—the genetic starting point when a species is
created. Through evolution, individuals will vary from the prototype
genome. Over time, individuals may vary so much from the prototype
that they would no longer be able to successfully mate with it, and by
definition become another species.

Population
A population is a group of organisms from a single species.

Gene Pools

A species’ gene pool is the total of all the genes in a population. It
represents all the genetic possibilities currently being explored by that
population.

A gene pool isn't an actual physical gathering of the genes—you don’t
take all the genes out of their organisms and mix ‘em up in a big vat or
pool. It's just a way to think of the information contained in a whole mess
of genes at once, while they are spread out in their various organisms.

EVOLUTION

What most people think of as evolution—adaptation of plants and
animals to changes in their environment, physical changes in plants and
animals, survival of the fittest, and new species evolving from older
ones—are not evolution, they are the results of evolution.

Tutorial
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Evolution, simply put, is the constantly ongoing process of changes in
the gene pool over time. Nothing more, nothing less. It is the combina-
tion of many minute genetic changes over a long period of time that
produces the noticeable results mentioned above.

The mechanisms that bring about changes in the gene pool are natural
selection, genetic drift, gene flow, mutation and recombination.

In SimLife, evolution can occur by all of these naturally occurring
mechanisms, plus one more. In SimLife, you can directly look at an
organism’s genes and physically change them.

SPECIATION

Speciation is the process of one species evolving into another (or group
of other) species. It usually occurs when populations of the same
species become physically separated and are subject to different envi-
ronmental pressures. Over a long period of time, the gene pools in the
two populations drift apart and eventually the two populations cannot
interbreed (even if physically brought back together), and they become
two different species.

In SimLife, species will automatically change into new species as they
diverge from the prototype (if you have AutoSpeciate turned on). These
new species will retain the same icon and name—with the addition of the
subname Version 2—until you change them.

You can also manually speciate—pick an individual and change it into
another species.
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Make sure the game is installed properly, then start it up. See your
machine-specific addendum for instructions.

This tutorial assumes that you have a mouse and know how to click,
double-click, and click-and-drag. If you don't have a mouse and/or don't
know how to do these things, see the manual that came with your
computer, and the SimLife machine-specific addendum.

Once the game has started, you will immediately be faced with the New
Game Window and a decision: picking a scenario to play.

TAKE A TOUR
OF YOUR
GOMPUTERIZED
ECOSYSTEM

DEGISIONS,
DECISIONS

| Craft your own plants and animals, and let
them loose n & world of your own design.

‘survive? Can you establish a stable food
chein? When will dissster strike?

—

| Experiments] Mode: Do whetever you want!

Or, pick various species from the Zooto
| inhabit your experiment. Will your plants

: Crests A New Mep?
Load & Game Play Scenpario

Each of the six scenarios present a different gaming and learning
challenge. You can also play SimLife in Experimental Mode and set up
your own scenarios and experiments. In addition, this window can
launch you into the on-screen tutorial. (If you haven't already been
through it, now would be a fine time for it.)

Tutorial
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AND ON THE
MENU TONIGHT....

HOW DASHING!

Click on (and highlight) the names of each of the scenarios—uwithout
clicking on the Play Scenario button. Read the descriptions of each
scenario as they appear in the big box in the upper-right corner of the
window.

After you've looked them all over, click on Experimental Mode, then click
on Play Scenario. We'll take a quick tour of the various menus and
windows in SimLife, then build our own scenario.

Take a moment and look at the Menu Bar. It will be at or near the top of
the screen. As usual, these menus group similar types of commands
together for easy access: all the file-related commands are in the File
Menu and so on.

Click and hold on each of the menus and take a quick look at the
commands. Slide the pointer (while still holding down the mouse
button) down to the different menu items. Notice that some items bring
up submenus. Look these over, too.

Check your machine-specific addendum for special menu details for
your computer and keyboard shortcuts for opening menus and select-
ing menu items.

The Dashboard is your control center.

The Dashboard will differ more from computer to computer than
anything else in SimLife. Depending on your computer, it may appear as
either a separate moveable window at the bottom of the screen, or as a
control bar at the top of the screen. It may or may not have the game
clock included, and it may have some other slight variations.

[n addition, in some versions (including DOS and Windows), the Map and
Edit Window Control Panels appear at the top of the screen along with
the Dashboard.
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NOW YOU SEEIT...

The left side of the Dashboard has lots of buttons and pictures. These are
for controlling which plants and animals are visible in the Edit and Map
Windows.

Arow of icons displays the different life-forms in SimLife, and how they
will look in the Edit Window.

Click on the “A” button to display animals, and the “P” button to display
plants. There are more plants and animals available than can be seen at
one time. Click the right and left arrows to scroll through all of them.

There is a little rectangle below each icon. Depending on your monitor,
the rectangle will be a color, a shade or a symbol. This rectangle shows
what the organism will look like in the Map Window. (Since the Map
Window covers such a big area, the life-forms look so small that they
can’t be shown as icons or pictures, so they show up as small colored
dots on color monitors and little symbols on black and white monitors.)

What if two of the animals you want to use are the same color or symbol?
You won't be able to tell them apart in the Map Window! Or what if you
just don't like the color we chose for your favorite electronic pet? Your
aesthetic sensibilities might be offended!

Never fear: you have the power to change the color/shade/ pattern of any
organism. Click and hold on any rectangle to reveal a submenu of all the
available colors/shades/patterns. (This is a super-secret hidden feature,
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so don't tell anybody about it. This information isn’t in anyone else’s
manual, just yours. We think you're special.)

Below each rectangle is an On/Off button. Clicking these buttons toggles
the display of each organism on and off in the Edit and Map Windows.

Turning a plant or animal off in the Dashboard does not kill it or change
it or remove it from the game or disk. It only turns the organism invisible.

Atthe moment, other than the buttons changing from saying “on” to “off”
and back again, nothing will happen since we haven't placed any of these
life-forms in the world yet.

Why not see everything all the time? It can be confusing to have hundreds
or thousands of animals running around on your screen. Sometimes it's
easiest to remove all the clutter and just look at one plant or animal (or
a couple of each) at a time.

A STAR IS BORN

The middle section of the Dashboard displays and lets you choose the
“Selected Species,” which is, at least for a while, the star of the show.

Often while playing with SimLife, you'll be concentrating on one species
at a time, jumping from one window to another gathering information.
If you select a species in one window, it is automatically selected for
most of the other windows. This way you don’t have to reselect the same
organism every time you switch windows.

The Selected Species can be chosen in most windows. To select it in the
Dashboard, read on.

GETTING DOWN

Some buttons in SimLife open pop-up menus when you click and hold on
them.

These buttons are marked by a small down-arrow. The Dashboard has
two of them, one near the middle, and one near the right side.

White
Yellow
Orange
Red
Pink

Purple
v Dark Blue
Light Blue

Light Green
Dark Green
Brown

Gold

Light Grey
Medium Grey
Dark Grey
Black
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Depending on your computer, click or click and hold on the down-arrow
button near the center of the Dashboard. You now see a menu of all the
plants and animals in SimLife. To select an item, click on your choice or
slide the cursor to it and let go.

The name of the new Selected Species will appear in the middle of the
Dashboard, and its icon will be highlighted in the Display section to the
left.

WITH A LITTLE HELP FROM MY BUTTONS

As you may have noticed, many of the windows in SimLife have a lot of
buttons, including the Dashboard. To help you remember what all the
buttons do, we give you yet another button.

Click and hold on the Help button. As long as you hold down the mouse
button, you'll see a display of what every button in the Dashboard does.

Most windows in SimLife have these Help buttons, and they all work the
same way. Use them any time you want a reminder of what does what.

Near the Help button are a couple of words. These words indicate the
currently active tool in the Edit Window. We'll come back to this later.

See Animasl Specief ) Species Selection Pap-Up Menu
Scroll Species Left i
See F']I:nt Species ieon 1052 Pk Currently Selected Edit Window Tool

Seroll Species Right g £ Show Edit Window
arme o
Color Pop-Up Menu for Displaying Selected ; Sh':'wsr::i N—

Species in Map Window .
Show Climate Lab

On/Off Switch for Species Census Window
Dizplay in Map and Edit Windows Fop-Up Menu
The Currently Selected Species Pause(’Run
|

Species
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HOLD ON A MINUTE

The button on the far right of the Dashboard pauses the simulation. It
works just like a pause button on a tape player. Click it to stop time. Click
it again to start time.

When you're done playing with it, leave the Pause off.
YOU CANGET THERE FROM HERE
To the left of the Pause button are five window-opening buttons.

Open Biology Lab
Open Edit Window Open Census Window
| Pop-up menu

REEEE

Open Map Window ' Open Climate Lab

From left to right, these buttons open or activate the Edit Window, Map
Window, Biology Lab, Climate Lab, and the many Census Windows.

Notice that the Census Windows button has the down-arrow—that
famous down-arrow that means a pop-up menu is hidden under it.

Click and hold on the Census Windows button and look at the pop-up
menu of all the Census Windows.

Take a minute or two and click on each of these buttons, open all the
windows, including all the Census Windows, take a quick look at them
and then close them. Except for the Edit Window, they can all be closed
by clicking in the close box in the upper-left corner of the window. Asthe
windows appear, you'll notice a couple things:

o The Dashboard always stays on top of any other
window—even active ones.

* Only one Census Window can be displayed at once.

Tutorial
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oEE THE WORLD

Once you've had a chance to glimpse each of the windows, take a closer
look at the Map Window. You can open or activate it either by clicking
on the Map Window button on the Dashboard or by selecting Map in the
Windows menu.

Title Bar

Close Box

Edit
Rectangle

.ﬁ... Low-_ High @I a Slleolm] e P‘opulata“
= :

TP T TR | _on | % ] Select One

Map of the World

- Display Area

Build World...

Map Window Control Panel

This window shows you the entire world. If your screen is big enough,
you can move the window around by clicking and dragging the title bar.
You can close the Map Window by clicking in the Close Box in the upper-
left corner.

The main portion of this window is the map of your world. Somewhere
in the map is a rectangle—the Edit Rectangle. It outlines the part of the
map that is visible in the Edit Window (a close-up view of parts of the
world that we'll be looking at soon).
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CONTROL THE WORLD

Note: as shown in this manual, the Map Window Control
Panel is found at the bottom of the Map Window. On some
computers, it will appear at the top of the screen, as part of
the Dashboard. Don’tworry, it’s there somewhere. See your
machine-specific addendum for details.

At the bottom of the window is the Map Window Control Panel. It
controls what information is seen in the map.

In just about the middle of the Map Window Control Panel is a Help
button. Click and hold on it to see an explanation of what all the other
buttons do.

The five buttons on the left toggle on and off displays of multi-level data.
Each of these displays a range of information, like Altitude low to high.
Only one of these can be on at a time. Just to the right of these buttons
is a color key to help interpret the multi-level information.

Go ahead and click on them. When you're done, leave the Altitude
display on.

To the right of the Help button are seven buttons that toggle on and off
displays of single-level information. Any or all or none of these can be on
at the same time.

At this point, since the world is still very empty, the only button that will
change anything in the display is the Water button. But go ahead and
click on all of them if it makes you happy.

At the far right of the Map Window Control Panel are two buttons that
open two more windows, one to build worlds and one to populate them.

Tutorial
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WORLD
BUILDING 101

| Build World... l

; Rg wn&! World
Wsather Average
Vaﬁutm Temp.

Cold

. Many

Mountains

None

Dry

We will now design a world and build it. For this tutorial, any world
will do, so go ahead and be rash in your upcoming decisions.

Click on the Build World button in the Map Window Control Panel to
open the World Design Window.

wWorld Demgn

High
“l’:;xms
Regional World  World
Weather Average Average
Variation Temp Moisture
Hu{ugens

l“hau

World Food Suurcas
Size:
: RWE?"S
‘ Mouriains
'-3"35 eerﬂ Brs

_Msver Mind
; New Waorld Name: - :
_ ]untlﬂed world | large i | Make It So ' '

HE

- The World Design Window has a number of sliders and
World buttons. Three of the sliders control the world’s climate,
Average controlling the average weather variation, average tem-
Moisture  perature and average moisture. (In SimLife, moisture
includes both humidity and precipitation.)

Set these anywhere you want by clicking and sliding the arrows on each
slider.

Next, set the sliders for the amount of rivers and lakes you want and for
the number of mountains you want.

Over on the right are sliders that control how many artifacts will be
spread around the world. In SimLife, artifacts are anything that can
appear in the world that is not plant, animal, land, or water. The four
artifacts are:

* Toxins—poisons that negatively affect the health of
organisms;

* Mutagens—substances that increase the odds of mutation;
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* Food Sources—this refers to Ultra-Food sources that supply
any and all food that animals require; and

 Barriers—barricades that SimLife organisms cannot cross.
Set these four sliders anywhere you want.
Next, we'll pick a size for the world. There are four choices, each of which
is best for different experiments. Keep in mind while choosing a world
size that the larger the world, the longer it takes the computer to build

it, and the slower the simulation will run.

Choose the world size you want. (I recommend small, but it's your
world.)

Now you get to name the new world. Highlight the words below New
World Name: and type in whatever you want.

New World Nﬁme:

Juntitled world

Now, click on the Make It So button, and the world will be built, layer by
layer, before your very eyes. If a dialog box or requester asks if you want
to save the current world, click No.

Now we have aworld. A barren, desolate, lonely world. Nothing to do, no
one to talk to. Time to get a life—or better yet, a whole lot of it. Click on
the Populate... button in the Map Window.

The Populate Window lets us add plants and animals to the world smgly

or in large groups. — — =
| Populate
what o Do 4 Selacted Species: whers. |
e |
| e | nsus] |
| i o e ey
! [I M\ﬂfﬂ‘lnﬂ” m-nsnl

M

Tonms
r‘iutegens
Food Snurl:as

Burriers

Warld
Size:

Tiny

[

LIVE AND LET
SIMLIVE

| Powlate... l
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Click or click and hold on the down-arrow button in the Species box. A
submenu of all the available plants and animals—just like the one in the
Dashboard—appears. Slide the cursor until the llama is highlighted,
then either click or release the mouse button.

Now click on the up-arrow in the

Number box until you reach 10 or 20.

Click on the Add a Group button.

Click on the On the Land Button.

Tl 7y —

Add a Group I

On the Land I

Now click on Make It So. Ten (or however many you wanted) llamas are
now alive and kicking in the new world. Now we have ten lonely llamas.

THE LIFE OF THE PARTY

Let's get this party moving and really put some life into it. Again, open
the Populate Window by clicking on the Populate... button in the Map

| o Window.
. [ Populate
What te Do Selected Species: izl
(I am—— | =
Number: —
Ty ey

‘ be scattered all over the world.

i Populate
| What to Do Selected Species. Where
e | (.
e pa—y
] i EEm—
[] Never Hing " HMake |1 So I

Clickand hold in the Species box, then slide the cursor to All Plants.
- Set the Number box to 25. Click on Add Scattered. Click on On the
Land, then click Make It So. Twenty-five of each plant species will

~ Repeat the above process, but for Species, select All Animals.

The world is now filled with life of all sorts. You can see the animals
scurrying around in the Map Window, but let’s take a closer look.

Find the Edit Rectangle in the map. Drag it to a part of the world you
- want to explore, then double-click in it.
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XN TR o | 5 ] Select One

You are now in the Edit Window, ready for a close-up tour of the world.

Title Bar
Ed]t ———— Euperlmelntat uLlE——0 — ¢
Window ' |
Control
Panel -
— Display
Area

Jostick x5l .

— | — Size Box

Scroll Bars

You can move the Edit Window around the screen by clicking and
dragging the Title Bar. You can resize the window by clicking and
dragging the Resize Box in the lower-right corner. You cannot close the
Edit Window.

The main section of the window is the Display Area, where you can see
various plants, animals and artifacts, as well as land and water.

LOOK CLOSELY

Tutorial
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Day /Night & Season indicator

eyl ¥

Digital Clock

Decrease Temperature

Decrease Moisture
Increase Moisture

Decrease Altitude

o Increase Altitude
f—— Turn On/Off Altitude Layer

———— Life Tool Pop-Up Menu
Add/Remove Water

Turn On/Off Life Layer

Add/Remove Barrier

Add/Remove Toxins
Add/Remove Mutagens

— Increase Temperature
= Turn On/0ff Temperature Layer

t—— Turn On /0ff Moisture Layer

Turn On/Off Water Layer

Add/Remove Ultr a-Food

THE DEAD SEA SCROLLS. SO DOES THE LAND.

Since the world is too large to show in the Edit Window all at once, you
can scroll the window to show different parts of the map.

Depending on your computer, there are a few ways to scroll. Check with
your machine-specific addendum for more information on scrolling with
your computer.

There is a “joystick” for scrolling. Click or click and hold on any of the
arrows to scroll the window in the arrow’s direction.

Note: On computers with small monitors the joystick will not
be visible. Sorry.

In addition, if your Edit Window has Scroll Bars and Arrows, you can use
them. If not, you can move the mouse to any edge or corner of the screen
to scroll.

However you do it, scroll around and look the world over.

THE DISTINGUISHED PANEL

Note: as shown in this manual, the Edit Window Control
Panel is found on the left side of the Edit Window. On some
computers, it will appear at the top of the screen, as part of
the Dashboard. See your machine-specific addendum for
details.

Along the left side of the Edit Window is the Edit Window Control Panel,
filled with buttons and tools. Notice our old friend, the Help button. Click
and hold on it to see a display of what everything does.

At the top of the panel is the clock. It graphically shows the passing of
day, night and the seasons. It also gives the Tick, Day and Year. Ticks are
the smallest unit of time in SimLife. A tick is the time it takes an animal
to move one step and do one thing. The actual time a tick takes depends
on your computer’s speed, the size of the world and the number of plants
and animals currently living.
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Below the clock are a lot of buttons that activate the different Edit
Window tools. The name of the active button is displayed in the
Dashboard to the left of the Help button.

Immediately below the clock are three groups of buttons. These let you
not only choose whether or not to display the simulation information on
temperature, moisture and altitude, but let you adjust the settings.

Moving Up In The World

Click on the Altitude button. Notice that the land is all shown in one
color/shade/pattern. The altitude data is not shown. Click on it again and
the mountains and valleys come back.

Now click on the up-arrow button to the right of the Altitude button, then
click and/or click and drag the cursor in the Display Area. A mountain
rises from the land.

Click on the down-arrow button to the left of the Altitude button, then
click and hold on the mountain. It settles back into the plains.

A Hot Time In The 0ld World Tonight

Now click on the Temperature button. A display of the temperature data
is added to the Display Area using colors or shades, depending on your
computer. A key to interpreting the colors/shades can be found in the
Map Window Control Panel, when the multi-level temperature display is
on. If you can arrange your screen so the Map Window Control Panel
shows below the Edit Window, it will make it easier to see the key.

Click on the up-arrow button to the right of the Temperature button,
then click and/or click and drag the cursor in the Display Area. The
temperature rises.

Click on the down-arrow button to the left of the Temperature button,
then click and hold in the Display Area. The temperature lowers.

The Moisture buttons work the same way.

Turn the temperature display off.

[
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T
Al

[.,_:Populate
Smite
Move
Clone

The Carrot
Highlight

Show Genes
Show Dariables
Show Phenotype
Speciate

Just The Artifacts, Ma’am

Now look at the four buttons just above the Help button. These let you
place or remove Artifacts.

Click on the Food Source button (the one that looks like a shopping cart).
Now click or click and drag in the Display Area. You've placed Ultra-Food
(a universal, unlimited food source) for your animals. To remove the
sources, just click on them.

The other artifact buttons let you place and remove barriers, toxins and
mutagens in the same way.

Water You Doing?

Just above the Barriers button is the Water button. Click on the little On/
Off button below it to toggle the display of water on and off. Turning it
off doesn’t make the water go away, it just makes it invisible.

Make sure the display of water in set to On. Click on the Water button,
then click or click and drag the cursor in the display area to make water.
If you click or click and drag on water, it will turn back into land.

This Is The Life (button)

We've saved the most powerful button for last. The Life button does a lot
of different things, all related to adding, removing, displaying and
modifying life.

Note: In any of the steps below, if you find it difficult when
asked to click on animals while they are moving, pause the
simulation by clicking on the Pause button in the Dashboard.

Click on the little On/Off button below it to toggle the display of life on
and off. Turning life off doesn’t make the life go away, it just makes it
invisible.

To choose what you want the Life button to do, click and hold on it. A
submenu of all the button’s functions will appear. Then slide the cursor
to your choice and release the mouse button.
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Pop—You Late!

The default setting for the Life button is Populate, which adds life to the
world. The species to be added can be set in the Dashboard (the Selected
Species).

Go to the Dashboard and select LLucia’s Llama as the Selected Species.
Then go back to the Edit Window, click and hold on the Life button, and
select Populate. Now click in the Display Area to add llamas.

I Smite And I Smite Not

Click and hold the Life button and select Smite. Click on any living thing
in the Display area, and it will die. Use this judiciously.

Get A Move On

Click and hold the Life button, and select Move. Now click and drag any
living thing to move it to another location.

Send In The Clones

Click and hold the Life button, and select Clone. Now click and drag any
living thing to another location. Instead of moving the original organism,
Clone makes a duplicate organism and places it where you release the
mouse button.

If you hold down the Option key—or Control key if your keyboard has
no Option key—while cloning, the clone will be mutated in some random
way.

Highlite The Low Life

Click and hold the Life button, and select Highlight. Now click on an
animal to highlight it. Open the Simulation Menu, open the Goodies
submenu, and select Auto Tracking. Now the Edit Window will automati-
cally scroll to keep your highlighted animal showing. The animal will
stay highlighted until it dies or you highlight something else.

£
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I Don’t Carrot All For This

Click and hold the Life button, and select The Carrot. Now click and hold
somewhere in the Display Area. All the members of the Species you
highlighted will flock to the cursor.

Pull Down Your Genes

Click and hold the Life button, and select Show Genes. Click
on any plant. The Genome Window with the complete
genetic code for the plant will appear. We'll play more with
the Genome Window later. For now, click on Never Mind.

Now, with the Life button still set to Show Genes, click on an
animal. The Genome Window with the complete genetic
code for the animal will appear. Notice that animals have a
more complex genetic code.

Click on Never Mind.

Let's Get Personal

Click and hold the Life button, and select Show Variables,
then click on a plant. This brings up the Variables Window,
which gives the current status of the plant you clicked on.

The Variables are all the information the simulation has about an
organism that isn't in its genetic code, like age and size.

Click in the Close Box to close the Variables Window. Repeat the process

for an animal. 0 Llucia's LLama 6
| Help_i
tlth _ —
Food _
L —— water e —
L —— Radration [prreiomviimerizire
‘Water r = . - r
O o e
Woigh [T ekt
Height [£0 9 anensasss o age [TE51 *
Weight[TTZ  rhiisiinnieiaininy Forage Count e
o L Gestotion [~k
) . | v'm digital
~ "
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Let Me Look At You

Click and hold the Life button, and select Show Phenotype, then click on
an animal.

This opens the Phenotype Window for the animal you clicked on, which
is sort of a close-up view of the animal—and sort of isn't.

This picture isn't really what the animal looks like. It's a compilation
picture made out of parts of animals that we are all familiar with, to give
us some idea of how the animal fits into its environment.

From the picture, you should be able to tell what the animal eats, how
it moves, where it lives, and how many young it has at a time.

These compilation pictures are the flash cards used in the Biology Lab
for designing plants and animals.

Click in the Close Box to close the Phenotype Window. Repeat the
process for a plant.

Let’s Split
Click and hold the Life button, and select Speciate. Now click on any
plant or animal. The Speciate Window opens.

Among other things, you can use this
window to change the organism into
another species, or a new species. For
complete details, see the Reference
section below.

| Speciate
E LLucia's LLama B2

Make Me Prototype Of Species !
Make Me Into A New Species |
‘MWTOWMBQW

New Species =d
LLucia's LLama E

Never Mind §

(Click on Never Mind to make this win-
dow go away.

‘Walking, lives in mountsins
Long gestation time, few children

7

|

Makes nectar, dropping Seeds
Evergreen temperate tree
Land Plant, sprouts in Cold dry weather

7/
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A HIS T 0 R I l:Al A goodly amount of time has passed since this world was created. And

EVEN'I’ a lot of things have happened. But what happened when? And what
might have happened that we didn’t notice?
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This window lists the world's important events along with the date they
happened. You can use the Older, Newer and Latest buttons to page
o L through all the events.
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Horse hes no females left.
Killer 8's eee has become extinct eee

Beyond the Nuclear Family...beyond the Atomic Family..beyond the Generic Family..it's...

The ADYENTURES of the GENETIC FAMILY!

You tell ‘’em Pop!

Featuring:
Mr. and Mrs. Gene Poole, their son Codon, their daughter Allele, and their dog Bowser.

< )

;\ ~ ..creates together.

FON N

The family that
mutates together...

My dolly can
rhyme better
) than that.

1

1 T Better living
through GENETIC
ENGINEERING!
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All things come to an end. And until you get the hang of building a viable
food chain and ecosystem, you may be tempted to call this game
SimDeath instead of SimLife.

Tracking down the causes of death can give you insight into problems
in the ecosystem. And to help you investigate the causes of death, we
present the Mortality Window.

Click and hold on the Census button in the Dashboard, slide the cursor
to Mortality, and release the mouse button.

This window graphically and numerically shows how many organisms
have died and what killed them. You can look at mortality data for an
individual organism, or for All Animals or All Plants at once. The data
shown goes back five years.

When you've had enough of digging through death, close the Mortality
Window by clicking in the Close Box.

Let's design a new plant. Click on the Biology Lab button in the Dash-
board to open the Biology Lab.

Biology Lab at Select Level

(Close Box ” Title Bar
bt | ~ Plant and
Animal
Pretty Menu
Picture of —
Tule
Hew Plant ‘Seve Al Ple Delete All Flents Load & Species
Mew animal Seve All Arigals Dslste All Animals Lood & Zoo J

Many Buttons

DEATH, WHERE 1S
THY STING?

Eaten

01d Age
0

Disesse
)

No ‘Water

Mo Food

20 40 &0 80 100
Percent of All Deaths

GOING TO SEED

#

3]
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The Biology Lab has two levels, the Select Level and the Edit Level. You
are now looking at the Select Level. This is where you can load and save
organisms individually or in groups, or start new ones.

We're going to make a new plant, so click on the New Plant button.

You are now at the Edit Level of the Biology Lab, ready to work on your
new plant.

Biology Lab at Edit Level

Close Box he Biology Lab Title Bar
Name Box .
Slider
E] HMating
- pet——— v, Controls
E! % Geres from
Flash El 1 i — 2 - Father
CardH E £l 2 Undo M mmws
Section flowers e teaves
n amaas
L] Icon Editin:
No nectar, drifting seed H
Mdmurtum;erate grﬁ; Secnon
Land Plant, sprouts in cold dry weather

IButtons

A ROSE BY ANY OTHER NAME

Right now the name for the new plant is New Plant, which isn't very
charming or expressive. Click the Rename button, highlight the words
“New Plant,” and type in a new name—how about Rover?—and click
Make It So.

Enter a new name for the
species you are currently
editing in the Biology Lab.
Please limit the name to 15
characters or less,

[Rover‘i J
_
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WOW. WHAT A FLASH

Below the name is the composite picture of the plant, as seen in the
Phenotype Window. The plant is made of three pictures. To the left of
each picture are arrows.

Youcan click on these arrows to cycle through all the pictures. Go ahead
and do some clicking. As you do, notice the text below the pictures—it
describes the plant you are designing.

The top line of text describes the top picture, which defines the plant’s
flower: whether or not it makes nectar, and what type of seeds it has.

The middle line of text describes the middle picture, which defines the
plant’s structure, its preferred climate and whether it is deciduous or
evergreern.

The bottom line of text describes the bottom picture, which gives the
plant’s sprouting needs and tells whether the plant lives on land or
water.

Sowe're on the same track for the next step, click around until your text
and picture match this:

- Deciduous temperate shrub
Flosting, sprouts in warm dry weasther

D ([T [IpE] "5 DE] L] =

Once your picture matches, notice the row of buttons below the plant
description. Click on the third button from the left. This button writes
the genetic code for your new plant based on the flash cards you chose.

Tutorial
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R

That was easy. We designed a plant by making only afew major decisions
and left the details up to the computer. Let’s go a step deeper and play
directly with the plant’s genetic code to do some fine-tuning.

Roll up your sleeves and read on.

| DREAM OF GENOME

Look again at all the buttons below the text section. Click and hold on the
Help button and look it over for a few seconds.

Most of these buttons are very powerful tools for advanced experi-
ments, so for now, we'll only deal with one or two.

Click on the Edit Species Prototype Genome button.

| Species Genome for Rover st You now see the Genome Window that defines Rover.
Gender Foth (24 Evaporation Rate  Fo All the genetic information in the text and pictures is
Structure floating E - it W
L ]| Sk e T here, plus a few other genes.
S (U - S brinsrilinrs Let's modify Rover a little. First, we'll give Rover male
etk T . Haminam Siga flowers instead of both. Click and hold in the little
T down-arrow button to the right of the word Gender,
(2ed 0id Age
|[never rin] | rake it Sof Bl T .
' = slide the cursorto Male, and release the mouse button.
< Male
G O = Female
v'Both
Now, let’s let Rover make Nectar, so click on the button next to Nectar.
o
Structure floating

v Floating
Grass
Shrub

Now, something big: let’s turn Rover into a tree. Click and hold
on the down-arrow button to the right of the words Structure and
Floating, slide the cursor to Tree and release the mouse button.
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When it was a floating plant, Rover didn’t need to store much water, but
now as a tree, it will need a lot of water storage capability. Click and drag
the arrow on the Water slider about three-quarters of the way to the
right.

Note: when you make majorchanges in the genome, be sure
tocheck overany related genes. If we didn tadjust the Water
Storage gene while making Rover a tree, they all would
have died of thirst before maturity.

That’s enough genetic tinkering for now. Click on Make It So to return to
the Biology Lab.

|A HARD DAY AT THE OFFICE... }

The old drip \F/eab,‘that Gasp!
. oole’s
cant k@ep up ALLi WET! /

with us.

—

This could be the answer! The Bremco

HOME GENE SPLICER-DICER! \

|
|
e
l

Ahl Here Nobody can call this Poole all wet!

g, .eelf-improvement
for the office!

-
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Gene Pool
Diversity

' Mating

J W Difference
r—ﬂu—# %GQW from
Father

FLASHBACKS

Now look at the flash cards. The flashcard image automatically updated
to match the changes in the Genome Window.

TIME OUT!

OK, here’s something to remember: we haven’t been designing an
individual plant—we've been designing an entire species. The “Rover”
we've been working on is the prototype for a whole species of Rovers.

As you place new Rovers into the world, they will be based on this
prototype, and vary only slightly. When new Rovers are born, they will
be based on their parents.

OK. Back to the Biology Lab.

THE FINAL TOUGHES

Just three more items to be mentioned and Rover is done. There are
three sliders in the upper-right section of the Biology Lab.

The top slider sets the amount that the Rovers you place in the world will
vary from the prototype. The farther to the right you set the Gene Pool
Diversity slider, the more variation in the genes in all the Rovers-to-be.
The more the variation, the more possibility for evolution. This slider
does not affect Rovers that are born to other Rovers.

The middle slider, Mating Difference, sets how genetically different two
Rovers can be and still produce offspring.

The last slider, %Genes from Father, sets how many of the Rover-
offspring’s genes come from each parent. We humans get ours 50/50, but
you can set Rover anywhere you want.

That's it. Rover’s all designed and done... except for the way it looks in
the Edit Window. Now we get to draw some pictures.
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IGON DO IT. CAN YOU?

The icon we draw for Rover won't affect it or its genes in any way. The
only thing the icon does is help us identify it when we see it in its
environment. You can be as silly or abstract as you want when drawing
icons, as long as you can remember what they are.

Aplant needs four icons, one for when it's a seed, one with no leaves, one
with leaves, and one with flowers.

Buttons — _ .
: @saeﬁs no lefves Actiial Size
ﬂowfrs leaves Icons
: .
Palette — J— Drawing Area

A Seedy Spot

First, we'll draw the seed icon. Click on the little icon for seeds, then click
on the Clear button.

Now click on a color. Draw the seed just as you would with any paint
program: click or click and drag on a blank spot to draw, click or click and
drag on a colored spot to erase it. As you draw the icon in the large
drawing area, it appears real-size above.

If you wish, and you have them, use other colors to adorn the seed. My
icon for Rover as a seed is here, to the right.

1 ]
ITTT T T 1TT
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E' seeds ?ﬁ no leaves
flowers leaves
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Branching Out

Click on the “No Leaves” icon, then click Clear. This icon represents the
plant when it has branches, but no leaves or flowers.

Draw it however you want (but remember, Rover is a tree). My Rover
with no leaves is shown to the left.

Leal Me Alone

Now we want to draw the same thing and add leaves. Before changing to
the next icon, go to the Edit Menu at the top of your screen, and select
Copy Icon.

Next click on the Leaves icon, then select Paste Icon from the Edit Menu.
We've got our branches—all we need to add are the leaves.

Go ahead and add leaves.

Rover In Bloom

Choose Copy Icon from the Edit Menu again, select the “Flowers” icon,
then select Paste Icon from the Edit Menu.

Now add your flowers.

The Easy Way

For those of us who can't draw worth beans—or are in a hurry—there
are a number of professionally pre-drawn icons. Click and hold on the
Icons button just above Undo to see a submenu of 32 icons to choose
from. Just look now—be careful not to choose one or your personal
artwork will be lost.

Each of these icons only shows the one stage with leaves, but if you
choose one it supplies all four icon stages of the plant.

We could have just chosen one of these and saved all the time and
trouble of drawing our Rover, but don’t you feel like a better human
being for having done it yourself?
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Rover’s All Over
Now click on the Return To Select Level button.

Notice that Rover is now amongst all the other plants in the Species
Display.

Click on the Save button to save all our hard work to disk for future use.
Not only can you use Rover now, but you can load it into any future
games or experiments.

lfyouhave any questions about saving plants, see your machine-specific
addendum.

Spreading Your Seed
Close the Biology Lab by clicking in the Close Box.

Make sure Rover is the Selected Species in the Dashboard.

Go to Edit Window, set the Life Button to Populate and place a few
Rovers. When you place them, they are seeds. As time passes, they grow
branches, then leaves, then bloom. If Rover is too stupid to bloom, it
must be a blooming idiot.

Now we'll look at one more window. Open the Windows Menu and select
Evaluation.

The Evaluation Window lets you know
how well you're doing at ecosystem man-
agement by giving you a Score, a Rating,
and a Status report. It also pictorially
shows which ecological niches are cur- |
rently filled with plants and animals. You
can click on any of the pictures to get an
explanation of what they represent.

£ o=t B4 Udfd[fdl.d
] w6 w6 Ko | Ko Ko Ko

i ok G G110

YOUR REPORT
CARD

Evaluation

Score: 1049
Rating: Murseryman

Status: Animals are dying off
Click on pictures for more info...
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SEMI-SORTA-
SUMMARY

This concludes Part 2 of the tutorial. We've been through a lot of windows,
features and functions and you should understand enough to figure out
any new ones you run across. Congratulations.

[n addition, we've gone through the process of plant design. The process
of animal design is very similar and will be dealt with in detail in the next
section of the tutorial... speaking of which...

The next and final part of this tutorial will be the design, setup and
execution of a complete experiment. Thrills, spills and fun for the whole
family. Don’t miss it!
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Now it’s time to design, set up, carry out and evaluate an experiment.

SimLife is very complex and has a massive amount of features. One of
most powerful features of SimLife is the ability to turn off or eliminate
many of the features for better experimental control.

[n any experiment, control is a primary issue. All possible outside
influences must be eliminated for the experiment to be valid and to really
find out who did what to whom and why.

Now, we'll set up a very simple experiment. We'll turn off and leave out
anumber of factors. This gives us complete control over the experiment
and will also make the simulation run faster.

A summary of this experiment, along with blanks to fill in your data and
write your conclusions, can be found in the lab book included with this
product. If you don’t want to mark up your lab book, you may make a
photocopy of it for your personal use and mark that up. No selling copies
of the lab book in dark alleys to minors while wearing a trenchcoat.

The goal of this experiment is to observe evolution (a change in the gene
pool) through natural selection.

We will focus on a few genes in particular: Roaming, Turning, Turn Type
and Turn Angle. The Roaming gene controls how likely an animal is to
keep moving even though it is not necessarily hungry or thirsty. The
Turning gene controls how often the animal turns while moving. The
Turn Type and Turn Angle genes control how the animal moves when it
is turning.

We will set up a world where environmental pressures favor survival for
an animal with a high tendency for roaming and turning and see if, after
a number of generations, the animal’s gene pool changes to increase
these tendencies.

BUILDING AN
EXPERIMENT:
SPLATT

THE SIMLIFE
LAB BOOK

THE GOAL OF THIS
EXPERIMENT

THE APPROACH

Tutorial
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THE PLAN
OF ATTACK

STEP ONE:
BUILD-A-BUG

For simplicity—and control—the world will have only two species of
animals—the experimental subjects and the control group. Both spe-
cies will be supplied with all the food and water they need.

Environmental pressure to promote roaming and turning will only be
applied to the subject group. And that pressure will be you. You will act
as the predator and use the Smite function of the Life button to kill any
of the subject animals that hold still too long—those that don’t roam
very often.

No other predators will be allowed into the world where they might
cause different or unknown environmental influences.

The steps we'll be taking in setting up the experiment will be:
Design and build the subject animal.

Duplicate and rename the subject as the control animal.
Design and build the world needed for the experiment.
Modify the climate for optimum control.

Change the laws of physics for optimum time passage.
Populate the world with the subject and control species.
Record the starting genetic data for both populations.
Apply the environmental pressure for a number of generations.
Observe the results, at two points in time.

Analyze the results.

S Lo U W=

oy

The first thing we need to do is design and build the animal that we will
be hunting down and killing.

We at Maxis believe in the sacredness of all life, both real and artificial.
All life-forms have their place in the ecosystem and the universe. We
suggest you only destroy animals, even electronic ones, for a good
cause—Ilike this tutorial.

When deciding who should live and who should die, keep in mind that
some organisms are, well, let’s just say that killing some animals inspires
less guilt than others. Speaking of cockroaches, let’s model our experi-
mental subject after them.

4




If you feel personally offended by using cockroaches as test subjects,
then you can always turn off your computer and curl up with a good
Franz Kafka story. Or, instead of modeling the subjects after cockroach-
es, base them on something else... since we're dealing with the Roaming
gene, you can make your critters look like noses and call them the
Roamin’ Noses. (Iwas going to use the Roamin’ Noses in this experiment,
butIcouldn’t draw good nose icons.) Or you could make the animal look
like your older brother, your boss, or anyone or anything else you'd
enjoy splatting.

PREPARATION

Before you can continue with this experiment, make sure SimLife is
running and in Experimental Mode.

BI0-MANIPULATION

Click on the Biology Lab button in the Dashboard.

e Piant sove ol Pinnts. | [ Dateta Al Piants E[ Lot & Species
tene Animal Save a1t animais | | Datete a11 Aniimels Lot A 200

When the Biology Lab opens, click on New Animal.

Tutorial
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Now we name our new test-subject-to-be. Click on the Rename button,
highlight the old name, type in a new one, and click Make It So. I'm nam-
ing my new animal Splatt.

Enter a new name for the "
[Spiatt |

p— - species you are currently
Rename ~ editing in the Biology Lab. - £
M Please limit the name to 15 Never Mind 7

characters or less,

Next, we'll set the three sliders above the icon section. Since we'll be
dealing with a relatively small population, we’ll need as much Gene Pool
Diversity as possible. Set it all the way up.

Set Mating Difference all the way up, and set %Genes from Father to 50%.

We've got some serious gene-splicing to do, so we'll skip the flash cards
and go straight to the Genome Window. Click on the Edit Species Proto-
type Genome button.

YOU ANIMAL, YOU

Notice that the Genome Window for an animal is much more compli-
cated than for a plant. In addition, there are two indicator bars in the
lower-right corner, for Maximum Size and Energy Requirements.

There is no free lunch in SimLife. The more powerful and versatile you
make an animal, the more energy it will need to survive. You can make
an animal so strong and fast and stealthy and dangerous with such great
vision that it would be invincible—but even if it lived in a supermarket
it couldn’t eat fast enough to survive.

THE SPLICE OF LIFE

In general, our requirements for this animal aren’t very demanding. All
we want it to do is eat and reproduce and roam. It won't have any
enemies to contend with, and it won’t have to search or fight for food or
water.
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Set your animal’s window to look something like this: r

Animal Design Summary
Here [ will just mention what each setting should be.
See the Reference section below for a complete
description of what each gene does.

1. Keep the Gender Male or Female; if it's sterile or Tun Type Turn Angle st Aation
. 3 ) Im-hv =i |r1n Low ;’ Time Danger
asexual it won't show us very much evolution. i 8 Ly —

2. For Movement, just Walking will do.

T e rom [ovoringf rake 1059] |

3. It will only need one Food Source, but since
we're using cockroaches for our model, click them all. (Notice that
each type of food you add increases the animal’s energy require-
ments. For this experiment, it won't matter, but be careful in others.)

. Set Share Food and Persist to about 50%.
. Set Roaming and Turning to about 25%.

o U e

. Set Turn Type to Zig-Zag, and Turn Angle to Medium-Low.

-1

. There will be nothing to prefer, avoid or ignore, so we'll prefer to
ignore the avoidance settings.

8. Set Life span to 50%. (We don’t want the older bugs to clutter up our
ecosystem.)

9. Set Adult to 25% so they’'ll mature quickly.
10. Set Die-off to middle-age.

11. On the Features, set Size and Vision to about 25%, and Stealth and
Weapons to (.

12. For Gestation, set Size to 25% (or less), Time to about 5%, %Female
to 50%, and Mutation all the way down.

13. Set Number Of Children to 4.

14. For Food (internal food storage), set Max to 50%, Danger to 25%,
and Action between them.

15. Set Water the same as Food.

16. For Health, set Max all the way up, Action at about 50%, and Danger
at about 25%.

| Make It Sul
Now click on Make It So to return to the Biology Lab.

Tutorial &7
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I Save l

PRETTY PICTURES

The final stage in designing Splatt is making the icons. With plants, there
were four. With animals, there are only two, one for the animal as a child
and one for the animal as an adult. (There are actually four animal icons:
the other two are flipped images of the first two, so when the animals
move around the Edit Window they don’t look like they're going back-
wards. These flipped icons are automatically made for you, courtesy of
your friendly local computer.)

Now is the time to let your artistic talents shine, to express the very soul
of Splatt in a grid of 16 x 16 colored dots. Try to evoke the essence of
Splattness, or just do anything—as long as you will be able to recognize
it in the Edit Window, and are able to distinguish it from any other life-
forms.

Click on the Adult icon, then click Clear. Now draw an icon to represent
Splatt the Roach, or Splatt the Nose, or Splatt the little sister, or

whatever. My Splatt is shown to the left.

So, maybe it does look more like a rabbit than a bug. | know what it is, and
that’s what counts.

Next click on the Child icon, then click Clear. Now draw a portrait of the
insect as a young bug. Make sure it looks different enough from the adult
so you don’t stomp on children by mistake during the experiment.

Once you're done with the icons, click on the Return to Select Level button

Now click on the Save button. If you need help saving Splatt, see you
machine-specific addendum.

Close the Biology Lab for now by clicking in the Close Box.
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THEY’RE ALIVE!

Look at the Dashboard. Notice that Splatt is now the Selected Species, =™ .~ Populate
and its icon has been added to the other icons.

Move
Now go to the Edit Window. Click and hold the Life button. Slide the Clone
cursor to Populate and release the mouse button. R
The Carrot
Now click or click and drag the cursor in the Edit Window Display Area Highlight

to set a bunch of Splatts loose in the world. P s—r
Show Genes
FOR USE AT A LATER TIME Show Uariables

Show Phenotype

This new animal we've created will not automatically appear in the Speciate

Dashboard if you start a new game at a later time. If you have saved the
animal to disk, you can load it into the game (and Dashboard) by using
the Load Species button in the Biology Lab at the Select Level.

Take a few moments to watch your creations scurry about, living and STEP IW“:
dying; then it's time to get back to work. Click on the Pause button in the 'I'H[ E ﬂ N'I' R ﬂ l

Dashboard to pause the simulation.
SPECIFS

We are now going to make our control species. It will be an exact
duplicate of Splatt except for two things: its name and its icons. We need
to give it another name so the simulation will keep its data separate from
Splatt’s, and we need it to look different so we can be sure to apply our
environmental influence only on the subject and not the control.

The Biology Lab
Doubleclick on Splatt’s icon in the Dashboard.

The Biology Lab will open, with Splatt ready to
edit.
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| Copy !

| Renarne !

Click on the Return to Select Level button to go to the Select Level of the

Biology Lab.

[ wewrmnt [ soveanpiants [ poteteaii ptante f| towcaspaes |

| e amimal || Seve ait animeis § | Detote at dwvmaia | | Lomtaza |

We now want to make a duplicate of Splatt, so click on the Copy button.

Look at the Dashboard. Notice that there is now a duplicate of Splatt
pictured just to its right. If it isn’t showing, click on the right arrow to
scroll until you see it. This is our copy. Double-click on the copy’s icon

in the Dashboard.

igiscRL [t

Copy of Splatt

Our new species is now showing in the Biology Lab. It has been named
Copy of Species, which is kind of a dumb name, so let’s rename it. Click
on the the Rename button, type in a new name (I'm using Control), and

click Make It So.

Enter a new name far the
species you are currentiy
editing in the Biology Lab.

Please limit the name to 15
characters or less.

[Contral]

L

Never Mind _

Make It So l
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A BUG OF A DIFFERENT COLOR

We need to make our control bugs look different from Splatt, so we need
new icons. You can be as creative as you want here, but I'll be lazy and
make mine identical, except for the color. My Splatts are black. I'll make
Controls red.

Be sure to change both the adult and child icons.

Once you've changed the icons, click on the Return to Select Level
button, then save the new species.

(lose the Biology Lab.

ON DASHBOARD!

One Last Detail: check the colors assigned to Splatt and Control in the
Dashboard.

Below the icons of each species is a colored rectangle. This is the color
that the animal will appear in the Map Window. (The Map Window
represents such a large area that there’s no room for icons, just colored
dots.)

I the default colors for Splatt and Control are aesthetically pleasing to
you and different enough from each other that you can easily tell them
apart, do nothing. If you want to change one or both, click and hold on
the colored rectangles to open a submenu of color choices, then slide
the cursor to the color you want.

Now it’s time to custom-build the laboratory/world for this experiment.

Open the Map Window by clicking on the Map Window button in the
Dashboard, then click on the Build World... button to open the World

Design Window.
| Build ‘w‘orld..._!

I Save I

STEP THREE:
ADVANGED
WORLD DESIGN

Tutorial
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Adjust your World Design Window to look like the sample
on the left. You can name it anything you want. I'm using
Splatter.

In general, we want our experimental world to be absolutely
non-hostile. We, as the smiters, are going to be the only
danger to life in this world.

WORLD DESIGN SUMMARY

Here’s a listing of all the settings and why I chose them.

‘ Make It So I

. We want the climate to be pleasant and forgiving, so set Regional

Weather Variation low (about 25%), and the Average Tempera-
ture and Average Moisture to average (about 50%).

We'll be customizing the terrain later, so for now, set Rivers and
Lakes and Mountains all the way down. In any event, we won't
want any mountains in this world, because mountains affect the
climate and we want our climate to be identical in all parts of the
world.

We'll want no Toxins that might interfere with our experiment;
set them to none.

Absolutely no Mutagens! We want all evolution in this experi-
ment to result from natural selection,

We'll be strategically placing Food Sources by hand, so, for now,
set them to none.

We won't need any Barriers, so set them to none.

Set World Size to Tiny. We won't need much space, and since
we'll be dealing with a number of generations, we'll want time to
pass quickly. (The smaller the world, the faster the simulation
runs.)

When you've made all the adjustments and named your world, click on
the Make It So button.
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EXTERIOR DECORATING

Our new world is pretty boring, and very barren. Now it's time to put on
some finishing touches.

We want our Splatts and Controls to have unlimited food and water, so
let's ring the world with water, and place lots of food sources around the
border. We'll also want to scatter numerous watering holes and more
food sources all over the interior.

Go to the Edit Window, click on the Water button, and draw a border of
water all the way around the world, then dot the interior of the world
with small ponds. Be careful not to put so many that it makes it hard for
the animals to move around.

Next, click on the Food Source button, and scatter food around the
border. Place a Food Source near each pond.

When you are done, the view in the Edit Window should look
something like the graphic to the right.

The view in the Map Window should look something like the
graphic below.

Water

We now have our world. It would be a shame to lose all your hard work,
so open the File Menu and select Save. See your machine-specific
addendum if you need more information on saving games.

Tutorial
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SIEP F OUR: Click on the Climate Lab button in the Dashboard to open the Climate

CLIMATE CONTROL | =

We don’t really need to mess around with the climate for this experi-
ment, but since this is a tutorial, we'll go through the motions so you'll
know how to do it when you need to.

Remember way back when we set the average
moisture and average temperature in the

The Climate Lab

=Y ¢l - o » 4 & - * | World Design Window? Here you can set the
Day Length ¥aristion ___Peak . _ ' amount that the heat and water vary around
[summer T3 = the average we already set. You can also set

the amount of variation in day length during
S| the year.

Reinfell artation _ Peok |
F‘“%'sprim =i -

&W“m%mm"lﬁﬁ wwf Set all three of the sliders around 50%—we

e Days 16 don’t want to put our little critters under too
: . much climatic stress, but we don't want to
bore them to death, either.

Each of these three settings lets you select the season at which it peaks.
Set the Temperature Variation peak to Winter by clicking and holding on
the down-arrow button, opening the submenu, sliding the cursor to
Winter and releasing the mouse button. Why would anyone want to
make it hot in the winter? Because they can.

Close the Climate Lab.
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Next, we need to mess with the Laws of Physics to compress time and
remove other influences and factors that might “taint” the experiment.

Open the Simulation Menu, then open the Technical Submenu and select
Change Physics... to open the Laws of Physics Window.

This is the stuff experimenters’ dreams
are made of. The control over time and
energy this window gives you is one of
the main incentives for experimenting
with artificial life (as opposed to non-
artificial life). Every biologistin theworld
would love to have this type of power
and control over experiments. (Sowould
every meglomaniacal lunatic, but that’s
another story.)

Basically, what we want to do here is
make life as easy as possible for our
bugs, make time pass very quickly and

STEP FIVE:
THE LAWS
OF PRYSICS

make a few other minor adjustments.

To change any of the settings, click and hold on the down-arrow buttons,
slide the cursor to your new choice, then release the mouse button.

Go ahead and adjust your Laws of Physics Window to match the picture
above, then click on Make It So. The Laws of Physics Window will close.

LET’S GET PHYSICSFUL

Here’s a summary of all the settings, with brief reasons why they suit this
experiment. A more complete explanation of what each control does can
be found in the Reference section below.

Set all the Movement Costs, Metabolism Costs and Health Costs to Tiny.
We don't want to drain our critters of any more energy than we have to.

Tutorial
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BELIFE

Since we're supplying the animals with unlimited Food Sources, the
Food Value settings don't really matter. But go ahead and set them all
to Huge, just for the principle of the thing.

We won't have any plants in this world, so you can set Plant Costs to
anything your heart desires.

In the Simulation Stuff section, set Life span to Short. We want our older
generations to pass on their genes, then nobly die, and not clutter up the
world. (Sometimes science is cruel.)

Set Day Length to 8 Ticks and Year Length to 16 Days to set time moving
at a fast clip. We'll be dealing with a number of generations in this
experiment, and don’t want to spend the next 10 years of our lives
working on this stupid tutorial.

Plant Limit doesn’t matter, since we'll have no plants. Go wild.

Set Mutation Rate to Zero. We want to see if we can reproduce evolution
through natural selection without the advantages that mutations can
give.

Set Animal Limits to 200. We don’t want to overcrowd the world.

You can set the Soil and Climate Change slider anywhere you want, as
it won't affect anything in this experiment.
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Now we'll set our Splatts and Controls loose in the world, using the SIEP Slx:

Populate Window. PﬂPUlATIUN

In order to have evolution through natural selection, without any E x P l 0 S|0N
mutations, we'll need a good spread of genes in the gene pool. To do this,
we'll set loose some Splatts and Controls, then make some modifications
to both species’ Genome Prototypes, and set some more loose.

Ifitisn't already paused, pause time now by clicking on the Pause button
in the Dashboard.

LET THERE BE SPLATT

Open the Map Window by clicking on the Map Window button in the
Dashboard. -

Click on the Populate... button in the Map Window Control Panel. I POE ilete. !

Click and hold on the down-arrow but-

tonin the Selected Species box, drag the i

- Populate
cursor to Splatt's icon, then release the I P

mouse button. what to Do: Selected Species: Where:

Add a Group lSth ﬁ

ClickonAddS 1, and OntheLand
ICKON cattered, an nthe Land. S In the Water
umber: —
E] E Iﬂ___.] Anywhere |

il

Click or click and hold on the up-arrow
button in the Number box until 40 is

displayed. ; ; l| Never Mind ” Make It So I

(Click on Make It So. 40 new Splatts will
be scattered about the world.

LET THERE BE MORE SPLATT

Double-click on the Splatt icon in the Dashboard to open the Biology

T

Lab with Splatt ready to edit. , =
L=l 2R [ £ 1o B8
|1 (o] ] ] ] ee—]—]
(on] onf on on] on] on] on] on] o on] on] on
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Click on the Edit Species Prototype Genome button.

Now make the changes to the Splatt genome as shown above to give us
a good spread of turn- and roam-related genes.

Here are the changes to make:
1. Slide the Roaming and Turning genes up to 75%.
2. Change Turn Type to Random.
3. Change Turn Angle to Medium-High.

Click on Make It So, then close the Biology Lab.

Click on the Populate... button in the Map Window Control Panel, then
populate the world with another 40 Splatts, scattered on the land.

| Populate
[ what o 0o, Gelected Species [ where:
= | (.
— e I’mm‘
Number:
k) | Cangmare |
h mmm” muhl |

TAKE CONTROL PLEASE

Now you will need to repeat the same process you just went through
with Splatts, but with the Controls.

Briefly, here's how to do it:
1. Open the Populate Window.
Set the Selected Species to Control.
Set the Number to 40.
Click Add Scattered.
Click On the Land.
Click Make It So.
Double-click on the Control icon in the Dashboard.

NS s W
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8. Click on the Edit Species Prototype Genome button.

9. Slide the Roaming and Turning genes up to 75%.

10. Change Turn Type to Random.

11. Change Turn Angle to Medium-High.
12. Click on Make It So.
13. Close the Biology Lab.
14. Click on the Populate... button in the Map Window Control Panel.
15. Click on Make It So.

You should now have 40 each of Splatts and Controls with the low
settings for turns and roaming, and 40 of each with the higher settings.

Before going on with the experiment, we need to take a time out and get
familiar with a few more SimLife features. First we’ll take a quick tour of
the many Census Windows, then we’'ll think about how to record our
data, then we'll do an in-depth personal interview with the Gene Pool
Window.

Now would be a great time to save the experiment to disk. Open the File
Menu and select Save Game. Information on saving games with your
computer can be found in the computer-specific addendum.

TIME OUT 1: TAKING THE CENSUS

We will now take a few moments to explore the Census Windows, where
you can get massive amounts of data about the life and times of your
world. These windows show the status and results of all games and
experiments.

Click on the Pause button in the Dashboard and let the simulation run for
10 or 20 seconds, then click Pause again. This will give the Census
Windows a chance to update and analyze the genes of your new
population.

BREAK TIME

Tutorial
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Diversity
Food Web
Gene Pool

Histurg
Mortality
5% Population

To open any of the Census Windows, click and hold on the Census
Window button in the Dashboard to reveal a submenu, then slide the
cursor to the window you want to open and release the mouse button.
For now, open the Graphs Window.

m
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In the upper-right corner of the window are up and down arrow buttons
that let you cycle through all the Census Windows. Go ahead and click
on one of the arrows a few times, looking briefly at each window. When
you get back to the Graphs Window, stop.

A complete description of each and every button and control of each and
every Census Window can be found in the Reference section below.

TIME OUT 2: RECORDING DATA

In this experiment and in any SimLife games or experiments, you will
probably want to track the data you find in the Census Windows. There
are a number of ways to do this.

If you spent most of your life in a laboratory, you'll probably want to
sketch copies of the Census Windows into your beloved and trusty lab
notebook. If you're not already following and recording this experiment
in the provided SimLife Lab Book (or a copy of it), you may want to start
now.

In the back of the Lab Book, we have provided a full complement of data
sheets with blank windows for you to copy, fill in and include in any
write-ups of SimLife experiments.
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lfyoudon'tlike lab books, you can write up and record your experiments
in any word processor.

[fyou have a way to take screenshots of your computer screen and print
them out and tape them into a lab book (or place the screenshot files
directly into word processor documents), you'll find it very useful. (You
may have better luck printing the data if you run SimLife in black and
white before taking screenshots.)

Note: Some versions ofSimLife, depending on the computer,
have built-in facilities for capturing windows to a clipboard
or disk. See your machine-specific addendum for details.

TIME OUT 3: THE GENE POOL WINDOW

This window is crucial to understanding the results of our experiment.
A complete explanation of this window can be found in the Reference
section below, but we'll spend a little time here covering the basics.

Open the Gene Pool Window by clicking and holding on the Census
Window button in the Dashboard, sliding the cursor to the words Gene
Pool and releasing the mouse button.

Gene Pool

Each shice represents a value for a s trait;
Lov (TN o

Use Colors? Calors are % of pop. using each of a gene's traits:

Species !0 S‘E ﬁﬂ:gg lﬂZ*ﬂ?*B
7-13% 53-69% 9796

3"““ 14-20% 70-81% 97-100%
rs.w——— e
L e m‘—
Ia.fmm m
C:jsmﬂo Size =i
e =

2]
fPopuluhon 31

“ A

This window shows the combination of all the genes in the population.
At the top-left corner of the window is the Population Box, which shows
the total population for the Local Species. The Local Species is selected

Diversity
Food Web

~bene Pool

Graphs
History
Mortality
Population
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Use Colors?

just below the Population Box. Click and hold on the down-arrow button
to see a pop-up menu of all icons for all plants and animals. (Notice that
you can also choose All Plants or All Animals and see all their genes at
once.)

To choose a Local Species, slide the cursor to the icon you want, then
release the mouse button. For now, select Splatt.

Somewhere around there is a yes/no button for using (or not) color.
Don’t worry about it for now. Worry about it later.

Be Discrete

Below the Local Species Box is the display area for Discrete Genes, the
genes that are set in the Genome Window with buttons.

There are too many of these genes to show in the window at one time,
but you can see all of these genes a few (one group) at a time. To change
the group, click and hold on the Group Select down-arrow button, slide
the cursor to the group you want, then release the mouse button.

The checkmark(s) on the left of the discrete gene bar graphs indicate the
setting(s) of the species Prototype.

Take some time and, in turn, select each group and see the results.

Be Indiscrete

The whole right side of the Gene Pool Window displays the Continuous
Genes—those that are set with sliders in the Genome Window.

This section can display the data in two ways: by using colors, or by
using black bar graphs. While a little confusing at first, once you get the
hang of the color display, it gives a lot of information quickly. Besides,
it looks cool.

But alas, for now, click on the button over on the left that sets Use Colors
to No.
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Atthe top of this part of the window is a key to help

you interpret the data. It changes depending on l:‘ e
. . Population :
your choice of color or black and white. ooty - Low 1;1;1;m;;:|m|||m;uu;;n; High
| e
Each of the rectangles (made up of small slices) | o g ey
corresponds to a gene slider in the Genome Win- _ "

' F . | li h lTurnTgpl [=d IL?fe@an (=1 :::l‘% ml i
dow. For one animal, an arrow or aline can mark the : = [ T
value for the gene. But when you need to see the [ Jroooms foesttme =3 LI
gene values for alarge number of animals, it'salittle |+ [___Jreem  rse—=5 [l T
trickier. [ Jewes [Fstation m LTI

] o [DILE H{ T
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We use little bar graphs (or color graphs). Wher- . m—,— I
ever there is a bar, at least one of the animals has s store = ([T

that value for the gene. The height of the bar (or the
shade of the color) indicates how many of the
population have that value.

Only nine continuous genes can be shown at once. You can choose
which genes to display by... ] bet you can guess how to do it. [ have faith
in you.

If you are truly daring, switch back to Use Colors (if you have a color
monitor), study the key and see if it makes sense to you.

Now it's time to go back to the experiment. Close the Gene Pool Window
by clicking in the Close Box.

Time to take our starting data. You can use a piece of paper, your own
lab book, or the official SimLife Lab Book (or a copy of it).

Open the Technical submenu in the Simulation Menu and select Set Time
to 0 so your experiment starts at Tick 0, Day 0 and Year 0. Be sure to
record the time along with your other data.

Next, open the Gene Pool Window. Select Splatt as the Local Species.
Chances are that you now have less than 80 each of Splatts and Controls
because some died during the 10 seconds that the game was unpaused

STEP SEVEN:
TAKE STARTING
DATA

Tutorial
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to let the Census Windows update. Unless you have less than 20 of each,
don’t worry about it. If you have less than 20, go to the Edit Window and
use the Populate mode of the Life Tool to add more Splatts and/or
Controls.

On paper or in the Lab Book, record the following discrete gene
information: 1. Population

2. Turn Angle

3. Turn Type

Record the same information for Control.

Now record the information for the following continuous genes:
1. Roaming
2. Turning

Record the same information for Control.

Here’s my data: Tick: 0

Day: 0
Year: 0
Splatt Control
Population: 56 Population: 59
Iw ! |'l¢v
]:lmd.w : . Tow
v med i s E:}.:tm
e [ Juooig
v [____Jrwdem v |Random
(I T oo
Jrosmine T3 [[TTTIRITTIITTIITTRI] froaming T3 [[[[[I[RILTILIII]
[roring 2 ([ IRITITTTIITI frormng =3 [[1[[[[§] i

Once the data is recorded, you're ready to start stomping bugs.
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Time to kill bugs.

BUT WHAT'S MY MOTIVATION?

The idea here is to be a predator. You like to kill and eat Splatts. You find
it easier to catch the ones that:

1. Stay still too long, or

2. Go in a straight line for a long while.

You won't smite any of the Control species because you are a predator
that wants its experiment to work.

You won't kill off so many that you deplete the population.

As you begin smiting, depending on the speed of your computer, it might
be far too easy or far too difficult to catch the Splatts. Adjust the speed
of the game in the Speed submenu of the Simulation Menu to make time
move fairly quickly and to give yourself a little challenge.

One more thing: you may want to turn off the Play Animal Sounds in the
Goodies submenu of the Simulation Menu if others are listening, but it
is helpful to have the aural feedback whenever there is a birth, death or
mating.

LET THE SMITING BEGIN

(Click on the Pause button in the Dashboard to start the clock.

Now, smite the wee bugs, and remember:

* Go for the ones that stay in one place too long, and that go in
a straight line for a while.

* Avoid smiting the Controls.

* Speed up or slow down the simulation speed as needed.

PROGRESS REPORT

When your population starts to dwindle a little, take some time off (stop
smiting, but leave the simulation running) and look through the various
Census Windows while the Splatt population builds back up.

STEP FIGHT:
SPLATT THEM
BUGS

Tutorial
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STEP NINE:
TAKING
DATA

WHAT CAN 60 WRONG AND HOW TO FIXIT

It's possible that there are so many water holes or food sources that
some creatures are trapped and can’t move, as opposed to not wanting
to move. If so, lower the amount of water holes and food sources.

[t's possible that your population could die out, or all the females or
males will kick. Go ahead and add some new ones. Ideally this shouldn't
happen, and it will set you back a little by diluting the gene pool.

If the Controls start crowding out the Splatts and using up most of the
allotted Animal Limit (remember our settings in the Laws of Physics
Window?), use the Populate Window to kill off some Controls and give
the Splatts a chance.

If you have a slow machine, the bugs may be too easy to catch and you'l
kill too many. Try increasing the simulation speed. You can also try
holding the cursor over the bug you want to smite and counting to three
slowly before pulling the trigger.

Check the Mortality Window—one of the Census Windows—for causes
of death. If many of them die from lack of food or water, add more food
and water to the world.

After at least five or six generations, pause the simulation, and take down
the Tick, Day, Year and Population as well as the same genetic informa
tion you took at Time 0.

Smite away for many more generations.

When you've done all the smiting you can stand, pause the simulation
and take a complete, final set of data for both species.
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This is perhaps the most important part of any experiment. Look over
your before, after, and in-between data. And think about it and the
following questions.

What does it mean?

Was there evolution?

Did the gene pool change?

Was it by natural selection?

Why or why not?

What went wrong?

What went right?

If you had it to do over again (and you do), would you do it differently?
What would you change?

Write a report with all the answers to all those questions and have it on
my desk by 8:00am tomorrow morning.

Depending on quite a number of factors, your Splatt experiment may or
may not have demonstrated evolution in action. Whatever happened,
don'’t be disappointed. We usually learn more when things go wrong
than when they go right.

Splatt was a very short, simple experiment, and now that you've been
dragged through it, you should have a good idea of the power and flex-
ibility of SimLife.

Happy simulating.

STEP TEN:
ANALYSIS

EXPERIMENT
SUMMARY

Tutorial
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HEALIFE

TUTORIAL
o UMMARY

Well, that’s quite enough of a tutorial if you ask me. If you made it all the
way through, be proud.

You've been introduced to alot of information in this tutorial, and it only
hinted at the possibilities of this program. Only by playing around, com-
ing up with your own ideas and testing them will you fully master SimLife.

Go. Play. Experiment. The reference section is here if and when you need
it. There's another manual section with suggested experiments. There
is also a bibliography at the end of this manual to point you to some great
books about life, artificial life, biology, evolution, genetics, and other
related subjects.
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Tdon’t need a wife, living the timeless life.
When I need a friend, I just give a wriggle.
Split right down the middle.

And when I look, there’s two of me,

Both as handsome as can be.”

— Mike Heron
from A Very Cellular Song




HELIFE

INTRODUCTION/
THE BASICS
SIMLIFE

GONVENTIONS AND
TERMINOLOGY

DOWN-ARROW (TRIANGLE) BUTTONS

Whenever you see a button with a down-arrow, or a triangle pointing
down, it means you can click and hold on this button to open a drop-
down menu of choices.

=

Clicking quickly on any down-arrow button will automatically reselect
the last selection without opening the drop-down menu.

OPTION KEY OR GONTROL KEY

The Option key, if you have one, is used for a number of shortcuts in
SimLife. If you don’t have one, use the Control key for the following
shortcuts:

In The Dashboard

Option-click on the Animal or Plant display On/Off buttons to turn the
display of all animals or plants on or off. This is handy if you want to see,
for instance, just one animal: turn them all off at once, then turn the one
you want back on.

Option-click on a color in the color submenu under any of the icons to
turn all the plants or animals to that color. Use this if you want one animal
to stand out in the crowd: turn them all to a single color, then turn the
one you want to a different color.

In The Map Window Control Panel

Option-click on the Populate... button to automatically populate the
world with a random assortment of plants and animals.

SPECIES NAMING SYSTEM

You can name species anything you want, up to 15 characters. Each
species also has a version number attached to its name. (The version
number is displayed in the Dashboard when the species is the Selected
Species.)
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As these species split into new species, the new species will become
Version 2, Version 3 and so on. The name will remain the same until and
unless you change it.

INDIVIDUAL ORGANISM NAMING SYSTEM

Individual organisms have two-part names: their species name and a
number. The numbers are given to individuals in the order they're born
and continue to increase during the duration of game. There are no “go-
backs” to reuse the numbers of organisms that die. The numbers start
at 0 (zero). The biggest number that can be used in an organism’s name
is 221 or 4,.294,967,296. If all the numbers are used, they start over again

at 0.
TERMINOLOGY
Selected Species

Within most windows, only one species will be “active” at a time. And
when playing SimLife, you usually play with one species at a time,
checking it out in one window, spreading it in another, and modifying it
in yet another.

Reselecting the species each time you jump to another window would be
ahassle, so in most windows, when you select a species, it becomes the
default or Selected Species for most other windows. The Selected Species
stays selected until you pick another one.

Local Species

Selecting a species in some windows does not make that species the
“official” Selected Species. The lucky plant or animal you choosein these
windows becomes the center of attention for these windows or parts of
windows only—they are local stars. Since we need to call them
something, these are called the Local Species.

Choosing or changing the Local Species in these windows does not
change the Selected Species or Local Species in the other windows.

Reference
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ABOUT LIFE IN
SIMLIFE

Prototype Genome

Each species in SimLife has a Prototype Genome. This is the genetic
starting point for a species: the baseline from which evolution can be
measured. Through evolution, individuals will vary from the Prototype
Genome. Over time, individuals may vary so much from the prototype
that they would no longer be able to successfully mate with it, and by
definition become another species.

LOOKS OF LIFE

As you play SimLife, the different plants and animals will visually appear
in a few different ways. None of these ways truly and accurately shows
the way these organisms look.

These electronic organisms exist as ones and zeros—energy states in
transistor switches in the memory chips of your computer. Assuming
that most of the beings that play SimLife are human, and that none of the
humans we know can see energy states in transistor switches, we figured
we'd better find some way to visually present SimLife-forms in a way that
humans can see and understand.

One way they appear is as a series of three “flash cards” as seen in the
Biology Lab and Phenotype Window. These flash card pictures were
chosen and drawn to express the organisms’ physical and behavioral
traits in familiar terms. You may not know what the organism looks like,
but by looking at combinations of familiar earth plants and animals, you
will know how it fits into its world.

Another way the organisms appear is as icons in the Edit Window. These
icons are pretty small (16 by 16 pixels) and can’t be very fancy. Their
main purpose is to help you distinguish one organism from another (and
to look pretty).

The last way the organisms appear is as small squares or dots (some-
times a single pixel) in the Map Window. When looking at this window,
you can tell that organisms are there and that they're moving (if they
are).
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PHILOSOPHY OF LIFE

For the purposes of playing with SimLife, we define life as anything that
exhibits lifelike behavior, including: adaptive behavior, self-replication
and the ability to extract order from the environment.

SimLife-forms easily meet this definition, and more. They metabolize
energy from your wall socket. They require the proper environment—
the SimLife program—to survive. They react to stimuli in the environ-
ment. They evolve.

Ina way, they are like viruses and need a host—the computer—to live
in and with.

We did our best to keep different SimLife versions as close to each other
as possible while staying true to the interface conventions of each type
of computer.

Allthe main features and functions are the same in all versions, but some
things have been moved around. The main places where differences are
found are in the Dashboard, the Edit Window Control Panel, and the
Map Window Control Panel. Check with your machine-specific adden-
dum for details.

SIMLIFE ON
DIFFERENT
COMPUTERS
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HENLIFE

MENUS

FILE MENU

Here is a listing and explanation of all menu items in SimLife. If there are
any additions, omissions or differences, they will be explained in the
addendum for your computer.

This menu has the commands for file management and quitting SimLife.
There may File Menu items for Page Setup and Printing that are not listed
here. See your machine-specific addendum for details.

ABOUT SIMLIFE...

About SimlLife... brings up vital and fascinating facts about this game. If
your computer has a special menu, like the Macintosh “Apple” menu,
this item will be there and not in the File Menu. It may also appear as
About Application....

NEW GAME

New Game opens the New Game Window allowing you to choose from
the many available game scenarios, or to begin a new world from
scratch.

OPEN GAME

Open Game lets you load and play a pre-saved game.

CLOSE

Close removes the current game from memory without quitting SimLife.

SAVE

Save is for saving the current game to disk. If the game has not been
saved before, you will be prompted for a file name.

SAVE AS...

Save As... is for saving the current game to disk. You will always be
prompted for a file name.

QuIT

Quit ends SimLife.
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The Edit Menu is primarily used in SimLife when you are designing icons
torepresent plants or animals. For more information, see the section on
the Biology Lab below.

Also see your machine-specific addendum for more information (if there
is any) on this menu.

UNDO

Undoes the last icon drawing action you made on a plant or animal icon.

COPY ICON

Copies the current icon in the Biology Lab so it can later be pasted into
another icon.

PASTE ICON

Pastes the copied icon into the current icon in the Biology Lab.

CLEAR ICON

Clears (erases) the icon currently being edited in the Biology Lab.

SHOW CLIPBOARD

On computers that have a Clipboard, displays the current contents of
the clipboard.

The Simulation Menu is for controlling various game-play options and
simulation settings. Each item in this menu opens a submenu. Submenu
items are active if they have a checkmark to their left.

SPEED

The Speed submenu lets you adjust the speed at which the simulation
runs, which affects the rate at which time passes in your ecosystem. In
the DOS and Windows versions, Speed is a full menu, not a submenu.

Pause
Pause stops time in the simulation completely.

EDIT MENU

SIMULATION MENU
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Slow
Slow sets the simulation to its slowest speed.

Medium
Medium sets the simulation speed to a nice relaxed rate of time.

" Fast

Fast sets the simulation speed to about twice as fast as Medium.

Ultra

Ultra lets the simulation run as fast as possible on your computer.

2. Maybe this will help...

DISHPAN HANDS! |
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|
|
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No more dishpan hands! With these new scales, And ['ve always wanted a PESTICIDE-FREE HOME!
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GOODIES

This submenu lets you customize some of the interface features in
SimLife.

Play Music

Play Music toggles the playing of music on and off. The amount and
quality of music available to you depends on your computer.

Play Animal Sounds

Play Animal Sounds toggles the animal sound effects on and off. The
amount and quality of sound effects available to you depends on your
computer. These sounds notify you of animal-related occurrences in
your ecosystem, including mating, birth, disease and death.

Play Other Sounds

Play Other Sounds toggles environmental and disaster-related sound
effects on and off. The amount and quality of sound effects available to
you depends on your computer.

Auto Scroll

Auto Scroll causes the terrain in the Edit Window to automatically scroll
when you are placing organisms or modifying the world near the edge
of the window, so you don’t have to constantly stop and mess with the
scroll bars.

Auto Tracking

Auto Tracking scrolls the area in Edit Window to keep the highlighted
plant or animal visible.

Display Messages
Display Messages toggles on and off the display of helpful hints and
messages during the game.
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Update All Windows

Update All Windows toggles between constantly updating all the
information in all the windows that are open and only updating the
information in the active (front) window. Updating all of the windows
will slow the simulation speed.

Populate...

Populate... opens the Populate Window.

Build World...

Build World... opens the World Design Window.

LAYERS

This submenu lets you easily turn on and off many of the layers of data
that can be displayed in the Edit and Map Windows. This only affects the
display of these layers, and in no way changes or deletes the actual data
from the simulation.

Hide All Layers

Hide All Layers turns off the display of all data layers.
Show All Layers

Show All Layers turns on the display of all data layers.
Hide All Animals

Hide All Animals turns off the display of all animals.
Show All Animals

Show All Animals turns on the display of all animals.
Hide All Plants

Hide All Plants turns off the display of all plants.
Show All Plants

Show All Plants turns on the display of all plants.
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Show Plague/STD Pink (as “P”)

Show Plague/STD Pink (as “P"), when active, turns the display of
diseased animals in the Map Window pink on color monitors, and into
the letter “P” on monochrome monitors, so you can easily track the
spread of disease through the ecosystem.

DIFFICULTY

This submenu lets you adjust anumber of factors that affect ease of play.
All these adjustments can be seen in the Laws of Physics Window.

Typical changes that affect ease of play are length of day, higher or lower
energy value for food, higher or lower energy loss for toxins and injuries,
higher or lower health costs and movement costs.

Beginner
Beginner is the easiest setting.

Novice
Novice gives you a little bit of a challenge. Barely.

Average

Average is the difficulty level that provides a good challenge without
taxing your innermost brain reserves.

Advanced

Advanced requires a lot of thinking, but not complete mastery of all the
ins and outs of the simulation.

Expert

Expert requires complete knowledge of everything to do with the
simulation and life and evolution and everything else. And a lot of luck.

Modified

Modified means you've gone into the Laws of Physics Window and
changed something so it is no longer in any of the preset difficulty levels.
To return to a preset setting, choose any one of the above choices.
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You can't choose Modified from this menu. It will be ghosted unless you
make changes in the Laws of Physics Window, in which case Modified
will be black with a checkmark beside it.

TECHNICAL

This submenu gives you access to a number of advanced simulation
manipulation functions.

Set Random Seed...

Set Random Seed... opens a dialog box or requester that lets you modify
the seed number from which random numbers are generated. Random
numbers are used in a number of places, most notably in world building.

You cannot set the seed to zero.

One use of changing the random seed is to recreate worlds without
taking up all the disk space that’s needed when saving a complete game.

Here's how to do it:
e Enter a number and write it down.

* Open the World Design Window, write down all your
settings and build a world.

¢ If you like the world you get, you can recreate it at any
time with the random seed and World Design settings.

e [fyoudon't like it, recycle the paper you wrote the seed
down on.

People who use this method of returning to particular ecosystems
receive a free membership in the Save The Seed Not The World Club.
Details on this club might be found in some cereal box, but I'm not sure.

Change Physics...

Change Physics... opens a dialog box or requester that lets you modify
the physics of the universe in the simulation, including days per year and
the energy it takes to climb, fly, walk, etc. These settings can change the
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ease of play, or let you experiment with worlds that are very different
from ours.

When you make a change in this window, the Difficulty setting is set to
Modified.

Locate An Individual...

Locate An Individual... opens a dialog box or requester that lets you
locate specific plants or animals in your ecosystem.

World Building Options...

World Building Options... opens a dialog box or requester that lets you
modify the way SimLife builds new worlds.

Record All Statistics

Record All Statistics... toggles between the simulation saving statistics
for every possible graph and saving all but the “percentage” graphs.
When you sacrifice the information in the “percentage” graphs, you gain
simulation speed and use less memory.

Set Time To 0

Set Time to 0 resets the Tick, Day and Year to zero. Use this item to reset
the clock when you are ready to begin an experiment.

Run Gontrol...

Selecting Run Control... opens a dialog box or requester that lets you tell
the simulation to pause after a certain amount of time and wait for you.

You can set it to pause after any amount of days or years, depending on
your experiment, but the most useful is 50 years. All the graphing,
history and census data is only kept in memory for 50 years: if you stop
the simulation every 50 years and save it to disk (each time under a
different name), you can get continuous data and graphs for the whole
experiment.
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Data Logging...

Data Logging..., when active, continually saves simulation data to a disk
file. When you select this item, it will open a dialog box or requester and
let you choose a name and location for this file.

The data log file is in a standard ASCII, tab-delimited format and can be
loaded into a number of spreadsheets or databases for charting, graph
ing and statistical analysis. This is an advanced feature for people who
really love to play with spreadsheets and charts and graphs. The format
for the data file can be found in your machine-specific addendum.

Warning: The data log file can get very big and will fill
your drive if you're not careful.

AutoSpeciate

When AutoSpeciate is selected, organisms that diverge so much from
their Prototype Genome that they could not successfully mate with the
prototype will automatically be reclassified as a new species.

The new species version number will be changed, but it will retain the
same icon and name until and unless you change it.

Reconverge Species

Reconverge Species recombines multiple species into a single species
If you have AutoSpeciate activated, you can end up with a large number
of very similar species. Reconverge Species cleans up the clutter
combining a number of almost identical species into one or & fe
species.

This adds genetic diversity to older, existing species, and makes more
room in the ecosystem for new species.

Here’s how it works:
1. The total population of each existing species is examined, and al
the genes are combined and averaged.
2. The species prototype is changed to match the average genotype




3. Starting with the newest species, each species prototype is com-
pared to the prototype of every other (newer) species.

4. If, when the comparison is made, the two prototypes are able to
successfully mate, the populations are combined into one spe-
cies—into the first of the species to exist.

|ONE AFTERNOON... |

Our pet Bowser sure is
BORING!

‘ | Yeah, And
UGLY, T00! l/
| / ( b

=

Hey kids, let's MAKE BOWSER
BETTER WITH THIS add-on
module for the Home Gene
Splicer-Dicer!

IS

Fangs!
|
A long taill

|
Claws!

More eyes!

\

Wings!

,‘ Those wacky kids!

'm just glad Boswer's
- HOUSEBROKEN!
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HEILIFE

WINDOWS MENU

This menu is for opening and activating the various windows in SimLife

DASHBOARD

Dashboard opens or activates the Dashboard.

VARIABLES

Variables opens or activates the Variables Window, which displays
information on the highlighted individual plant or animal.

This item can only be chosen when an organism is highlighted.

PHENOTYPE

Phenotype opens or activates the Phenotype Window, which displays
the flash card representation of the highlighted plant or animal.

This item can only be chosen when an organism is highlighted.

EVALUATION

Evaluation opens or activates the Evaluation Window.

EDIT

Edit opens or activates the Edit Window.

MAP

Map opens or activates the Map Window.

CLIMATE LAB

Climate Lab opens or activates the Climate Laboratory.

BIOLOGY LAB

Biology Lab opens or activates the Biology Laboratory.
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CENSUS

Census opens a submenu that lets you choose from the seven census
displays/graphs. Only one census window can be displayed on-screen at
atime.

Diversity
Diversity opens or activates the Diversity Window, which shows how
many different types of organisms are currently living in the world.

Food Web

Food Web opens or activates the Food Web Window, which graphically
shows the predator/prey relationships in your ecosystem.

bene Pool

Gene Pool opens or activates the Gene Pool Window, where you can see
the evidence of evolution.

braphs

Graphs opens or activates the Graphs Window, which can display, up to
four at a time, any of 720 graphs in two time scales.

History

History opens or activates the History Window, which keeps a running
record of all events in the world.

Mortality

Mortality opens or activates the Mortality Window, which displays a
chart of the reasons for plant and animal death in your ecosystem.

Population

Population opens or activates the Population Window, which shows the
relative populations of all plant or all animal species.
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DISASTERS MENU

This menu lets you activate a number of disasters that will test the
stability and resilience of your ecosystems, as well as show the dire
consequences these disasters can produce.

Disasters that are currently in progress are indicated by a checkmark to
their left. All disasters that you activate stay active until you select them
again in the menu to terminate them.

Disasters will occur randomly in games unless No AutoDisasters is
selected. Random disasters will turn themselves off after a while. As
disasters turn off, they take a few simulation cycles to finish up and go
away, so they don't cause worse problems by stopping abruptly (like
beaching fish after a flood). Random disasters and those that occur as
part of a scenario can't be turned off. They'll stop when they're good and
ready. The length of and destruction caused by disasters depends onthe
difficulty setting in the Simulation Menu.

PLAGUE

Plague releases a deadly disease into the ecosystem. Plagues are passed
from animal to animal. When an infected animal is right next to an
uninfected animal, there is a 10% chance of the plague being passed on.

31D

STD releases a sexually transmitted disease into the ecosystem. STDs
are passed when animals mate,

HEAT WAVE

Heat Wave causes the temperature all over the ecosystem to increase.

COLD WAVE

Cold Wave causes the temperature all over the ecosystem to decrease.

FLOOD

Flood causes a flood to occur.
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DROUGHT

Drought causes a drought to occur.

FIRE

Fire starts a fire in the ecosystem, but only if there are plants.

COMET

Comet causes a large, destructive comet to impact somewhere in the
ecosystem.

TELEPORT

Teleport causes many of the plants and animals to be randomly redis-
tributed around the ecosystem.

CIVILIZATION

Civilization allows an invasion of our pristine ecosystem by land
developers. Land developers are members of some strange industrial
species that bulldozes the land and builds houses. (Humans. Can't take
them anywhere.)

NO AUTO-DISASTERS

No Auto-Disasters eliminates random disasters from occurring, but
won't stop disasters that occur in scenarios, or disasters you activate
yourself. Selecting No Auto-Disasters after a disaster has begun will not
stop it or make it end sooner.
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BELIFE

WINDOWS

DASHBOARD

Macintosh Dashboard

SimLife has a lot of windows. More windows than you can shake a stick
at (or throw a stone through). You don’t have to use all of them all of the
time, so don't panic. They're all there for a reason, and will be more and
more useful as you become more familiar with SimLife. Here is an
explanation of each and every window, each and every button, slider
and feature in each window, and an explanation of what they all do and
why you'll want to do it.

The Dashboard is a row of buttons that gives you easy control over plant
and animal display, access to all the other windows and a simulation
pause button.

On the Macintosh, the Dashboard is a separate small window at the
bottom of the screen, and will be displayed on top of any other window
on the screen, with the exception of dialog boxes or requesters that wait
for an “OK,” “Never Mind,” or “Make It So” before you can do anything
else.

Selected Species

Close Box

Dos/Windows Dashboard

 Display Section |Section | Window Buttons

‘ ﬁ‘mhﬂ Mﬂg @— Pause Button

an | on] Speciate Tool E ! !

Tool Display | elp Button

On DOS and Windows computers, the Dashboard is found at the top of
the screen, and is a control bar, not a separate window. Also, on these
machines, the Edit Window Control Panel and the Map Window Control
Panel (one at a time) are displayed as part of the Dashboard. Here's how
the Dashboard looks on a DOS or Windows-based computer while
combined with the Edit Window Control Panel. For more details and for
other computers, check your machine-specific addendum.

TICK 16
£F fowr 10
YEAR 3

Animal [x] Q @Q A M

Dragon
Version 1 Populate Build World

BEEEERE
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TITLE BAR (MAC VERSION ONLY)

At the top of the Dashboard is the Title Bar. While badly named (since
it contains no title), it is still useful.

You can click and drag the Title Bar to move the Dashboard around the
screen.

On the left side of the Title Bar is the Close Button. Clicking on the Close
Button will make the Dashboard go away. You can bring it back by
selecting Dashboard in the Windows menu.

ORGANISM DISPLAY CONTROLS

Below the Title Bar and on the left are the controls for displaying (or not
displaying) different plants and animals.

The “A” and “P” buttons choose between dealing with animals and
plants respectively.

The animals or plants are displayed in a row. These are the icons that
represent the organisms in the Edit Window. Only 12 show at atime. You
canuse the left and right arrows to scroll through all possible organisms.

i you click on the picture or icon of any organism, it is highlighted and
becomes the Selected Species. The name and type (plant or animal) of
the organism appears in the center section of the Dashboard. The
Selected Species becomes the default choice for use in most windows.
For example, if you clicked on the Rose, then went to the Edit Window,
the Rose would be the default organism to use with the Populate tool.
Then, if you went to the Biology Lab, the Rose would be the default
organism to genetically modify.

lfyou double-click on any organism’s icon, the Biology Lab will open with
that organism ready for dissection.

Right below the picture of the organism is a colored rectangle. This
shows the color of the dot that the organism is represented by in the Map
Window.
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To change the color, click and hold on the rectangle to reveal a menu of
color choices, slide the pointer to the color you want, then release the
mouse button.

If you hold down the Option key (or Control key if your keyboard has no
Option key) while selecting a color for a plant, then that color will be
selected for all the plants. If you hold down the Option key (or Control
key) while selecting a color for an animal, then that color will be selected
for all the animals.

Below the color rectangles are the display On/Off buttons for each
organism. Clicking them toggles their display on and off. Turning them
off does not remove them from the simulation, just from view.

If you hold down the Option key (or Control key if your keyboard has no
Option key) while turning a plant on or off, all the plants will be turned
on or off. If you hold down the Option key (or Control key) while turning
an animal on or off, all the animals will be turned on or off.

SELECTED SPECIES SECTION

The middle of the Dashboard displays and selects the Selected Species,
which is the default organism to be used or manipulated in any of the
windows.

The display shows three pieces of information: whether the Selected
Species is a plant or an animal, the name of the Selected Species, and the
version number of the Selected Species.

The Selected Species can be selected in two ways: click on its icon in the
Organism Display Section to the left, or click and hold on the Select
button (the one with the down-arrow) to reveal a menu of all possible
organisms, then slide the pointer to the one you want and release the
mouse button.
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WINDOW BUTTONS

There are five buttons that open or activate different windows:

The Edit button opens or activates the Edit Window.
The Map button opens or activates the Map Window.
The Biology button opens or activates the Biology Lab.
The Climate button opens or activates the Climate Lab.

The Census button opens a submenu (notice the down-arrow) that lets
you open or activate any of the six Census Windows. Each of these
windows will be described in detail below.

PAUSE BUTTON

The Pause button stops time in the simulation. Click on the Pause button
again to resume at the previous speed.

If you wish an experiment to proceed at a very slow, controlled pace,
pause the simulation, then hold down the Option key (or control key)
and click on the pause button. Time will move forward in a single step
of one Tick (one simulation cycle) for each time you click.

EDIT WINDOW TOOL INDICATOR

The Dashboard also contains an indicator that tells which tool is active
in the Edit Window.

HELP BUTTON

Many windows in SimLife, especially those with many buttons, have a
Help button to give you a quick on-screen reminder of what everything
does. Click and hold on the Help button to get help.

Diversity
Food Web
Gene Pool
Graphs
History
Mortality
Population
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OTHER BUTTONS

On some computers there may be a few other buttons in or near the
dashboard, such as Populate... and Build World... which are duplicated
from the Map Window Control Panel. See your machine-specific adden-
dum for details.

ON THE FOOTBALL FIELD...
Hit the showers, Puddle.
\ - You're so0 SMALL

you look more like 2
PUDDLE to me!

Coach MUTE
ROCKNEY

The name's Foole, sir.

Y

You haven't —‘

tried THIS!
Gosh gee whiz golly, ‘

Pops, I've tried
everything!

R rr.#(/é/_&/ﬂ

He's no puddle! We'll call
him LaGOONI!




The New Game Window lets you select any of the nine scenarios, or start
anew game in Experimental Mode. It opens when you first start SimLife
and when you select New from the File Menu.

NEW GAME
WINDOW

From this window you can start
the on-screen tutorial, the sce-
narios, or Experimental Mode.

| Tutorial ! :

Meadows to Forests

The six included scenarios deal
with ecosystems and evolution.
When you click on a scenario
name, it will become highlighted
and a brief description of its goals

| The Roaches' Revenge ||

[_Bsttie of The Sexes _{

willappear in the upper-right cor-
ner of the window.

When you choose Experimental

gxﬁ'&ﬁm:@ Mode: Do whatever you want!

_Craft your own plants and animals, and let
‘them loose in & world of your own design.
| Or, pick various species from the Zoo to

1| inhabit your experiment. Will your plants

[__Predator & Prey i

11 | The Longest Chain? _{

survive? Can you establish a stable food
chain? When will disaster strike?

Craste 4 New Hap?

Mode, you are free to create your
own scenarios and experiments.

Once you have highlighted the Tutorial, Experimental Mode, or the
scenario you want to play, click on the Play Scenario button.

When you first start SimLife, you must select either a scenario or
Experimental mode. When you first load the game the Never Mind
button will not be available. If you open the New Game Window at a later
time, you will have the opportunity to leave this window without
selecting a scenario by clicking on Never Mind.

The YES/NO button lets you play any scenario in a world of your own
design instead of the default world. First, build or load that world, then
click this button to say NO, then highlight the scenario and click Play
Scenario.

Play Scenario

Mever M}'_;ﬁd_-f -
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EDIT WINDOW

The Edit Window is a close-up view of the world. Here you can modify the
terrain and the microclimate, populate the world with plants and
animals, and manipulate the environment.

It can be opened or activated by selecting Edit Window in the Windows
Menu or by clicking on the Edit Window button in the Dashboard.

Note: on some computers, the Edit Window Control Panel is
found atthe top of the screen, integrated with the Dashboard.
See your machine-specific addendum for details.

| Title Bar

Edit Window._|
Control Panel

Experimental Mode

Joystick

Scroll Bars

EDIT WINDOW TITLE BAR

The Edit Window Title Bar displays the name of the current scenario or
game. The Edit Window can be moved around the screen by clicking and
dragging the Title Bar.

Clicking on the Grow Box on the right side of the Title Bar expands the
window to fill the screen. Clicking on it again shrinks it to its previous
size. Depending on your computer, you may or may not be able to close
the Edit Window while SimLife is running.
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THE DISPLAY AREA

The biggest section of the Edit Window is the display of the world. The
world is too big to be shown in its entirety in this window at one time, so
there are Scroll Bars, Scroll Arrows and Scroll Boxes to help you navigate
to any place in the world.

Onsome computers there is ascrolling “joystick” in the lower-left corner
of the window. Clicking or clicking and holding on any of the arrows will
scroll the Display Area over the world in the direction that the arrow
points. Clicking on the blank space in the middle where there is no arrow
doesn’t do anything, but you can click there if it makes you happy.

You can resize the Edit Window by clicking and dragging the Size Box in
the lower-right corner of the window.

Things In The Display Area

In the Display Area, you will see: Land (in 16 levels of altitude), Water,

e S

Artifacts are special items you can place in the ecosystem such as @ @
barriers, Ultra-Food food sources, toxins and mutagens. mutagen bacrier
Drawing Order Artifacts

Often more than one “thing” will occupy a place at a time even though
only one can be seen at a time. Things are drawn on the screen in the
order below, from top to bottom:

I Temperature or Moisture Layers (only when turned on)

2. Animals

3. Plants

4. Artifacts

5. Water

6. Altitude
Turning off different layers in either the Edit Window Control Panel or
the Simulation Menu can help clear the clutter.
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THE EDIT WINDOW CONTROL PANEL

This control panel graphically displays the passage of time, controls
what data is shown in the Display Area, and provides all the tools you
will need to modify the land and environment.

As shown here, it is a vertical panel on the left side of the Edit Window.
On some computers it is a horizontal panel at the top of the screen,
integrated with the Dashboard.

An indicator that tells which tool is currently active in the Edit Window
can be found in the Dashboard.

| CAN'T THINK Good thing | |
OF A GOOD ordered THIS! YEAHR!! |
SCIENCE FAIR pr—==") & |
PROJECT! g o 5 ™
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Time Display
This display shows the passage of time. The sun and moon cycle
showing day and night. At the peak of each lunar circle, anicon depicting
the current season is displayed.

Below the sun and moon is a digital clock that displays the Tick, Day and
Year.

A tick is the amount of time it takes your computer to completely
calculate one simulation cycle. The actual (real-time) duration of a tick
varies with the speed of your computer.

The number of ticks per day and days per year varies with the different
scenarios, and can be customized for different experiments.

Each year is divided up into four equally lengthed seasons: summer, fall,
winter and spring.

Temperature Tool

The Temperature tool controls the display of temperature data in the
Edit Window and lets you modify the local temperature.

Totoggle the display of the temperature layer in the Edit Window on and
off, click anywhere on the button. The words “on” or “off” will appear
below the temperature icon, indicating... well, you know.

The temperature is displayed as colored or shaded squares. A color key
to help you interpret the temperature can be found in the Map Window
Control Panel when the temperature display is active in the Map
Window.

Turning off the temperature display does not affect the actual tempera-
ture in the simulation, only whether or not it is shown in the Edit
Window.

To raise or lower the temperature in a specific area of the ecosystem,
click on the up or down arrows on either side of the temperature icon,
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then click, click and hold, or click and drag in the display area. After you
have adjusted the temperature up or down, it will still vary with the
Seasons.

If you want to raise or lower the temperature in a very small area (a cell
or tile, the size of one plant or animal), hold down the Option key while
you click. If your keyboard doesn’t have an Option key, use the Control
key.

When the cursor is in the Edit Window Display Area and the temperature
tool is active, it will appear as a thermometer.

Seeing the temperature display can help you understand your
ecosystem’s climate and discover reasons why different plants or
animals thrive or die in different areas.

Adjusting the temperature directly affects the local plant life and indi-
rectly affects the animals. By raising or lowering the temperature in one
(or more) section(s) of a world, you can have two or more ecosystems
existing side-by-side for comparison experiments.

I you change the temperature slowly over a period of many years you
may be able to track the genetic changes of the local plant life as it adapts
to its changing environment,

Moisture Tool

The Moisture tool controls the display of moisture data in the Edit
Window, and lets you modify the local moisture in the air.

[n SimLife, moisture is the combination of humidity and rainfall—all the
water that stays in or passes through the atmosphere.

To toggle the display of the Moisture layer in the Edit Window on and off,
click anywhere on the button. The words “on” or “off” will appear below
the moisture icon, indicating... I'll give you two guesses.
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Moisture is displayed as colored or shaded squares. A color key to help
you interpret the moisture can be found in the Map Window Control
Panel when the moisture display is active in the Map Window.

Turning off the moisture display does not affect the simulation, only
whether or not it is shown in the Edit Window.

To raise or lower the moisture in a specific area of the ecosystem, click
on the up or down arrows, respectively, to either side of the moisture
icon, then click, click and hold, or click and drag in the display area. After
you have adjusted the moisture up or down, it will still vary with the
seasons.

If you want to raise or lower the moisture in a very small area (a cell or
tile, the size of one plant or animal), hold down the Option key while you
click. If your keyboard doesn’t have an Option key, use the Control key.

When the cursor is in the Edit Window Display Area and the moisture
tool is active, it will appear as a water drop.

Seeing the moisture display can help you understand your ecosystem’s
climate, and discover reasons why different plants or animals thrive or
die in different areas.

Adjusting the moisture directly affects the local plant life and indirectly
affects the animals. If you change the moisture slowly over a period of
many years you may be able to track the genetic changes of the local
plant life as it adapts to its changing environment.

Altitude Tool

The Altitude tool controls the display of altitude data in the Edit Window
and lets you raise or lower the land.

To toggle the display of the altitude layer in the Edit Window on and off,
clickanywhere on the button. The words “on” or “off” will appear below
the altitude icon, indicating... I'll let you figure it out.
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Populate
Smite
Move
Clone

Highlight
Show Genes
Show Dariables

Show Phenotype
Speciate

The Carrot
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The altitude is displayed as a range of colors or shades, from dark tolight
as altitude increases. A color key to help you interpret the altitude can
be found in the Map Window Control Panel when the altitude displayis
active in the Map Window.

Turning off the altitude display does not affect the simulation. only
whether or not it is shown in the Edit Window.

To raise or lower the land in a specific area of the ecosystem, click on the
up or down arrows on either side of the altitude icon, then click, click and
hold, or click and drag in the display area.

When the cursor is in the Edit Window Display Area and the altitude tool
is active, it will appear as a mountain.

Seeing the altitude display can help you understand your ecosystem's
climate, and discover reasons why different plants or animals thrive or
die in different areas.

Life Tool

The Life tool is a multi-function tool that gives you the capabilities of
displaying, placing, marking, moving, cloning, smiting and inspecting
any organism in the ecosystem.

Click on the small On/Off button below the icon to turn on and off the
display of all life in the ecosystem.

Click and hold on the Life icon to see a pop-up menu of all the capabilities
of this tool.

Click quickly on the Life icon to reselect the previous submenu choice
without opening the submenu.
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Populate
Populate lets you add plants or animals to the ecosystem.

When Populate is active, the cursor will appear as a DNA spiral. Clicking
or clicking and dragging will place the Selected Species into the ecosys-
tem. To change the Selected Species, see the section on the Dashboard
above.

There are places where you cannot place a new organism. You can't
place a plant on a plant, or an animal on an animal. Sometimes when you
place an organism, you cannot see it any more. That’s usually because
there is something else in that spot that has drawing priority, ie.,
animals are drawn over plants, etc. A complete explanation of drawing
order is given in the Edit Window Display Area section above.

Smite

Smite lets you remove individual plants or animals from the world.
When Smite is active, the cursor becomes a lightning bolt. Click on any
life-form to end its miserable existence (or enjoyable existence, if you
want to feel guilty).

To remove an entire species, see the Populate Window below.

Move

Move lets you drag an individual plant or animal to another location.
When Move is active, the cursor becomes a hand. Click and drag to move
any organism to another place.

When moving an organism, you can't place a plant on a plant or an animal
on an animal. If you place an organism and cannot see it any more, it's
because something else in that spot has drawing priority, i.e., animals
are drawn over plants, etc.

Clone

Clone lets you make a copy of an existing plant or animal. When Clone
is active, the cursor becomes a double set of DNA spirals. Click and hold
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on any organism, then drag the cursor to a new location and release the
mouse button.

If you hold down the Option key (or Control key on computers with no
Option key) while cloning, the clone will mutate. For more information
on mutations, see the section on Mutation below.

When cloning an organism, you cannot place a plant on a plant or an
animal on an animal. If you place an organism and can't see it any more,
it's because something else in that spot has drawing priority, i.e.
animals are drawn over plants, etc.

The Carrot (Recruit)

The Carrot is for calling individual animals. When the Carrot is active,
& the cursor will appear as a carrot. While the Carrot is active, and you
clickand hold (for awhile) in the display area, the animals of the Selected
Species (the one listed in the middle section of the Dashboard) will try
to go to where you click.

To change the Selected Species, see the section on the Dashboard
above.

If you hold down the Option key (or Control key if your keyboard has no
Option key) and click, only the highlighted animal will be called to your
click.

This tool is useful for separating individuals or groups so it is easier to
move, clone, relocate or otherwise play with them.

Highlight

s Highlight lets you mark a plant or animal. When Highlight is active, the
cursor becomes a highlighted box. Click on any organism to highlight it.

When you highlight an organism, it becomes the Selected Species. When
Auto Tracking is active in the Goodies submenu of the Simulation Menu,
the screen will scroll so the highlighted organism stays in view.
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Show Genes

Show Genes allows you to inspect the genes of any individual plant or
animal. When Show Genes is active, the cursor will appear as a DNA
spiral and pencil. Click on any organism to bring up the Genome
Window.

This is the one place in SimLife when you can inspect and modify the
genes of one individual organism instead of the species prototype.

The Genome Window is explained in detail below.

Show Variables

Show Variables allows you to inspect the simulation variables of any
individual plant or animal. These variables are the non-genetic informa-
tion that is different for each organism and that changes throughout its
life, including health, age, height, weight, etc.

When Show Variables is active, the cursor will appear as a slider control.
Click on any organism to bring up the Variables Window. The Variables
Window is explained in detail below.

Show Phenotype

Show Phenotype brings up a small window displaying the “flash card”
image of any plant or animal. When Show Phenotype is active, the cursor
will appear as an eye. Click on any organism to see its flash card picture.

The Phenotype Window is explained in detail below.

Speciate

Speciate lets you grab an individual organism from one species and
change it into another species in a number of ways.

When Speciate is active, the cursor will appear as a sort of triangle of
three boxes, representing “two descended from one.” Click on any
organism to open the Speciate Window. The Speciate Window is ex-
plained in detail below.
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Water Tool

The Water tool toggles on and off the display of water in the Edit
Window, and lets you add or remove water from the ecosystem.

Click on the small On/Off button below the icon to turn on and off the
display of all water in the ecosystem.

When the Water tool is active, the cursor says H,0. Click or click and drag
the cursor on land to turn it into water. Click or click and drag on water
to turn it into land.

Use this tool to customize landforms, enlarge or remove lakes and
isolate groups of land animals. You can also make islands and moats, and
spell your name in a river.

Food Tool

The Food tool lets you place or remove Ultra-Food food sources any-
where you want. This food will feed any animal an unlimited supply of
whatever it needs to survive. This is especially useful in newer ecosys-
tems that haven’t had time for plants to spread, or when the food chain
has been broken.

When the Food tool is active, the cursor becomes a shopping cart.

Ultra-Food food sources last forever and provide an unlimited amount
of food to all animals that approach them.

Barrier Tool

The Barrier tool lets you put down impenetrable barriers in the ecosys-
tem that only flying organisms can cross.

When the Barrier tool is active, the cursor becomes a pile of rocks. Click
anywhere on land or water to place a barrier.

Barriers are useful for dividing populations into isolated groups. You
can then expose each group to different environmental pressures and
track the divergent evolution in the different groups.
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Since flying organisms can cross barriers, to isolate them you'll have to
use the altitude tool and make very high mountains.

The Toxin tool lets you place a deadly poison into the ecosystem. This
poison will decrease an organism'’s health when it is directly adjacent to

it.

When the Toxin toolis active, the cursor becomes a skull and crossbones.
Click or click and drag in the Edit Window to place toxins.

'SIBLING RIVALRY | won | won | won
' | won | WON!I

She thinks she's
50 smart...

Toxin Tool

REGRESSION
Modulell |

l Here's a special dish of
| termites just for MY
LITTLE MONKEY!
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[f you place a toxin on top of a creature, the creature will be drawn on top
of the toxin. You may want to temporarily turn off the life layer when
placing toxins.

Mutagen Tool

The Mutagen tool allows you to place material in the ecosystem that wil
raise the odds of mutations occurring in nearby plants and animals.

When the Mutagen tool is active, the cursor becomes the radiation
symbol. Click or click and drag in the Edit Window to place mutagens.

If you place a mutagen on top of a creature, the creature will be drawn
on top of the mutagen. You may want to temporarily turn off the life layer
when placing mutagens.

A detailed description of Mutation is found below in the Reference
section.

Help

Click and hold on the Help button to see an on-screen reminder of what
each button in the Edit Window Control Panel does.

The Joystick

This is a simulated joystick to scroll the area that is displayed in the Edit
Window. Clicking or clicking and holding on any of the arrows will scroll
the Display Area over the world in the direction the arrow points.
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The Map Window is a satellite view of the entire world. It is where you M AP W IND 0W
get an overview of the status of your ecosystem, garner information on
the environment and soil quality, and check the location of various
objects and organisms. It is also the launching site for mass-populating
the ecosystem and building new worlds.

The Map Window can be opened or activated by selecting Map in the
Windows Menu or by clicking on the Map icon on the Dashboard.

|Title Bar
Close Box Map of the World
Edit
Rectangle
— Display
Area
Map
Window
Control : .
o e : T — e [
et [ T Y[ I 0 I T e
. uttons

| Single Level Data
Help Button ~ Buttons

| Multi-Level Color Key

Data Buttons

Note: on some computers, the Map Window Control
Panel is found at the top of the screen, integrated with the
Dashboard. See your machine-specific addendum for
details.
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MAP WINDOW TITLE BAR

The Map Window Title Bar displays the scenario name, or the world
name if you build one of your own.

The Map Window can be moved around the screen by clicking and
dragging the Title Bar. Clicking on the Close Box on the left side of the
Title Bar makes the Map Window go away.

DISPLAY AREA

The Map Window Display Area is the actual map of your world. Because
of the scale of the map, objects, items and organisms in it are tiny and
are represented by colored or shaded dots or areas.

Many of the objects can be recognized by the color keys or indicators in
the Map Window Control Panel. Organisms can be identified by their
color as shown on the Dashboard.

Edit Rectangle

Somewhere in the Map Window Display Area is the Edit Rectangle. This
rectangle circumscribes the area of the map that is currently visible in
the Edit Window.

Clicking anywhere on the map will cause the Edit Rectangle to center
itself around the cursor. You can also click and drag the Edit Rectangle.
When the Edit Rectangle is moved, the Edit Window will change to
display the new area in the rectangle.

Double<clicking in the Edit Rectangle brings the Edit Window to the front.

THE MAP WINDOW CONTROL PANEL

The Map Window Control Panel is filled with buttons that control what
is viewed in the map. The display controls do not affect the world or the
simulation in any way, just what you see at a particular time.

There are two different types of display controls: multi-level displays—
only one (or none) of which can be displayed at a time, and single level
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displays—any or all of which can be displayed at a time. When appli-
cable, acolor key will appear near the middle of the Map Window Control
Panel to help you interpret the multi-level data.

There are also two buttons that open the related Populate and World
Design Windows.

Soil Depth

Soil Depth shows the depth, and therefore (in SimLife at least), the
quality of the soil. It is a multi-level display, and cannot be displayed at
the same time as any other multi-level display.

A color/shade key to help you interpret soil depth will appear near the
middle of the Map Window Control Panel.

The deeper the soil, the better the conditions and the more nutrients
there are for plants. New worlds will have shallow soil, but as plants grow
and die, they increase the depth. There will always be at least some good
soil in new worlds, especially near water sources.

Soil will erode if there are no plants on it.

Filter Feeder Food

Filter Feeder Food shows the amount of food available for the filter-
feeding animals such as crustaceans and whales in the ocean, and
spiders, insect-eating birds and anteaters on the land. It is a multi-level
display, and cannot be displayed at the same time as any other multi-
level display.

Filter food consists of plants and animals in the ocean, the soil and the
air that range from microscopic size to the size of large insects. Filter
food is at the bottom of the food chain.

Filter food concentrates in shallow water and on shorelines, where it can
get nutrients from the nearby soil yet still receive sunlight. Since it
requires sunlight, the amount of filter feeder food will vary with the
seasons.
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A color/shade key to help you interpret the available filter feeder food
will appear near the middle of the Map Window Control Panel.

Temperature

Temperature shows the air temperature in the world. It is a multi-level
display, and cannot be displayed at the same time as any other multi-
level display.

A color/shade key to help you interpret the temperature will appear
near the middle of the Map Window Control Panel.

Temperature changes with the seasons and directly affects plants and
indirectly affects animals.

Moisture

Moisture shows the amount of moisture in the world. It is a multi-level
display, and cannot be displayed at the same time as any other multi-
level display.

A color/shade key to help you interpret humidity will appear near the
middle of the Map Window Control Panel.

Moisture includes both humidity in the air and precipitation, and
changes with the seasons. The presence of plants increases moisture. As
moisture increases, plant-growing conditions improve so more plants
can grow. This in turn attracts and feeds more animals and increases soil
depth.

Altitude

Altitude shows the height of the land in the world. It is a multievel
display, and cannot be displayed at the same time as any other multi-
level display.

A color/shade key to help you interpret altitude will appear near the
middle of the Map Window Control Panel.
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The altitude of a new world affects the climate. (See The World Building
Process in Miscellaneous Simstuff at the end of this section for more
info.) Also, only animals with climbing capability can move up or down
steep slopes.

Life
Life toggles on and off the display of plants and animals on the map. This

is a single-level display, and can be viewed along with one of the multi-
level displays and any or all of the other single-level displays.

See the Dashboard to find out what colors represent which organisms.

Water

Water toggles on and off the display of all water on the map. This is a
single-level display, and can be viewed along with one of the multi-level
displays and any or all of the other single-level displays.

Barriers
Barriers toggles on and off the display of any barriers on the map. This
is a single-level display, and can be viewed along with one of the multi-
level displays and any or all of the other single-level displays.

Toxins
Toxins toggles on and off the display of any toxin deposits on the map.
This is a single-level display, and can be viewed along with one of the
multi-level displays and any or all of the other single-level displays.

Mutagens
Mutagens toggles on and off the display of mutation-causing agents on
the map. This is a single-level display, and can be viewed along with one
ofthe multi-level displays and any or all of the other single-level displays.

Food Sources
Food Sources toggles on and off the display of any Ultra-Food food
sources on the map. This is a single-level display, and can be viewed
along with one of the multi-level displays and any or all of the other
single-level displays.

-
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Trails

Trails toggles on and off the display of the trails that animals follow on
the map, so their foraging movements can be observed. This is a single-
level display, and can be viewed along with one of the multi-level
displays and any or all of the other single-level displays.

Trails, like all other data layers, exist even when their display is turned
off. Trails are used by animals to find or avoid each other for eating or
mating, or because of genetic attraction or avoidance.

Animals can sense and follow other animals’ trails. This is the SimLife
equivalent to vision and is controlled by the vision gene.

Help

Click and hold on the Help button to see an on-screen reminder of what
each button in the Map Window Control Panel does.

Populate Button

Populate... opens the Populate Window so you can add plants or animals
to the world. A complete explanation of the Populate Window can be
found below.

You can hold down the Option key (or the Control Key if your keyboard
has no Option key) while clicking on the Populate button to randomly
populate the world with plants and animals.

Build World Button

Build World... opens the World Design Window so you can create a new
world. A complete explanation of the World Design Window can be
found below.

122




The Populate Window lets you add or delete plants and animals to or P DP U lAT[

from the world in large numbers, as opposed to the Edit Window, where
you can only add or remove one organism at a time.

WINDOW

The Populate Window can be reached through the =
Populate button in the Map Window Control Panel, -

| Populate

and through the Goodies submenu in the Simula- Selected Species, Where:
tion Menu, == e |
The basic process of populating the world is to first || %m Eﬁ_? | | .
select a species (or group of species), and picka || y e g _
number of organisms to be added or deleted. Next, _ Ij Never rind { [ rake it 5o |

choose whether to add the species (either as a

group or scattered all over the world) or delete the species. Then decide
whether the organisms should be put on the land or in the water or both.
And last, instruct the computer to “Make It So.”

Selected Species

The Selected Species is the type of plant or animal you want to add or
remove. It will default to the Selected Species in the Dashboard.

To change the Selected Species, click and hold on the arrow button to
open a submenu of all available plants and animals, then slide the cursor
tothe one you want. In addition to individual species, you can also select
either All Plants or All Animals.

When you change the Selected Species in the Populate Window, it will
also change in the Dashboard.

Number
This is the number of organisms to be added or deleted. If you have
chosen All Plants or All Animals as the Selected Species, then this
number of each species will be added.

To adjust the number, click or click and hold on the up or down arrows,
or highlight the number and type in a new one.
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Add A Group

Click on this button if you want the Selected Species to be added to the
world in a group.

Add Scattered

Click on this button if you want the Selected Species to be spread all over
the world when it is added.

Kill Off

Click on this button if you want the Selected Species to be removed from
the world.

On The Land

Click on this button if you want the Selected Species to be placed on dry
land when it is added to the world.

In The Water

Click on this button if you want the Selected Species to be placed in the
water when it is added to the world.

Anywhere

Click on this button if you want the Selected Species to be placed
randomly on both land and water when it is added to the world.

Never Mind

Click on this button if you wish to leave the Populate Window without
adding or deleting any organisms.

Make It So

Click on this button when you are happy with all the settings above. The
Selected Species will be added or deleted and the Populate Window will
close.

Help

Click and hold on the Help button to see on-screen help for this window.
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The World Design Window lets you create new worlds to suit your whims
or the needs of your experiments. It can be reached through the Build
World button in the Map Window Control Panel, and through the

: §

WORLD I]ESIGN
WINDOW

Goodies submenu in the Simulation Menu.

The basic process of world design is to first
choose settings for climate, rivers and moun-
tains, then decide which and how many artifacts
you want in the world, then pick a size for the
world, name it and “Make It So.”

Most of the settings involve slider controls. To
adjust them, click and drag the arrows.

There are four possible world sizes. When choos-
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et
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Cold
Many
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ing world sizes, keep in mind the speed of your

New World Name:
computer (larger worlds run slower), the amount bbb i

Never Mind

[Wm-m of Fun

-

of RAM you have (larger worlds take more

Make It So

memory), and the particular experiment you are
designing. Larger world sizes are not available on some computers while
in black and white mode.

Regional Weather Variation

This adjustment controls the variations in temperature and moisture in
your ecosystem’s climate. When set to high, the seasonal changes in
both temperature and moisture will be high. When set to low, the
ecosystem will have very little difference between seasons.

World Average Temperature

This adjustment sets the average, or center point around which the
seasonal temperature variations vary.

World Average Moisture

This adjustment sets the average, or center point around which the
seasonal moisture variations vary.

Reference

125



BELIFE

Rivers And Lakes

This adjustment sets the amount of the ecosystem that is covered by
water. It ranges from none to many, which will cover the entire world
except for the highest mountain peaks. If you set Rivers and Lakes to
many and Mountains to none in the adjustment below, you can create an
ocean-only ecosystem.

Mountains

This adjustment sets the amount of mountains that will be generated in
the ecosystem.

Toxins

This adjustment sets the amount of toxins that will appear scattered
around the new world when it is generated. These can be set from none
to many.

Mutagens

This adjustment sets the amount of mutagens that will appear scattered
around the new world when it is generated. These can be set from none
to many.

Food Sources

This adjustment sets the amount of Ultra-Food Food Sources that will
appear scattered around the new world when it is generated. These can
be set from none to many.

Barriers

This adjustment sets the amount of Barriers that will appear scattered
around the new world when it is generated. These can be set from none
to many.

New World Name

This is where you enter the name for the new world.
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Tiny

Click on this button to generate a tiny world, which will be 32 x 64 tiles.

Small

Click on this button to generate a small world, which will be 64 x 128 tiles.

Medium

Click on this button to generate a medium-sized world, which will be 128
x 256 tiles.

Large
Click on this button to generate a large world, which will be 256 x 512
tiles.

Never Mind

Click here if you want to exit the World Design Window without building
anew world.

Make It So

Click here when you are satisfied with all the settings and want to exit
this window and proceed with building a new world.

Help

Click and hold on the Help button to see on-screen help for this window.
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BI“I_“GY I_AB The Biology Lab is a multi-level window for inspecting and modifying
existing plant and animal species, and designing and creating new ones.
It can be reached either through the Biology Lab item in the Windows
Menu or through the Biology Lab icon in the Dashboard. You can also
open the Biology Lab directly to the second (edit) level by double-
clicking on an organism'’s icon in the Dashboard.

The Biology Lab can be moved around the screen by clicking and
dragging the Title Bar. It will go away if you click in the Close Box.

Biology Lab at Select Level

lTit]e Bar
Close Box — (N T T S
&
Species o :
Selector e 2o e || _co | SIS TATSL IS
oetete [ _seve | [RPELI NN
rolind adiy DAL — Plant and
w33 X Animal Icon
;:'; CACATAD Menu
Cool _.-_J:J
Picture — Ll

Save All Plapts Delete 411 Plants Load A Species
Mew Animal Save All Aninjals Delete A1l Animals Load A Zoo L

Lots of Buttons

The first level of the Biology Lab is for selecting an organism to work
with. The second level is for editing, where you modify the organism
and/or its icon. From the second level you can open the Genome Window
and inspect or manipulate the organism’s genetic code.
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PROTOTYPES AND INDIVIDUALS

Inthe Biology Lab, you can only edit the Prototype (the genetic starting
point) of a species.

To edit the genes of an individual organism, you will have to select the
individual in the Edit Window with the Show Genes function of the Life
Tool and do the editing in the Genome Window.

SELECT LEVEL

Here you select an existing species to edit, copy, delete or save. You can
also create a new plant or animal species, or load in previously saved
species, individually or in groups (zoos). Once you have gone from here
to the Edit Level and modified a species, return here to save your
changes.

Selected Species

This is the species that is ready for editing, copying, etc. Icons of all
possible species are displayed on the right side of the window. To select
anew Selected Species, click its icon. Changing the Selected Species
here changes it in all windows.

Edit
Click here to move to the Edit level of the Biology Lab so you can inspect
or modify the Selected Species.

Gopy

(lick here to make a copy of the Selected Species that you can then edit
and save.

Delete

Click here to remove the Selected Species from the current world.
Deleting a species will not remove it from the disk or prevent you from
using it in another world.

Save
Click here to save your edited species to disk for later use.
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Warning: If you edit any of the plants and animals that
come with SimLife, you should save them under different
narmes or in different folders or directories than the
originals so you can go back to the originals at a later
time. Whatever you do, don't save over the original
plants and animals on the original disks. Protect your
Zoo!

New Plant

Click here to go to the Edit Level of the Biology Lab to create a new plant.

New Animal

Click here to go to the Edit Level of the Biology Lab to create a new
animal.

Save All Plants

Click here to save all the currently defined plants to disk in a single file.
These plants can all be loaded in at once by using the Load A Zoo button.

Save All Animals

Click here to save all currently defined animal species to disk in a single
file. These animals can all be loaded in at once by using the Load A Zoo
button.

Delete All Plants

Click here to remove all plants from the world. This only removes them
from the current world in the current experiment or scenario; it does not
remove them from the disk or prevent them from being used in other
worlds or scenarios.

Delete All Animals

Click here to remove all animals from the world. This only removes them
from the current world in the current experiment or scenario; it does not
remove them from the disk or prevent them from being used in other
worlds or scenarios.
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Load A Species

Click here to open a dialog box or requester to load in a previously saved
plant or animal.

Load A Zoo

Click here to open a dialog box or requester to load in a previously saved
Zoofile. AZoo is a group of plants or animals saved together by using the
Save All Plants or Save All Animals buttons.

EDIT LEVEL

The Edit Level of the Biology Lab lets you easily modify or design
organisms, as well as draw or change icons for the organisms and make
a few basic genetic manipulations.

When you edit at the Edit Level, you can never edit one individual
member of a species. You can only edit the prototype of the species.

You can get to the Edit Level from the Select Level by selecting a species
from the icons and then clicking the Edit button, by double-clicking on
aSelect Level plant or animal icon, or by clicking either the New Plant or
New Animal buttons.

You can also edit a species by double-clicking on the species’ icon on
the Dashboard. Whenever you start a new plant or animal, you will be
editing the entire species.
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The Biology Lab

The Edit Level of the Biology Lab is slightly different for animals and
plants.

i Gens Pool
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Edit Level for Animal Edit Level for Plant

Name
This is a display of the name of the Selected Species.

Rename

Click here to open a dialog box or requester that allows you to rename
the current species.

Flash Cards

The flash cards give you a simple way to modify or design an organism.

These flash card pictures are not actually representative of how the
organism looks. SimLife organisms are electronic and look like a matrix
of ones and zeros manifested as energy levels in transistor switches in
the memory of your computer. Since we humans can’t see energy levels
in transistors, we've put these flash cards into SimLife as a pictorial
analogy: a way to think of these organisms in familiar terms, to relate
them to combinations of plants and animals we are familiar with.

The pictures on the flash cards were chosen and drawn to help you
understand how the animal fits into the environment. Looking at these
pictures, it is fairly easy to figure out the organism'’s food, brain size,
method of movement, etc.
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Each SimLife organism is represented by a combination of three pic-
tures. Each of the pictures represents at least two genetic factors. To
change the pictures, click on the up or down arrows above or to the left
of the pictures.

As you “flip” through the flash cards, a text description of the organism
will appear below the pictures.

Designing organisms through the flash cards is somewhat limited. These
creatures will only have one food source, one type of seed, one method
of motion, etc. To add abilities to your creature, you can enter the
Genome Window and fine-tune its genetic code.

Note: You can flip through the flash cards all you want
without messing up your organism. The changes you
make to the flash cards don't actually affect the organism
until you click on the Change Prototype Genome to Match
Picture button, as explained below.

The flash cards for plants are arranged vertically.

The top card has eight possible pictures, which represent two factors:
the presence or absence of nectar and the four seed types (sticky,
dropping, drifting or fruit).

The middle card has 18 possible pictures, which represent three factors:
deciduous or evergreen, evaporation rate (dry, normal or humid) and
structure (grass, tree or shrub).

The bottom card has eight possible pictures, which represent three
factors, all of which deal with the plant’s germination: floating or non-
floating seeds, sprouting temperature (high or low) and sprouting
moisture (high or low).

Land Plant, sprouts in cold dry weather
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The flash cards for animals are arranged horizontally.

The left card, the front of the animal, has 18 possible pictures, which
represent two factors: the food source (nectar, plants, animals, fruit,
filter or seeds) and the intelligence (large, medium or small).

The middle card has 20 possible pictures, which represent two factors:
method of movement (walk, climb, swim or fly) and preferred environ-
ment (ocean, jungle, plains, mountain or desert).

The right card, the rear of the animal, has six possible pictures, which
represent two factors: gestation size and time (small, medium or large)
and litter size (1-2 or 4-8).

Gene Pool Diversity

This slider sets the genetic spread—the amount of variance in the
genes—of a species when you add it to the world through the Populate
Window or with the Populate function of the Life Tool in the Edit
Window. From then on, genetic diversity is in the hands of natural
selection and the species’ genetic algorithm.

Mating Difference

This slider control sets the limits on how different the genetic code of
two individuals of two species can be, while still allowing them to mate.

% Genes From Father

This slider controls the amount of genes the offspring receives from the
father. The rest of the genes come from the mother. This slider has no
effect in asexual species.

Icon Section

Here you can change or edit the icons that represent the existing creatures,
and choose or create new icons for new creatures.

There are differences in the icon section for plants and animals.
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Plant Icons

Each plant needs four icons that represent the four stages of plant life:
seed, with flowers, with leaves (but no flowers) and with no leaves. You
can either choose from the included icons or draw your own. You can
also choose icons, then edit them yourself.

Actual Size Icons

Buttons —— seeds no leaves
@ flowers leaves
Color Palette —— Drawing
Area

To choose a set of plant icons, click and hold on the Icons button to open
asubmenu of 32 predrawn plants, then slide the cursor to the one you
want and release the mouse button.

The submenu only shows one of the icons—leaves, no flowers—but all
four icons are there.

The icon drawing process is simple:

* Choose the icon you want to draw or change, then click
on it.

* Click on the color in the palette you want to draw with.

* Click or click and drag in the drawing area.

lf you make a mistake, you can undo your last drawing action by clicking
on the Undo button, or selecting Undo in the Edit Menu.
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Since different stages of the plant’s life may look very similar, you can:
* Draw one stage.
¢ Select the Copy Icon item in the Edit Menu.
¢ (Click on another icon.
* Select the Paste Icon item in the Edit Menu.

¢ Make any changes as necessary.

There is also a Clear button. Use this to completely clear an icon if you
want to start over.

Animal Icons

There are four icons for each animal, but only two that you can draw or
change. There are two stages of life represented by animal icons: child
and adult. Since animals move, you'll need two child and two adult icons
facing in different directions.

Actual Size Icons

Buttons —

E adult
o] ching

Drawing
Area

Color Palette

You can either choose from the included icons or draw your own. You
can also choose icons, then edit them yourself.
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To choose a set of animal icons, click and hold on the Icons button to
openasubmenu of 64 predrawn animals, then slide the cursor to the one
you want and release the mouse button.

The submenu only shows the adult icons in one direction, but all four
icons are there.

The icon drawing process for animals is even simpler than for plants:
you don’t have to draw the “flipped” icons—they are automatically
generated for you.

* Choose either the left adult or the left child icon and click
on it.

* (Click on the color in the pallette you want to draw with.

* Click or click and drag in the drawing area.

Ifyou make a mistake, you can undo your last drawing action by clicking
on the Undo button, or by selecting Undo in the Edit Menu.

Since the two stages of the animal’s life may look very similar, you can:
* Draw one stage.
* Select the Copy Icon item in the Edit Menu.
* (lick on another icon.
* Select the Paste Icon item in the Edit Menu.

* Make any changes as necessary.

here is also a Clear button. Use this to completely clear an icon if you
/ant to start over.
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Biology Lab Buttons

At the lower-left corner of the Biology Lab are seven buttons. Many of
these buttons are very powerful and can drastically alter the gene pool
of an entire species, so a warning message will appear to give youa
chance to back out.

Return to Select Level

Click here to return to the Select Level so you can save the current
species and/or edit another.

Change Picture to Match Prototype Genome

Click here to update the picture to match any changes you have made
to the species prototype in the Genome Window.

Change Prototype Genome to Match Picture

Click here to change the genetic code for the prototype species to match
the flash card picture. You can flip through the flash cards all you want,
and it won't affect the genetic code until you click on this button.

Edit Species Genome
Click this button to open the Genome Window for the Selected Species.

Make Population Match Prototype Genome

Click here to update the genetic code of the entire population of the
Selected Species to match the genetic code of the currently selected
species’ Prototype.

This is a deceptively powerful button that goes way beyond the capabil
ties of today’s biological science. In the world we live in, you can make
changes to an organism's genetic code, but the changes won't be
noticeable until a future generation—the organism won't re-form itsel
to match the new code.
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This tool in SimLife not only changes the genetic code of a whole
population of organisms, it instantly updates the population physically,
mentally or whateverly to match its new genetic code. If you add the
ability to fly to the Prototype and push this button, the whole population
of this species will instantly grow wings.

Make Prototype Genome Match Population

Click here to change the Prototype of the organism being edited to
match the current population of that species.

Help

Click and hold on the Help button to see an on-screen reminder of what
each button in the Biology Lab does.

Click on any of the control names for help messages—{jim

Return to Select Level
Change Picture to Match Species Prototype Genome

Change Species Prototype Genome to Match
Ficture (Click this button if you want the
current picture to define thiz species)

Edit Species Prototype Genome
Make Species Population
Match Prototype Genome

Make Prototype Genome
Match iapecies Fopulation

Reference 130



HELIFE

GENOME
WINDOWS

There are actually two Genome Windows: one for animals and one for
plants. These windows display the entire genetic code for any species or
individual organism and allow you to change, modify, manipulate or
redesign the organisms at the genetic level.

The Genome Windows can be opened from the Biology Lab by clicking
on the Edit Species Genome button or from the Edit Window by using the
Life Tool in Show Genes mode and clicking on an organism.

When you enter the Genome Window through the Biology Lab you will
be looking at the prototype genome for the whole species. When you
enter from the Edit Window you will be looking at the genome for the
individual organism that you clicked on.

The Genome Windows both consist of a number of slider controls, on/
off switches and drop-down menu choices. Designing or moditying
organisms at the genetic level is actually a lot easier than it looks—once
you understand what each of the genes does.

Perhaps the most important thing to keep in mind when designing an
organism s this: There is no free lunch. Even in SimLife. The price you pay
is in energy consumption. If you create an animal that can climb and
swim and fly, and it’s large and fast and strong and has sharp vision and
powerful weapons, it will require so much energy to survive that it prob-
ably couldn’t eat enough fast enough to stay alive even if it lived in a
supermarket. As you design or modify an organism, keep an eye on the
Energy Requirement Bar near the lower-right corner of the window. (It
will be explained in detail below.)

The genome only contains the potentials for the animal. There are a
number of factors or variables for each individual animal that change
with time. These variables include current health, weight, age, current
food and water storage, etc., and can be found in the Variables Window
as described below.
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HELP

At any time in this window you can click and hold on the name of any
gene or group of genes for a pop-up explanation of what the gene does.

THE ANIMAL GENOME

Food Sources | Species Genome for Orgot u
[ o f Nectar Gl
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| NofSeeds  Features Water
Size Max
Share Food Stealth Action

Roaming
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Turn Type Turn Angle Size Action
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Title Section

This part of the Genome Window displays the name of the species or
individual organism currently being edited. If it is an individual organ-
ism, it will have a number as part of its name.

| Species Genome for Orgot r Genome for Orgot 236

Gender
There are four possible settings for Gender: Female, Male, Asexual and
Sterile. Click and hold the down-arrow button to reveal the Gender
submenu, then slide the cursor to the gender (or lack thereof) of your
choice.

Movement

There are four ways animals can move. They can walk, climb, swim or fly.
The different methods of movement require differing amounts of energy:
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swimming takes the least, flying takes the most and walking and climbing
are somewhere in the middle. Of course, you can go to the Laws of
Physics Window (see below) and change the energy it takes to do these
things.

Clicking on the button to the left of each method of movement toggles
it on and off for the animal being edited. Animals can be made capable
of more than one type of movement, but the more skills and abilities an
animal has, the more energy it requires.

If all types of movement are turned off, the animal will just sit in one
place—like an anemone.

Send me the SPECIATION
/' MODULE for my HOME GENE
_~~\SPLICER-DICER! And throw in |
' ) . abanana pizza.

)

Let’s see... boiling in oil...
thumb screws... bamboo
strips under the
fingernails... tell the
coach about his bed-
wetting... 'VE GOT IT!
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Food Sources

Inaddition to Ultra-Food, there are six food sources that animals can eat:
nectar, plants, animals, fruit, filter food (plankton and near-microscopic
plants and animals in the sea, soil and air) and seeds.

Clicking on the button to the left of each food source toggles it on and off
for the animal being edited. Animals can be made capable of eating more
than one type of food, but more sources take more energy due to the
more versatile digestive system required to absorb the different mate-
rials.

Behavior

There are four slider controls, two drop-down menus and a series of
icons and buttons that define the animal’s behavior. In SimLife, all
behavior is geared to foraging for food, finding a mate and fleeing
enemies.

The Share Food slider deals with the social aspects of eating. If the slider
is all the way to the left, then the animal will hunt and eat alone, like the
tiger. If the slider is all the way to the right, then the animal has highly
developed social graces when it comes to food. These species will hunt
or gather together and share food with any member of their species.

The Roaming slider adjusts how often the animal will move when it
doesn’t absolutely need to find food or water right away.

The Turning slider adjusts the number and severity of directional
changes the animal makes while moving.

The Persist slider controls how long a creature will follow a trail before
giving up and trying something else.

Turn Type is a pull-down menu that lets you choose between three types
of turning behaviors: zig-zag, looping and random.

Turn Angle is a pull-down menu that lets you choose between four
severities of turns that the animal can make: low, medium-low, medium-
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Hint: It is a good
idea not to have
your animal be
attracted to
another animal
that will eat it.

high and high. A high turn angle helps an animal thoroughly explore a
small area, while a low turn angle allows an animal to hastily cover a
larger territory.

The Prefer/Avoid/Ignore controls set what types of plants or animals
your current animal will be attracted to or repelled by.

You can choose up to eight organisms and set whether they attract or
repel your animal;

* Click on any of the buttons below the icons to toggle
between Prefer (+), Avoid (-) or Ignore (Q).

¢ Click and hold on the icon above to reveal a submenu of
all life-forms.

¢ Slide the cursor to the plant or animal you want, then
release the mouse button.

Icons to the right take precedence in behavior conflicts, i.e., if an animal
comes into contact with one thing that it is attracted to and another thing
it is repelled by at the same time, it will react to the one whose icon is
farthest to the right.

Life
This section of the genetic code consists of two sliders and one pull-
down menu that deal with the animal’s maturation rate and length of life.

Life Span is a slider control for adjusting the maximum life span of the
animal. This maximum life span is a percentage of the maximum life span
in the Laws of Physics Window.

Adult is the age, or point in the life span, where the animal reaches
maturity. Animals grow in size until they reach adult age.

Die-off is a pulldown menu with three choices for death age (die-off is
superceded by death due to starvation, dehydration or predation): immor-
tal, live to old age and live to medium age. Click and hold on the down-arrow
button to see the menu, then slide the cursor to your choice.
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When the setting is immortal, the animal will not die of natural causes.
When the setting is old age, the animal will live out its maximum life span.
When the setting is medium age, the animal will die somewhere between
maturity and maximum life span.

Features

This section of the Genome Window consists of four slider controls that
deal with physical survival features, which require a lot of energy.

The Size slider controls the maximum size of the animal.

The Stealth slider controls the animal’s ability to move silently and
avoid predators.

The Weapons slider controls the power of the animal’s weapons (claws,
teeth, poisons, etc.).

The Vision slider controls the animal’s visual acuity.

Gestation

This section of the Genome Window consists of four sliders and one pull-
down menu that deal with the animal’s reproductive system.

The Size slider controls the amount that the animal gains in size during
gestation, which directly relates to how much food/energy the animal

needs to reproduce.

The Time slider controls the amount of time the animal takes to produce
offspring.

The % Female slider controls the percentage of offspring that are female.

The Mutation slider controls the likelihood of the animal's offspring
having a mutation.

Number of Children is a pull-down menu that controls the number of
offspring the animal has each litter. Click and hold on the down-arrow
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button to reveal the menu, then slide the cursor to the number you want.
The choices are 1, 2, 4 and 8 children per litter.

Food

This section of the Genome Window deals with the animal’s food/energy
stores. The current values for food for any individual animal can be seen
in the Variables Window.

The Max slider adjusts the maximum food the animal can store in its
body. A high max setting allows stocking up of energy when it is plentiful,
but increases the animal’s weight and slows it down.

The Action slider sets the food storage level that provokes the animal to
start looking for food.

The Danger slider sets the food storage level for when the animal does
nothing else but look for food.

Water

This section of the Genome Window deals with the animal’'s water
stores. The current water values for any animal can be seen in the
Variables Window.

The Max slider adjusts the maximum water the animal can store in its
body. A high max setting allows stocking up of water when it is plentiful,
but increases the animal’s weight and slows it down.

The Action slider sets the water storage level that provokes the animal
to start looking for water.

The Danger slider sets the water storage level for when the animal does
nothing else but look for water.

Health

This section of the Genome Window deals with the animal’s overall
health. The current values for health for any animal can be seen in the
Variables Window.
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The Max slider adjusts the maximum health level the animal can reach.

The Action slider sets the health level that causes the animal to start
resting to replenish its health.

The Danger slider sets the food storage level for when the animal does
nothing but sit still and save energy.

Maximum Size Bar
As you design or modify an animal in this window, the Maximum Size Bar
willindicate how big your animal will have to be to hold all the features
and capabilities you are programming into it.

Energy Requirement Bar
As you design or modify an animal in this window, the Energy Require-
ment Bar will indicate how much energy your animal will require to
survive with all the features and capabilities you are programming into
it.

The farther to the right this bar is, the more energy the animal needs to
survive. Try to keep this bar at 3/4 or less. If this bar gets all the way to
the right, the animal will need so much food to live it could starve in the
middle of dinner.

Never Mind

Click this button to leave the Genome Window without changes taking
place.

Make It So

Click this button when you are happy with all the settings. All your
changes will be activated and the window will close.

Help

At any time you can click and hold on the Help button or on any of the
labels or gene names to see on-screen help.
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THE PLANT GENOME

' Species Gename for New Plant
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Gender

button.

Structure

Title Section

This part of the Genome Window displays the
name of the species or individual plant currently
being edited. If it is an individual organism, it will
have a number as part of its name.

Gender is a pull-down menu with four choices for plants: Male, Female,
Both and Asexual. Click and hold on the down-arrow button to open the
menu, then slide the cursor to your choice and release the mouse

Structure is a pull-down menu with four choices for basic plant struc-
ture: Tree, Shrub, Grass and Floating. Click and hold on the down-arrow
button to open the menu, then slide the cursor to your choice and
release the mouse button.
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Seeds

seedsis a pull-down menu with four choices for types of seeds your plant
can have: Sticky, Dropping, Drifting and Fruit. Click and hold on the
down-arrow button to open the menu, then slide the cursor to your
choice and release the mouse button.

Seasons

Sprout Season is a pull-down menu with your choice of four seasons in
which your plant can sprout: Spring, Summer, Fall and Winter. Click and
hold on the down-arrow button to open the menu, then slide the cursor
to your choice and release the mouse button.

Flower Season will always be the season immediately following Sprout
Season.

Seed Season will always be the season immediately following Flower
Season.

Sliders

There are nine slider controls for adjusting various genetic characteris-
tics of your plant. All adjustments get higher as the slider moves from left
to right.

The Evaporation Rate slider controls the rate at which the plant loses
water to the atmosphere. The higher the evaporation rate, the faster it
loses water and the more water it needs to survive. Also, the higher the
evaporation rate, the faster the plant will grow.

The Sprout Moisture slider controls the amount of moisture required for
the plant’s seeds to sprout.

The Sprout Temperature slider controls the temperature that must be
reached in sprouting season before the seed will sprout.

The Health slider sets the maximum health level for the plant. The
higher the health, the more resistant it is to toxins and the better it can
survive after being partially eaten by animals.
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The Food slider sets the maximum amount of food the plant can store.

The Water slider sets the maximum amount of water the plant can store.

The Mutation Rate slider controls the odds on how often mutations will
occur in new generations of this plant.

The Maximum Size slider controls the size limitations of the plant.

The Old Age slider controls how long the plant can live (barring
accident, predation or disaster) before it loses the ability to reproduce.

Buttons

The Nectar button is a yes/no toggle that controls whether or not the
plant produces nectar.

The Evergreen button is ayes/no toggle that controls whether or not the
plant is an evergreen.

Click on Never Mind if you want to leave the Plant Genome Window
without any changes taking place.

Click on Make It So when you are happy with all your settings. All your
changes will be activated and the window will close.

Help

Click and hold on the Help button or on any slider or control names for
on-screen help.
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The Climate Lab lets you make changes to the climate of the current l;I.IMATE I.A

world. It can be reached through the Climate Lab item in the Windows
Menu or through the Climate Lab button in the Dashboard.

The Climate Lab can be moved around the
screen by clicking and dragging the Title
Bar. It'll go away if you click in the Close Box.

£

Day Length Yariation Peak

Each of the three adjustable climatic as-
pects deal with variation throughout the
year and have two controls: a slider to set

Rainfall Yariation Peak

Temperature Yariation __ Feak

The Climate Lab

P R 8

By,

'Summer =i

lSpn ng [xd

the amount of variation and a drop-down
menu to set the season where the variation

|Summer [x]

1 Days 16

reaches its peak.

Adjust the sliders by clicking and dragging the pointer. The variation
increases from left to right. To set the Peak Season, click and hold on the
down-arrow buttons to open a pull-down menu of the seasons, then slide
the cursor to the season of your choice and release the mouse button.

The right side of the window has a graph to visually depict the seasonal
variations for each setting.

Day Length Variation

This setting controls how much the amount of daylight per day changes
throughout the year. This affects the amount of sunlight plants get.

Rainfall Variation

This setting controls the seasonal changes in rainfall (which is included
under the Humidity heading in the graphs and in most other windows).

Temperature Variation
This setting controls the seasonal changes in temperature.

Help

You can get on-screen help by clicking on the Help button.
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GRAPHS WINDOW

w

The Graphs Window is a very versatile tool for extracting information
from the simulation. It can display 720 graphs in either of two time scales.
Four graphs can be displayed at a time.

The Graphs Window can be opened from the Windows Menu (it's in the
Census submenu) or through the Census button on the Dashboard.

| Title Bar

Close Box Graphs
ATl Plants
Time Scale — Population  Graph
| A animas = fIseiatt Selectors
Population  [x4 . Populstion  [xd E
Percentages - [ l “'"‘“‘*‘-—-—"— 609 1\ Number
b 457 Scale
40% . : —1304
R0 o2 O S
oxe || H\~——A./ =
" - S
1 Display Area

The Graphs Window can be moved around the screen by clicking and
dragging the Title Bar. It will go away if you click in the Close Box.

Just below the Close Box is a “punch card” that marks the Graphs
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forwards and backwards
through all the Census Windows.

To the left of the up and down arrows is the Help button. Click and hold
on this button to see a brief explanation of what this window does and
how it works.
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TIME SCALE

There are two available time scales in which the graphs can be dis-
played, 50 years or 50 days. Click on the Days or Years buttons to change
time scales.

GRAPH SELECTORS

There are four graph selectors, each of which can be used to choose any
graph—or no graph—to display. Each selector is assigned a color or
shade. The words in the selector and the corresponding graph will
appear in this color or shade.

Selecting a graph to display is a two-step process: first select a species,
then select the information.

The Local Species

The Local Species of the graph is the plant or animal whose information
is graphed. The Local Species can be any plant or animal, or all plants or
all animals at once. When this species is selected, it is active in the
Graphs Window only—it does not become the Selected Species in the
Dashboard.

To select a Local Species, click and hold on the upper down-arrow
button to reveal a submenu of all possible choices, then slide the cursor
to your choice and release the mouse button. An icon representing your
choice will appear below the arrow.

[fyou hold down the Option key (or the Control key if your keyboard has
no Option key) while selecting a Local Species, that species will be the
subject for all four selectors.

Desert Snake  [xd

Al Animnals
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No Graph

Births

Deaths

Age (7% of max)
Size (7. of man)
Females (%)
Radiation (%)
Food (%)
Water (%)
Health (%)

7% of Biomass
Ecology Score

Population

The Information
The information is the data to be graphed about the above subject.

To select the information to be displayed, click and hold on the lower
down-arrow button to reveal a submenu of all possible choices. then
slide the cursor to your choice and release the mouse button. If you hold
down the Option key (or the Control key if your keyboard has no Option
key) while selecting the information, that information will be selected for
all four selectors. (The last sentence was a selected selection for our
select audience.) The possible choices of information to display are:

No Graph — displays nothing for this Graph Selector.

Population — displays the changes in the subject’s population.
Births — displays the changes in the subject’s births.

Deaths — displays the changes in the subject’s deaths.

Age (% of Max) — displays the changes in how long the subject lives as
a percentage of its maximum possible age.

Size (% of Max) — displays the changes in the subject’s size as a
percentage of its maximum possible size.

Females (75) — displays the changes in the percentage of the subjects
that are female.

Radiation (V5) — displays the cumulative radiation dose the subject has
received as a percentage of the maximum dose.

Food (%) — displays the changes in the percentage of maximum food the
subject has stored.

Water (V6) — displays the changes in the percentage of maximum water
the subject has stored.

Health () — displays the changes in the subject’s health rating, as a
percentage of maximum health.

% of Biomass — displays the amount of the biomass that is represented
by the subject. If the subject is an animal species, the graph will show ts
percentage of the total animal biomass. If the subject is a plant species,
the graph will show its percentage of the total plant biomass. If the
subject is All Plants or All Animals, the graph will show its percentage of
combined plant and animal biomass.

Ecology Score — displays an ongoing score of the ecological soundness
of the current world. This score is actually a rating of how well you are
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doing as master of this ecosystem. It is easy to get high ecology scores
forshort periods of time—the challenge is to keep a constant high score.

Note: If you have deselected Record All Statistics in the
Technical submenu of the Simulation Menu, the percentage-
based graphs and the ecology score will not be available.

DISPLAY AREA

The bottom section of the Graphs Window is where the graphs are
displayed. When relevant, numbers will appear along the right side and/
or percentages will appear along the left side to provide a scale for

interpreting the graphs.

THE PRICE OF PROGRESS...

| A KBNS : is it?
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We'll have to sell

/ the house. But |
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If worse comes to worse,
the local zoo would love

Well, you know what they say about a
POOLE AND HIS MONEY!!
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MORTALITY
WINDOW

The Mortality Window is a graphic display of the causes of death in the
ecosystem. It also displays the predators (if any) that are responsible for
the deaths. It can be opened from the Windows Menu (it’s in the Census
submenu) or through the Census button on the Dashboard.

The Mortality Window can be moved around the screen by clicking and
dragging the Title Bar. It will go away if you click in the Close Box.
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Just below the Close Box is a “punch card” that marks the Mortality
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

Below the up and down arrows is the Help button. Click and hold on this
button to see a brief explanation of what this window does and how it
works.
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LOCAL SPECIES

Mortality information can be shown for any individual species, or for All
Plants or All Animals as a group. To select the Local Species whose
mortality graph you want to see, click and hold on the down-arrow
button to open the submenu of choices, slide the cursor to the species
of your mortal desire and release the mouse button.

The species selected here does not affect the Selected Species in the
Dashboard or any of the other windows.

ALL DEATHS

The default display is a graph of all causes of death for the previous five
years.

The agents of death are listed along the left side of the display from top
to bottom. The number of deaths in the current year from each cause is
displayed below the name of each agent.

The percentages are represented as bars that increase from left to right.

WHO’S EATING ME?

If you click on the Who's Eating Me? button, you will see a display of all
the predators with bar graphs showing how many of the Local Species
they have eaten.

Click on the All Deaths button to return to the default display.

CAUSES OF DEATH

For the most part, the causes of death are self-explanatory: Eaten, Old
Age, Disease, No Water and No Food are easy to figure out. The only
ambiguous one is Accident, which covers everything that doesn’t fit into
any of the above categories. Deaths listed as Accidents include human-
caused death by: Smiting, Plant and Animal Limits in the Laws of Physics
Window, and Populating land plants or animals in the water. It also
covers real accidents like water animals stranded on land during a
drought. Also, when animals have children, their litters spread out in all
directions. If a litter occurs near water, some infants can drown.
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GENE POOL
WINDOW

|
1
|

The Gene Pool Window is a graphic display of evolution in action. It
shows the frequency and spread of genes for any single species at a time,
or All Plants or All Animals at once.

It can be opened from the Windows Menu (it’s in the Census submenu)
or through the Census button on the Dashboard.

The Gene Pool Window can be moved around the screen by clicking and
dragging the Title Bar. It will go away if you click in the Close Box.

Close Box Gene Pool : Title Bar
P()[)Ul(’iﬁ(}ﬂ m-l"‘ﬂpuletion Each siioo rﬁmts a value for a Tm};;.‘frait:___ Color Key
Use Colors? - Colors are % of pop. using each of a gene's traits:
0-3% 21-32% 82-87%
Local Species Selector —H-2Pectes !?_ -l g .33:;’@
fHorse 14-20% 70-81% 97-100%
Life Span
—— A Imn :gt [3 Continuous
Discrete Gene Section - || ¥ [_—__—_]"* foest tme =4 - Gene
N L o | Section
: Asexual IW
:’Sterﬁt Im__
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Just below the Close Box is a “punch card” that marks the Gene Pool
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

Next to the up and down arrows is the Help button. Click and hold on this

button to see a brief explanation of what this window does and how it
works.




TYPES OF GENES

To understand this window, keep in mind that creatures in SimLife have
two types of genes: discrete and continuous.

Discrete genes are like yes/no or multiple-choice genes. They have one
value. For instance, as far as animal movement genes go, either the
individual animal walks or it doesn't; it flies or it doesn’t. Yes or no.
Relating to gender, either an animal is male, female, asexual or sterile.
Pick one and only one: multiple choice. Discrete genes are shown and
adjusted in the Genome Window as on/off buttons.

Continuous genes are those that can have a wide range of values, for
example, the life span or the mutation probability genes. Each of these
genes is a number somewhere on a continuum from 0 to 256. They are
shown and adjusted in the Genome Window as slider controls.

In a sense, you can think of the discrete genes as digital—yes or no, on
or off—and the continuous genes as analog with a continuous range of
possible values. (Technically, in SimLife, the continuous genes are
stored and computed digitally and actually have a number of discrete
values, but there are enough available values in the continuum for them
to appear analog for all practical and experimental purposes.)

POPULATION

This section of the Gene Pool Window displays the total population of
the Local Species, whether the Local Species is a plant, an animal, or All
Plants or All Animals.

This window always displays information on a species population—all
the members of that species that are currently alive in the world. The
only way you can see the gene pool information for one organism is if
there is only one alive, or if you put one organism into its own species
with the Speciate function. Of course, one organism is not a very good
gene pool.

Reference

159




lMavemeint

L

walk
climb
Swim

fly

LOCAL SPECIES

This section of the Gene Pool Window both displays and allows you to
select the Local Species. Click and hold on the down-arrow button to
reveal the submenu of all possible choices, then slide the cursor to your
choice and release the mouse button. Both the name of the Local Species
and its icon will be displayed.

The species selected here does not affect the Selected Species in the
Dashboard or any of the other windows.

USE COLORS BUTTON

This button toggles between displaying the continuous gene section of
this window using colors to represent percentages or using small bar
graphs to represent percentages. This will be explained below.

This button may not appear on computers with monochrome monitors.

DISCRETE GENES

This section of the Gene Pool Window displays all the information on the
discrete genes of the Local Species.

The genes are arranged into groups of related genes. The group name is
displayed at the top of this section, and the individual genes are listed
below with a bar chart showing what percentage of the population has
this gene. The bar charts range from 0% on the left to 100% on the right.
Since individual organisms can have more than one food source or
method of movement, the bar charts can add up to more than 100%.

Group Selection

One group of genes can be selected at a time. Click and hold on the down-
arrow button to reveal a submenu of the choices, slide the cursor to your
choice and release the mouse button.

broups And Individual Genes

Since the genes in plants and animals are different, so are the groups as
displayed in this section of this window.
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Plant Gene Groups
Gender: Asexual, Male, Female, Both

Structure: Floating, Grass, Shrub, Tree
Seeds: Sticky, Dropping, Drifting, Fruit
Sprout Season: Summer, Fall, Winter, Spring
Nectar: Yes, No

Evergreen: Yes, No

Animal Gene Groups
Gender: Male, Female, Asexual, Sterile

Movement: Walk, Climb, Swim, Fly

Food Sources: Nectar, Fruit, Filter, Plants, Animals, Seeds
Die-Off: Immortal, Old Age, Middle Age

# Children: 1,2, 4, 8

Attracted to: There are no “set” choice displays for Attracted to.... Icons
representing the six most common attractants for the Local Species will
be displayed to the right of its bar charts.

Tries to Avoid: There are no “set” choice displays for Tries to Avoid....
lcons representing the six most common repellants for the Local Species
will be displayed to the right of its bar charts.

Turn Angle: Low, Med-Low, Med-High, High
Turn Type: Looping, Random, Zig-Zag

CONTINUOUS GENES

This section of the Gene Pool Window displays all the information on the
continuous genes of the Local Species.

There are 23 different continuous genes that can be displayed for
animals and nine for plants.

Gender
Structure
Seeds

Sprout Season
Nectar
Evergreen

Plant Gene Groups

Gender
Movement
Food Sources
Die-0ff
Children
Attracted to...
Tries to Avoid...
Turn Angle
TurnTgpe

Animal Gene Groups
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Size

Stealth

Weapons
Evaporation Rate Vision
Sprout Moisture Food Store
Sprout Temp. Food Action

Food Store
Water Store
Health Store
Mutation Rate
Maximum Size
Lifespan

Plant Continuous
Genes

Food Danger
Water Store
Water Action
Water Danger
Health Store
Health Action
Health Danger
LifeSpan
Adult Age
Birth Size
Gestation Time
% Female
Mutation Rate
Roaming
Turning
Persist

Share Food

Animal Continuous
Genes

Use Colors?
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Gene Selection

Along the left side of this section is a list of the continuous genes being
displayed. Nine genes can be displayed at once, so all plant genes can be
viewed simultaneously.

To view all the animal genes or change the order of display for plants,
click and hold on the down-arrow to the right of the gene name to open
a submenu of all available choices, slide the cursor to your choice, then
release the mouse button.

Warning: Tricky Graphs
The Continuous Gene display is a little tricky, but understanding it is

very important to interpreting changes in the Gene Pool, which is
needed in many scenarios and experiments.

To make it easier to understand, there are two different ways to look at
the information: using colors and using bar graphs.

The two types of displays are chosen by clicking on the Use Colors?
button. A color or monochrome key will appear to help you interpret the
data in this section of the window.

On some computers with monochrome-only screens, the Use Colors?
button and/or the color key and/or color display may not be available.

Continuous Gene Display -- Monochrome

When the Use Colors? button is set to “No,” the continuous genes will be
displayed using small black bar graphs. The key at the top will help you
understand the display.

Each of these partitioned rectangles represents one continuous gene.
The left end of this rectangle corresponds with the lowest value for that
gene and the right side corresponds with the highest value. The bars
appear at different locations—different values—and show what per-
centage of the population has that value for the particular gene. The
higher the bar, the higher the percentage of the population with that
value.
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Fach of these lines matches a slider in the Genome Window. For
example, the life span gene.

Above is shown the Gene Pool Window life span gene display for one
animal, and that animal’s life span gene from the Genome Window.
Notice how the bar’s and arrow’s locations match.

To be really useful, the gene pool must show the combined genes for a
whole population, not just one organism. Each animal in the population
will have a value for life span, but not all of them will have the exact same
value.

When there is a spread of values for a gene, this is shown using multiple
black bars at different locations. The higher the bar, the more of the
population has that value for the gene.

In addition, if the Local Species is a single species (not All Plants or All
Animals), there will be a thin pink or black line somewhere in the display.
This line marks the value of this gene for the Prototype of the species.
You can look at the prototype value as the “starting position” for each
gene. When the black bars drift away from the Prototype, they represent
the change in the gene pool—the evolution of the genes through natural
selection and mutation.

If All Plants or All Animals is selected there will be no Prototype lines.

el lifespan
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Continuous Gene Display -- Color
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value for this gene. Instead of using the height of the bar to
represent the percentage, in this display we use color. The key
above will show you what colors represent what percentages.

e 7 I

The gene pool is the combined genes for a whole population. Each
organism in the population will have a value for each gene, but not all of
them will have the exact same value.

Each rectangle displays all the values of all the organisms for one gene.
When there is a spread of values for a gene, this is shown using multiple
colored bars at different locations.

Part of the reason for using this type of display is because it looks very
much like the Gel Electrophoresis analysis of actual DNA in a biology
laboratory.

In addition, if the Local Species is a single species (not All Plants or All
Animals), there will be a thin pink or black line somewhere in the display.
This line marks the value of this gene for the Prototype of the species.
You can look at the prototype value as the “starting position” for each
gene. When the colored bars drift away from the Prototype, they
represent the change in the gene pool—the evolution of the genes
through natural selection and mutation.

If All Plants or All Animals is selected there will be no Prototype lines.
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This window shows the predator/prey relationships between different
organisms in the ecosystem.

The Food Web Window can be opened from the Windows Menu (in the
Census submenu) or through the Census button on the Dashboard.

The Food Web Window can be moved around the screen by clicking and
dragging the Title Bar and it will go away if you click in the Close Box.

Close Box Title Bar
@

Click on icons »
ol Species

’ (=4
o naviget Horse — Species Selector

Predator Icons - i
and Graphs S| E“"

N
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-
B
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- Prey Icons

i

Plant Eaters | Meat Eaters
M— More Buttons

Just below the Close Box is a “punch card” which marks the Food Web
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

Next to the up and down arrows is the Help button. Click and hold on this
button to see a brief explanation of what this window does and how it
works.

FOOD WEB

WINDOW
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W Food Web
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Note: Plants can be eaten but not necessarily killed,
which can technically be called parasitism as opposed to
predation, but they’re shown here as prey.

SPECIES

This is the display of the Local Species: the species whose food web
information is shown below. To change the Local Species, click and hold
on the down-arrow to reveal a submenu of all available choices, then
slide the cursor to your choice and release the mouse button.

In this window you can only select a single species at a time; you cannot
choose All Plants or All Animals. Changing this species does not affect
the Selected Species in the Dashboard.

MAIN LINKS

The Main Links display is the default setting for this window, and is
shown above.

Press this button to display the main links in the food web for the current
ecosystem. It will show up to eight predator species on the left and their
associated eight favorite prey species on the right. These are the top
eight energy transactions in the food web.

To the left of the predator icons is a bar graph showing the relative
activity of the predators.

If you click on any of shown predators or preys, they'll pop to the center
and become the Local Species and this window will enter One Species
mode (see below).
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ONE SPECIES

Press this button to display the food web centered around the Local
Species.

The Local Species will appear in the middle. Any and all predators will be
listed along the left. These are the animals (if any) that eat the Local
Species.

The eight most common food sources, including prey (those who are
eaten by the Local Species) will appear along the right (if any—plants
have no prey).

To the right of the prey icons is a bar graph showing how many of each
prey were caught and eaten by the Local Species.

Ifthe Local Species is a plant, no prey will be displayed because plants
don’t go around hunting and eating things they catch. (Well, other than
the big plant in my office that likes to munch on editors that take liberties
with my writing, if you can take a hint.)

If you click on either a predator or prey, it will become the Subject
Species. Its icon will move to the middle of the display and its predators
and prey will be shown on the left and right respectively. In this way you
can move up and down the food chain and get a complete overview.

] Food Web
@A (Hepd (G2
Click on icons

Species
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POPULATION
INTERAGTION
WINDOW
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The Population Interaction Window displays a special type of graph of
the predator/prey relationships between different organisms in the
ecosystem. Unlike the graphs in the Graphs Window, which map a single
population against time, this graph maps the ratios of two populations
(predator and prey) against each other over time.

To open the Population Interaction Window, first open the Food Web
Window in Main Links mode, then hold down the Option key (or Control
key if your keyboard has no Option key) and click on one of the predator
icons.

| Population Interaction
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Note: This graph only shows the relationship between
plant and animal predation, and will not work when the
prey is filter food.

This window can be moved around the screen by clicking and dragging
the Title Bar and it will go away if you click in the Close Box.

Just below the Close Box is a punch card within a punch card that marks
the Population Interaction Window as a decendant of a Census Window.

Over on the right side of the window is the Help button. Click and hold

on this button to see a brief explanation of what this window does and
how it works.
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TIME SCALE

Click on the Days or Years buttons to choose between displaying data
for the last 50 days or the last 50 years.

DISPLAY AREA

This part of the window is a grid where the graph is displayed. The
predator is shown along the left (Y axis), the prey along the bottom (X
axis). The lower-left corner is zero population for both species. The
number of living predators is shown on the upper-left side of the grid, the
number of living prey is shown at the lower-right.

Above the display area s a color key that lets you know which of the data
points are older, and which are newer.

CHANGING SPECIES

Once this window is open, you can change the two species being
graphed to any two species currently loaded into the simulation. Click
and hold on the down arrow button next to either species’ icon, then
select the new species of your choice.

INTERPRETING THE GRAPH

If all the data points are clustered together in a small bunch, then both
the predator and prey populations are stable. If the line is circular, then
you have a predator/prey “cycle,” where the two populations directly
affect each other. If the line travels horizontally from right to left, the
predator is killing off the prey faster than they can reproduce.

In a long-lasting ecosystem, this graph will show various repeating, ever-
changing shapes and patterns that point out the chaotic nature of
ecosystems.

BACK T0 FOOD WEB

Clicking on this button returns you to the Food Web Window.
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P ﬂ PUI. AII 0N The Population Window is a graphic display of the relative populations
w IND ﬂw of all organisms in the ecosystem. It can be opened from the Windows
Menu (in the Census submenu) or through the Dashboard Census button.

s !
The Population Window can be moved around the screen by clicking
and dragging the Title Bar. It will go away if you click in the Close Box.
Just below the Close Box is a “punch card” that marks the Population
Window as a Census Window.

mm Near the upper-right corner of the window are up and down arrow
S buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

Below the arrows is the Help button. Click and hold on this button to see
— a brief explanation of what this window does and how it works.

ALL PLANTS

|
e o ﬁmﬁé Click on All Plants to see the population display of the plants. The

total plant population is displayed to the left of the All Plants
button, and icons representing all the plants are displayed below.

o
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Bars will appear above the icons representing the relative popu-

Q E g lations of each plant. The higher the bar, the greater the popula-
tion. If there is no bar, then there are no representatives of that

. Q species in the ecosystem at the current time.

ALL ANIMALS

- Click on All Animals to see the population display of the animals.
The total animal population is displayed to the left of the All
Plants button and icons representing all the animals are displayed
below.
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of each animal. The higher the bar, the greater the population. If there
is no bar, then there are no representatives of that species in the
ecosystem at the current time.

| Bars will appear above the icons representing the relative populations
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The Diversity Window is a graphic display of which ecological niches are
being exploited by the current population of plants and animals.

The Diversity Window can be opened from the Windows Menu (it'sin the
Census submenu) or through the Census button on the Dashboard. It
can be moved around the screen by clicking and dragging the Title Bar.
It will go away if you click in the Close Box.
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Just below the Close Box is a “punch card” which marks the Diversity
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

Below the arrows is the Help button. Click and hold on this button to see
a brief explanation of what this window does and how it works.
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MAKING A LIVING

To survive in an ecosystem, plants and animals must “exploit a niche,”
or make a living. Ecologically speaking, making a living is finding a way
to survive—finding food, avoiding becoming food and reproducing.

For animals, the most important parts of making a living are their type(s)
of movement and kind(s) of food they can eat.

Plants don’t move, so their strategies are a little different. Different sizes
and structures of plants (trees, shrubs, water plants, etc.) are better
adapted to different environments. Different ways of spreading seeds
(fruit, dropping, sticky, etc.) and energy-saving strategies (evergreen vs.
deciduous) work better (or don't) depending on the climate and sur-
rounding animal life.

If a lot of different organisms eat the same kind of food, live in the same
places, and generally live the same lifestyle, there will be a lot of
competition for resources. If different plants and animals each live a little
differently—eat different foods, move differently, spread seeds in differ-
ent ways—they are not in direct competition with each other, and more
can survive.

Beyond non-competition, a lot of different types of plants and animals
living together, each in a different niche, become more than the sum of
the individual organisms. They become an interrelated food web, a
community, an ecosystem. A healthy long-lasting ecosystem will have
plants and animals in many diverse niches.

ALL ANIMALS

Click on All Animals to see the diversity display of the animals. The
display is a gridlike graph with food sources on the left (the Y axis) and
types of movement on the bottom (X axis). There is a box at each grid
intersection point of the X and Y axes. The number of animals at each
intersection (Z axis) is shown by the size and shade of the box. A key to
interpreting the boxes and the numbers they represent is provided on
the right side of the window.
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ALL PLANTS |

Click on All Plants to see the diversity display of the plants. The display ’
is a gridlike graph with types of trees on the left (the Y axis) and seed and
nectar information on the bottom (X axis). There is a box at each grid
intersection point of the X and Y axes. The number of plants at each
intersection (Z axis) is shown by the size and shade of the box. A key to
interpreting the boxes and the numbers they represent is provided on
the right side of the window. ﬁ
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“ IS T 0 RY w IND 0w This window tracks and lists the important historical events that have

happened in the ecosystem during the present game or experiment.

The History Window can be opened from the Windows Menu (in the
Census submenu) or through the Census button on the Dashboard.

The History Window can be moved around the screen by clicking and
dragging the Title Bar and it will go away if you click in the Close Box.

Just below the Close Box is a “punch card” that marks the History
Window as a Census Window.

Near the upper-right corner of the window are up and down arrow
buttons. You can click on these arrows to cycle forward and backward
through all the Census Windows.

: ER

Below the arrows is the Help button. Click and hold on this button to see
a brief explanation of what this window does and how it works.
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The Laws of Physics Window gives you the power to change the physical
laws and properties that deal with time and energy in your world. It can
be opened with the Change Physics... item in the Technical submenu of
the Simulation Menu.

Movement Costs Metabolism Costs Th. Laws
[Ting =g swim [Tiny [z Geststion | of Physics Y
Tiny Walk Tiny Growth
| Tiny cimo  [Ting A Meelimg  gimujation Sturf J
[Ty X3Py Heaith Costs [Short (=4 Life Span
Tiny [z Toxin ; 8 ficks [zj Day Length

Food Value :
?iuoe T=4 Animals o ﬁ fiuw T6 dags (=3 Yeer Length
[Ting T3 04Me  [T7a =7 Plent Limit

Huge [z Plants *____ ==
— T Crowdi e —
Tae oy Fitter 1[I Croweing - [ZerTTST Mutation Rete

[ g rut  I7™ [xdtte, o5 T=] Animal Limits
Huge [ Nectsr '%-i‘l'-‘i%%?r = Soil & Climate Change
ny
Huge [=j Seeds

Tiny E water

rm pefeults [ N ]_aver Mind | m |

Besides feeding one’s ego by supplying such awesome power, this
window actually has very practical experimental uses. For example,
changing the amount of energy it takes to move, such as a setting of very
little energy to fly and a lot to walk, could simulate a low-gravity world.
Raising the energy it takes to swim could simulate a world with a very
viscous ocean.

Depending on your experiment, changing the physics of time can help
your efficiency. If you are interested in the behavior of one generation,
make the days and years as long as possible and increase the life span
of organisms. If you are interested in the genetic drift over many gener-
ations, shortening the length of days and years could save you hours or
days of computer time.

Many of the settings below have a range of possible values that goes from
Tiny to Low to Medium to High to Huge. Each value is twice the previous
value, i.e., Low is twice as high as Tiny, Medium is twice as high as Low,
etc.

LAWS GF PHYSICS
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HELP

At any time in this window you can click and hold on the Help button or
on the name of any control for a pop-up explanation of what it does.

MOVEMENT COSTS

This is where you can adjust the amount of energy it takes for an animal
to move in any of the four ways: Swimming, Walking, Climbing and Flying.
Since plants in SimLife don’t move, this won't affect them.

There are five values for each movement type: Tiny, Low, Medium, High
and Huge.

To change the movement cost, click and hold on the down-arrow button
to open a submenu of all available choices, slide the cursor to your
choice, then release the mouse button.

As mentioned above, changing movement costs can simulate different
gravities and ocean viscosities. If you use your imagination with these
settings you can come up with some interesting worlds.

FOOD VALUE

By adjusting the amount of food value—energy—supplied by each type
of food, you directly control how much food animals need and indirectly
affect their behavior by controlling how much time they must spend
looking for food and how much time they have for other pastimes, such
as looking for a mate.

There are six food sources: Animals, Plants, Filter Food, Fruit, Nectar and
Seeds. Each of these foods can be assigned a value: Tiny, Low, Medium,
High, or Huge.

To change the food value cost, click and hold on the down-arrow button
to open a submenu of all available choices, slide the cursor to your
choice, then release the mouse button.
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Changes in Food Values do not directly affect plants, but indirectly they
will affect how many of them will be eaten—more if their food value is
low, less if their food value is high.

These settings do not affect the Ultra-Food food sources.

METABOLISM COSTS

This section adjusts how much energy is required for metabolic pro-
cesses: Gestation, Growth and Healing. Each of these processes can be
assigned a value: Tiny, Low, Medium, High or Huge.

To change the metabolism cost, click and hold on the down-arrow
button to open a submenu of all available choices, slide the cursor to
your choice, then release the mouse button.

Gestation controls how much energy it takes to produce offspring. With
a high energy cost for gestation, only a very well-fed organism can
“afford” to reproduce.

Growth controls how much energy it takes for an organism to reach full
size.

Healing controls how much energy it takes to recover from injury,
plagues and toxins.

HEALTH COSTS

This section adjusts how much energy is lost by health-related pro-
cesses and issues. These issues are: Toxins, Plague, Old Age, Crowding
and Battle. Each of these items can be assigned a value: Tiny, Low,
Medium, High or Huge.

To change the health cost, click and hold on the down-arrow button to
open a submenu of all available choices, slide the cursor to your choice,
then release the mouse button.
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PLANT COSTS

This section controls how much energy is required by plants to “make
their living.” Plants need energy for getting food and water, growing and
making nectar, fruit, and seeds. The energy cost for food and water can
be set to a value: Tiny, Low, Medium, High, or Huge.

To change the plant costs, click and hold on the down-arrow button to
open a submenu of all available choices, slide the cursor to your choice,
then release the mouse button.

SIMULATION STUFF

This section controls seven simulation factors including time. Six fac-
tors are adjusted with a pop-up menu, the seventh with a slider bar.

Life Span

This setting adjusts the average life span for organisms in the world.

This setting is a “master control” for individual species’ life spans as set
in their genetic code. This setting sets a general life span length. The
species’ genes set the percentage of this general life span they are
capable of living.

The five possible life span settings are: Brief, Short, Medium, Long and
Methuselan. To change the life span, click and hold on the down-arrow
button to open a submenu of all available choices, slide the cursor to
your choice, then release the mouse button.

Day Length
This control sets how many Ticks (simulation cycles) constitute one
day. The possible day lengths are 8, 16, 32, 64, 128 and 256 Ticks.

To change the Ticks per day, click and hold on the down-arrow button
to open a submenu of all available choices, slide the cursor to your
choice, then release the mouse button.

You will want long days for behavioral experiments and short days for
long-term, many-generation experiments.
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Year Length

This control sets how many days constitute one year. The possible year
lengths are 16, 32, 64, 128 and 256 days.

To change the days per year, click and hold on the down-arrow button
to open a submenu of all available choices, slide the cursor to your
choice, then release the mouse button.

Plant Limit

This control lets you put limits on the number of plants that can exist in
the world at any one time. Since the simulation runs slower with more
organisms, you can limit the number of plants to: Unlimited, 1/2 maxi-
mum, 1/4 maximum, 1/8 maximum, 1/16 maximum, 1/32 maximum, 1/64
maximum and 1/128 maximum. The maximum is the total number of
cells in the world, and depends on world size.

To change the Plant Limit, click and hold on the down-arrow button to
open a submenu of all available choices, slide the cursor to your choice,
then release the mouse button.

Mutation Rate

This adjustment controls the overall Mutation Rate in the world, over-
riding an individual species’ mutation rate as set in its genetic code. This
setting sets a general rate, and the species’ genes set an individual rate
as a percentage of this general rate.

To change the Mutation Rate, click and hold on the down-arrow button
to open a submenu of all available choices, slide the cursor to your
choice, then release the mouse button.

Animal Limits
This adjustment sets the maximum number of animals that can occupy
the world at any one time. The setting is for all living species combined.
The more animals there are, the slower the simulation runs. Setting a
limitkeeps animals from runningamok and taking over all your computer’s
processing time.
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The maximum available animals that you can set are: Unlimited, 50, 100,
200, 400, 800 and 1600.

To change the maximum animals per species, click and hold on the
down-arrow button to open a submenu of all available choices, slide the
cursor to your choice, then release the mouse button.

Soil And Climate Change

This adjustment controls how much the soil and climate will change
over time. If you want a very stable climate with little or no erosion for
your experiments, set this slider low. If you want your ecosystem to be
subjected to wide swings in climatic conditions with erosion, set it high.

Buttons
At the bottom of the window are three buttons.

Click Set Defaults if you want to make the current settings in this window
the default conditions henceforth and forevermore (well, at least until
you make changes and set new defaults).

Click Never Mind if you want to make this window go away without
making any changes.

Click Make It So if you are happy with the current settings and want them
to be activated. The new settings will immediately take control of the
world, but the default settings will not be changed.
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The World Building Options Window lets you set options that the
simulation uses when creating a new world. It also lets you rebuild one
aspect, or data layer, of a world without changing anything else.

It can be opened with the World Building Options... item in the Technical
submenu of the Simulation Menu.

Show Steps toggles on and off the display of each data layer as the world
is built. When the steps are shown, it takes a little longer to build the
world, but it looks so cool that it seems to go faster.

Lake Size lets you choose to have large or small lakes in the world. If you
aren’t interested in water-dwelling creatures, making small lakes leaves
you more room for your landlubbers.

Temperature Zones, when selected, causes only the temperature zones
to be rebuilt the next time you build a world. This is especially useful
when you have changed a world’s altitude in the Edit Window and want
to update the temperature data to the new landform.

Moisture Zones, when selected, causes only the moisture zones to be
rebuilt the next time you build aworld. This is especially useful when you
have changed a world’s altitude in the Edit Window and want to update

the moisture data to the new landform.

Rivers and Lakes, when selected, causes only the rivers and lakes to be
rebuilt the next time you build a world.

Artifacts, when selected, causes only the artifact placement to be rebuilt
the next time you build a world.

Everything, when selected, causes every aspect of a world to be rebuilt
next time you build a world. This is the default setting.

Never Mind makes this window go away without making any changes.

Make It So activates the current settings and closes the window.

(

WORLD BUILDING
OPTIONS

| World Building Options

Show Steps:
Lake Size: | large | .
Create the Environment's:

|5M Mind l| mrtao I
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VARIABLES
WINDOW

The Variables Window shows and lets you change the current status of
any individual organism. The information in this window is not con-
tained in the genetic code; it is a display of the results of the genes and
environment.

This window shows the things that change during an organism'’s life, like
health, age, height, weight, etc., that are constantly variable. (Constantly
variable is the SimLife oxymoron of the week.) When you make changes
in this window, the changes in the organism take place immediately.

The Variables Window can be opened in two ways. From the Windows
Menu—if and only if there is currently an organism highlighted in the
Edit Window—or directly from the Edit Window by using the Life Tool
in Show Variables mode and clicking on an organism.

The Variables Window treats plants and animals differently—not be-
cause of prejudice, but because it recognizes the true differences
between the two types of organisms and appreciates them both for what
they are.

The Title Bar contains the name of the individual, which consists of the
species name and the individual’s number. The window can be moved
around the screen by clicking and dragging the Title Bar. The window
will go away if you click in the Close Box. The window will also go away
if the organism whose variables you are inspecting dies, so it is a
B good idea to pause the simulation while inspecting variables.

— | PLANT VARIABLES

| There are two sections to this window. The top section displays the
| individual plant’s current status for Health, Food supply, Water and
Radiation exposure.

Each display is a bar graph, with low on the left, high on the right. You
| can change (manipulate, heal, feed, starve, etc.) the plant by drag-
| ging the black arrows under each of the bars.
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The bottom section displays the Height, Weight and Age of the plant,
both numerically and with a bar. You can change the Height and Age by
dragging the black arrows under their bars, but Weight changes auto-
matically in relation to Height and other variables.

Note. If you age a seed, it will not instantly turn into a full
grown tree, or even sprout—it will become a very old
seed. Old seeds die.

ANIMAL VARIABLES

The Animal Variables Window has three sections.

LLucia's LLama 6

Health el

The top section is very similar to the top plant section. It shows the |{rood  gm ke

current status for Health, Food, Water and Radiation. In addition, it |} .
has marker arrows over Health, Food and Water to show where on |

the bar the animal takes action (the arrow on the right), or is in l%adﬁation_ &

Water e

danger (the arrow on the left). The action and danger levels are set

in the animal’s genome. ,HS‘*QM l 5 ;

j nghtﬁ r""“w
The middle section gives numerical and graphic representation of | il e _
g grap p . &ge IW _

the animal’s Height, Weight and Age. The Age bar has arrows to mark

the action level (arrow on the left) and danger level (arrow on the | _Fomge cﬁunt
right). This section also contains a display for Forage Count and |} oiation

Gestation.

['l'mﬁig-’ttaz_i:'{--f

Forage Count increases as an animal looks for food, and resets when
food is found. If the count reaches a certain number (depending on the
Persistence gene), the animal will try another foraging strategy.

For males, Gestation is blanked out. For females, Gestation gives the
current pregnancy status. If she is not pregnant, Gestation will be all the
way to the left. When the arrow reaches the right side of the slider, birth
occurs. Dragging the arrow all the way to the right causes the birth to
occur instantly: the SimCesarean.

The bottom section of this window is the Brain Box. Whatever the animal
is currently thinking will appear here.
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PHENOTYPE
WINDOW

| LLucia's LLama 19

The Phenotype Window displays any organism’s “flash card” image, as
seen in the Biology Lab.

O Pine Tree 244

Medium intelligence carnivore
Walking, lives in mountains
Long gestation time, few children

Makes nectar, dropping Seeds
. Evergreen temperate tree
Land Plant, sprouts in Cold dry weather

N S

The Phenotype Window can be opened in two ways: from the Windows
Menu if and only if there is currently an organism highlighted in the Edit
Window, or directly from the Edit Window by using the Life Tool in Show
Phenotype mode and clicking on an organism.

The image in this window does not represent the actual appearance of
the organism: Its purpose is to give you some insight into the organism'’s
size, structure, eating habits, etc.

We constructed these images of SimLife organisms out of parts of
familiar earth animals that should have some meaning for most of us. For
instance, looking at a phenotype of any animal, you can easily see what
it eats, how it moves and how many children it has per litter. And as
mammals, we like to think that if the picture of the head looks like a
mammal it has a larger brain than something with an insect’s head.
(Chauvinism? Maybe—but if any insects out there feel slighted you can
program your own darn game.)
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The Speciate Window lets you change a chosen individual organism into
another species in a few different ways.

The Speciate Window can only be opened from the Edit Window by
setting the Life Tool to Speciate and clicking on any organism.

SPECIES NAME

This is the display of the current individual organism (the Subject) that
is being speciated. Since it is an individual, it will have a number after the
species name.

MAKE ME PROTOTYPE OF SPECIES

Clicking this button will change the genotypes of all the organisms in the
Subject’s species to exactly match the Subject.

You might want to use this button if you have located one individual in
a species that has developed an advantageous genetic trait that you
want to share with the whole family.

MAKE ME INTO A NEW SPECIES

Click this button if you want to use the Subject as the starting point for
beginning a new species. After you click on this button, the Biology Lab
will open set to the Subject’s genotype. You can rename it and save it as
a new species. Before saving, you can modify the icon and the genome
(either with the flash cards or in the Genome Window).

CHANGE ME TO SPECIES SHOWN BELOW

Click this button to transform the Subject into another species. You can
choose the new species in the New Species box below.

If you try to turn a plant into an animal or an animal into a plant you'll
receive a caustic message proving that programmers can be just as big
of smart alecs as manual writers.

SPECIATE
WINDOW

| speciate
[pf] LLucie's LLama

Change Me To Species Shown Below |
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NEW SPECIES

Thisis adisplay of the species the Subject will be changed intoif you click
on the Change Me To Species Shown Below button above.

To change this species, click and hold on the down-arrow to reveal a
submenu of all available choices, slide the cursor to your choice and
release the mouse button.

NEVER MIND

Click this button to close the Speciate Window without doing anything
you might regret later.
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.0 o¥
The Evaluation Window gives you feedback on how well you are doing EVA I_ ”AT I ON
as an ecological experimenter. It visually shows the diversity of life in w IND ['w
your ecosystem and gives you a numerical score, a personal rating and
a status report.

The Evaluation Window can be reached through
the Evaluation item in the Windows Menu. It can
be moved around the screen by clicking and
dragging the Title Bar. It will go away if you click

i : e Score: 2486
in the Close Box. : R
d ! Status: The Hama is a quadraped
Click on pictures for more info...

THE MAIN DISPLAY

The main area of this window is a scenic view of a potential ecosystem.
There will be pictures of plants and/or animals that represent different
ecological niches that are currently filled. The more life-forms you have,
the more diversity you have, and the better your ecosystem’s chances
of survival. Click on any displayed pictures of plants or animals for more
information on the types and numbers of organisms they represent.

SGORE

This gives you numerical feedback on your skills and progress. The
score is based on the ecology score (which is a factor of a whole bunch
of things going on in the ecosystem), with diversity of species, the
number of years the game has been in progress and the difficulty level
factored in. It’s easy to get a high score for a short time, but keeping a
high score for a long time is very hard.

RATING

Rating gives you a title that describes your skill. There are 21 ratings
ranging from Parking Lot Builder to... you'll have to find out for yourself.

STATUS

Status is a one-line description of the current ecosystem. It might point
out a problem or need, mention something nice, give you useful informa-
tion or even compliment you.
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LOCATE AN
INDIVIDUAL
WINDOW

The Locate an Individual Window lets you find any currently living
individual organism. It can be opened from the Technical submenu in the
Simulation Menu.

SELECTED SPECIES

Click and hold on the down-arrow button to see a submenu of all
available species. While holding the mouse button down, slide the
cursor to the species you want, and release.

NUMBER

Highlight and type in the number of the individual you want to locate.

NEVER MIND

Click this button to close the Locate An Individual Window without
locating anything.

MAKE IT §0

Click on this button when you have chosen the species and number
above. The individual, if living, will be located, highlighted and visible in
the Edit Window. If it isn't living, you will be returned to the Locate An
Individual Window for another try.
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The Run Control Window lets you tell the simulation to pause and wait
foryou after a certain amount of time. It can be opened fron the Technical
submenu of the Simulation Menu. Use this window when you want to
check data at certain times without sitting at the computer, waiting and
watching, ready to dive for the pause button.

You can set it to pause after any amount of days or years, depending on
your experiment, but the most useful is 50 years. All the graphing,
history and census data is only kept in memory for 50 years: if you stop
the simulation every 50 years and save it to disk (each time under a
different name), you can get continuous data and graphs for the whole
experiment.

Note: Run Control will stay active until you disable it.

NUMBER

Use the up-and down-arrows or type in the number of days or years you
want the simulation to run before pausing.

DISABLE

Click this button to disable Run Control.

DAYS

Click this button to activate Run Control and make it pause after a
number of days.

YEARS

Click this button to activate Run Control and make it pause after a
number of years.

NEVER MIND

Click this button to close the Run Control Window without activating it.

MAKE IT S0

Click on this button when you have set the amount of time you want the
simulation to run before pausing.

<

RUN CORTROL
WINDOW

~ Pause simulatinn' after

] | E—

S Years

H'Hﬂ%ﬁl‘ﬂl‘l&il Make It So i
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OAMPLE
EXPERIMENTS

There are an unlimited number of experiments you can design and run
with SimLife. Here are just a few ideas to work with.

SEED-EATERS AND PLANTS

Design an experiment to see if, on the whole, seed-eaters do more
damage or good to plant populations.

Keep in mind:
* Many seeds don't sprout if they don't have the right
genes for sprouting temperature and moisture.

* Seedsthatdon’tsprout takeup roomthat could otherwise
be exploited by seeds that can sprout.

* Seeds that are eaten never sprout.

THE BATTLE OF THE SEXLESS

Design an experiment that shows whether or not sexual reproduction
(as opposed to asexual reproduction) provided an advantage to a
species.

Keep in mind:

* The vast majority of species on earth use sex during
reproduction to expand their gene pool.

* Sexual reproduction requires the large energy expense
of finding and courting a mate that could otherwise be
used to find food or directly increase the population.

* What is there in the real world that's missing from
SimLife that might make your experimental outcome
different?

OTHER WORLDS

AFood Web that is successful in earthlike surroundings might not do so
well if transplanted to another planet with different gravity, different
ocean viscosity, and/or different energy returns from food sources.
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Design an experiment (or 10) that simulate(s) other worlds, set loose
some life, and see what happens. Then determine the genetic changes
that would allow the life to better survive in the new surroundings.

Keep in mind:

* Different types of worlds can be designed in the Laws of
Physics Window.

¢ |t will be easier to start with Food Webs that have been
proven survivors in an earthlike setting.

GALAPAGOS

The Galapagos Islands contain the best known examples of divergent
evolution because of isolation.

Design an experiment where two populations (one on the mainland, one
on an island) are isolated from each other, and see if and how the paths
that evolution takes in the two populations differ.

Keep in mind:

* To get the full effect, and to have different evolutionary
pressures, make the mainland large, and the island small.

You'll have better luck with this one if you use a fairly large
world.

¢ Barriers over land or water will block walkers, but not flyers.
To keep flying creatures from crossing the ocean, spreading
their genes and messing up the experiment, have the island
as far from the mainland as possible, and set the energy
requirement for flying so high that an animal will starve to
death before it can cross the ocean.

P16 OUT

Sometimes colonists bring animals from their old homes to new lands.
Unfortunately, these animals always escape, and often don’t have any
natural enemies to keep their population down. A classic case is the pig
in Hawaii. It not only has no natural enemies, but also eats many of the
native plants down to the roots, killing them.
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Design an experiment to simulate the destruction done by pigs in Hawaii,
and try to come up with a solution for the problem.

Keep in mind:
* Setting the food value of plants to low in the Laws of

Physics Window will cause herbivores to eat the entire
plant and not just graze on the leaves.

* Sometimes solutions to problems cause their own, worse
problems.

CRY WOLF

Fans of the Farley Mowat book Never Cry Wolf (or the Disney movie based
on the book) know of the importance of the balance between the
populations of wolves and caribou.

Design an experiment with a stable cyclic balance between wolves
(carnivores) and caribou (herbivores), then go hunting and drastically
reduce the wolf population. See if reducing the predators is better or
worse for the prey.

Keep in mind:

* Watch the Population Interaction Window first for
establishing the stable wolf/caribou relationship, then
to see the results when the wolf population drops.

* If you haven't read the book or seen the movie, |
recommend both.

INBREEDING

What happens when there is not enough genetic diversity within a
species’ gene pool? An April 1992 National Geographic article told of the
modern-day woes of lions living in the Ngorongoro Crater in Tanzania
with just this problem.

Design an experiment where a species with very little genetic diversity
faces a new environmental pressure such as dwindling food source,
climate change, or new predator.
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THE CALIFORNIA WATER RUSH

For the past five years, California has been suffering from a drought. Yet
farmers still grow crops that require huge amounts of water and
homeowners want large green (thirsty) lawns.

Design an experiment where you have many water-hungry plants flour-
ishing in a wet environment, then slowly start to dry things up. See if you
candevelop new strains of the old plants that require less water, or come
up with new plants that will meet the same needs without needing the
same water,
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MISCELLANEOUS
OIM-STUFF

CONSERVING
MEMORY

MAKING THE
SIMULATION RUN
FASTER

SimLife can be amemory hog. If you have limited memory, you may want
to do the following:

* [se the smaller-sized worlds: the smaller the world, the
less memory the simulation needs.

* Use the Plant and Animal Limits in the Laws of Physics
Window.

e Turn off Record All Statistics in the Technical submenu
of the Simulation Menu.

Aside from setting the actual simulation speed in the Speed submenu of
the Simulation Menu, there are two basic ways to make the simulation
run faster: limiting memory use and limiting screen redraws.

The more information in memory, the more data the simulation has to
check and recalculate every cycle. Ways to limit memory usage are:

* Use the smaller-sized worlds: the smaller the world, the
less memory the simulation needs.

* Use the Plant and Animal Limits in the Laws of Physics
Window.

* Turn off Record All Statistics in the Technical submenu
of the Simulation Menu.

Dealing with graphics and redrawing the screen is very processor-
intensive. Ways to limit redraws are:

* Limit the number of windows you have open at a time.
* Keep the Edit Window small.

* Turn off Auto Tracking in the Goodies submenu of the
Simulation Menu. When on, Auto Tracking can cause
frequent screen redraws, which slow things down.

* Turn off Update All Windows in the Goodies submenu of
the Simulation Menu.
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In addition, turning off sounds and music in the Goodies submenu of the
Simulation Menu will free up the processor a little, and will increase
speed just a little.

You can also change the day and year length in the Laws of Physics
Window, but this only changes the rate time passes, and doesn’t actually
make the simulation run any faster.

When building a new world, the simulation follows these steps: TH[ W 0 RI_D

1. Draw fractal lines to make the upper ridges and peaks of BU"_DING
mountain ranges.

2. Use Cellular Automaton techniques to gradually and PRBCESS
randomly bring the peaks of the mountains down to the
plains.

Pick points at mountain peaks and start rivers flowing down.
Let rivers wind downhill until they hit the plains.
Once on the plains, flood the rivers out into lakes.

SR

Create the moistures zones: starting along the left edge of the
screen, the wind blows the moisture from west to east. Air
picks up moisture as it goes over lakes, loses it over plains,
drops moisture on west side of mountains and is drier on the
east side. Since air loses moisture going across plains, a long
plain will turn into a desert without nearby water.

7. Create the temperature zones: start on left. Begin with a
random but smooth distribution of temperatures, and sweep
to the right. As you go over water, temperature becomes
more moderate. As you go up in altitude, it gets colder. On
flat ground, it gets hotter (desert effect). If you have few
mountains and lakes you get a desert.

8. Build the soil layer. The best soil is under water and in moist
zones. The soil gets worse as you go up in altitude. If you add
water, it will not make the soil better. If you expose previously
underwater soil, it will be good, but will start to erode
immediately.
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DATA HILE TYPES

9. Add the filter food. Filter food follows the moisture: moist
areas and lakes have the most. Filter food changes with the
seasons: more when it's warm with long days; wetness helps,
too.

SimLife uses a number of different types of data files to save plants,
animals, and games. Here is a listing and explanation of each of the types.
If there are variations for your particular computer, they will be covered
in the machine-specific addendum.

GAME DATA FILE

Depending on world size and population, the Game file can range from
50KB to 500KB. The Game file does not save any of the census informa-
tion.

Included information:
* The map
» All species prototypes
* All organisms and their locations on the map

 The state of all windows and menu settings.

INDIVIDUAL ANIMAL DATA FILE

This file holds the species prototype for an animal, and is approximately
1KB in size. It is created from the Select Level of the Biology Lab when
you click on the Save button.

INDIVIDUAL PLANT DATA FILE

This file holds the species prototype for a plant, and is approximately
1KB in size. It is created from the Select Level of the Biology Lab when
you click on the Save button.

PLANT 200 FILE

This file holds the species prototypes for a group of plants. It is created
from the Biology Lab using the Save All Plants button. Its size is
approximately 1KB per plant.
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ANIMAL Z00 FILE

This file holds the species prototypes for a group of animals. It is created
from the Biology Lab using the Save All Animals button. Its size is
approximately 1KB per animal.

DATA LOG FILE

Data Log files are created when you activate the Data Logging option in
the Technical submenu of the Simulation Menu. When active, once a day
all the simulation memory that is viewable in the Graph Census Window
is dumped to disk.

It is in a standard ASCII tab-delimited file format and can be loaded into
most spreadsheets and databases for charting, graphing and statistical
analysis.

The size of this file depends on the number of species and length of the
game, and is approximately 1KB per day. This file is appendable: you can
log data during a game or experiment, stop for a while, and come back
to the game at a later time and continue logging to the same Data Log file.

The Data Log file also contains genetic descriptions of each animal that
lives during a game, plus enough genealogy info to eventually recreate
the family trees of animals in your experiments.

For more information and for the file format, see your machine-specific
addendum.

Reference
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GLOSSARY

The SimLife manual provides many game-specific definitions for terms that are
working definitions relevant to gameplay. Many of the following glossary defi-
nitions are more broad, formal denotations of terms.

Adaptive Behavior — Responses—often genetically controlled—of an
individual, group or species to the environment that aid survival and
reproduction.

Artificial Life — The study of and attempt to simulate life and lifelike
processes in artificial media, including software (computer simulations),
hardware (robotics), and wetware (organic material).

Asexual — Involving or reproducing by reproductive processes (as cell
division, spore formation, fission, or budding) that do not involve the
union of individuals or germ cells; lacking sex or functional sex organs.

Carnivore — An organism that feeds on animals; a flesh-eating animal.

Census — A usually complete enumeration of a population; specifically, a
periodic governmental population count.

Chromosome — A filamentous, threadlike structure in the cell nucleus (in
eukaryotic cells), along which the genes are located.

Deciduous — Falling off or shed seasonally or at a certain stage of
development in the life cycle; shedding leaves each year.

Diversity — Represented by a broad band of distinct elements or qualities;
characterized by variety, difference and deep range.

DNA — Any of various nucleic acids that are localized especially in cell
nuclei that are the molecular basis of heredity in many organisms, and are
constructed of a double helix held together by hydrogen bonds between
purine and pyrimidine bases, which project inward from two chains
containing alternate links of deoxyribose and phosphate.

Ecology — A branch of science concerned with the interrelationship of
organisms and their environments.

Ecosystem — The sum total of physical features and organisms occurring in
a given area.

Environment — The complex of physical, chemical and biotic factors (as
climate, soil, and living things) that act upon an organism or an ecological
community and ultimately determine its form and survival.

Evergreen — Having foliage that remains green and functional through more
than one growing season.

Evolution — Change in the genetic makeup of a population with time: a
theory that the various types of animals and plants have their origin in
other preexisting types and that the distinguishable differences are due to
modifications in successive generations.
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Extinct — No longer active or existing.

Filter Food — Organic matter or minute organisms often found in water
currents that provide a source of nutrition for certain animals.

Food Chain — the sequence of organisms, including producers, consumers,
and decomposers, through which energy and materials are made and
consumed in a community; an order of predation in which organisms use
the next usually lower member as a food source.

Foraging — A browsing, grazing or wandering search for food or provisions.

Gene — A sequence of DNA nucleotides that codes for a particular
polypeptide or an RNA molecule. Genes provide information for structure
and function in organisms and are passed on in reproduction.

Genealogy — An account of the descent of a person, family, or group from
an ancestry or from older forms.

Genetic Drift — Change in the gene pool purely as a result of chance, and
not as a result of selection, mutation, or migration.

Genetics — A branch of biology that deals with the heredity and variation of
organisms; the genetic makeup and phenomena of an organism, type,
group, or condition.

Genome — The total genetic information in an organism'’s nucleus.

Germination — Sprouting or developing; coming into being or beginning to
grow.

Gestation — The carrying of young in the uterus and the concomitant
developmental stages.

Herbivore — An animal that eats plants.
Humidity — Degree of wetness, especially atmospheric moisture.

Intelligence — Ability to learn or understand or to deal with new or trying
situations; the ability to apply knowledge to manipulate one’s
environment.

Mutation — Any relatively stable heritable change in the genetic material.

Natural Selection — Differential reproduction in nature, leading to an
increase in the frequency of some genes or gene combinations and to a
decrease in the frequency of others.

Nectar — A sweet liquid that is secreted by the nectaries of a plant,
sometimes a nutritional source for animals.

Niche — The functional role and position of an organism in the ecosystem.

Phenotype — The physical manifestation of a genetic trait; the features of
form, function, and behavior of an organism; an expression of interaction
between genotype and environment.

Glossary
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Precipitation — A deposit on the earth of hail, mist, rain, sleet, or snow; the
quantity of water deposited.

Predator — One that preys, destroys or devours; often a consumer of living
tissue.

Prey — An animal taken by a predator as food.

Prototype — An individual that exhibits the essential features of a later
type; an original model on which something is patterned.

Recombination — The formation by the processes of crossing-over and
independent assortment of new combinations of genes in progeny that
did not occur in the parents.

Speciation — The process of the formation of new species.

Species — A category of biological classification ranking immediately below
the genus or subgenus, comprising related organisms or populations
potentially capable of interbreeding.

Toxin — A poisonous substance that is a specific product of the metabolic
activities of a living organism and is usually very unstable, notably toxic
when introduced into the tissues, and typically capable of inducing
antibody formation.
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